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1 Guide to the different versions of the gvSIG User
Manual.

Guide to the different versions of the gvSIG user manual
Version Modifications

gvSIG 1.1 User Manual / Initial version*
Version 0

* This version of the user manual corresponds to version 3 of the same manual in Spanish.
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2 Introduction

The gvSIG project came into being as a result of an initiative carried out by the Valencian
Regional Government (Generalitat Valenciana), through its Regional Ministry for
Infrastructure and Transport (the public tender “Computer services for the development of
GIS applications for the Regional Ministry for Infrastructure and Transport using free
software”).

The Jaume | University is in charge of monitoring the project so that it complies with all
international standards (Open GIS Consortium).

IVER Tecnologias de la Informacién S.A. was awarded the tender and is responsible for
the application’s development.

21 What is gvSIG?

gvSIG is a programme which manages geographic information. It has a user-friendly
interface and fast access to most standard raster and vector formats. gvSIG can also
integrate local and remote data in the same view through WMS, WFS, WCS and JDBC
sources.

It is aimed at end users of geographic information in business and public administration
(city councils, regional councils and regional and national ministries).

It is also highly suited to the university environment thanks to its R&D&l element.

It is a free, open code application with a GPL licence. From the outset, special emphasis
has been given to the expansion of the gvSIG project so that developers can add functions
to the application easily and develop completely new applications from the libraries used in
gvSIG (as long as they comply with the GPL licence).

2.2 What can we do with gvSIG?

gvSIG is a sophisticated Geographic Information System for managing spatial data and
performing complex analyses on it.

gvSIG can be used for a wide range of tasks, including:
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2.2.1 The gvSIG interface

The gvSIG interface has the necessary features required to communicate with the
programme. The graphical interface is intuitive and user-friendly and is suitable for any
user who is familiar with Geographic Information Systems.

The gvSIG interface is made up of a main window with different tools and secondary
windows for the documents created using the programme, as described in the following
sections.

Before describing the different documents and tools, we must take a look at the gvSIG
interface. The more familiar you become with the interface the easier it will be to go
through the following chapters.

gv5IG:5in titulo

[
s Gestor de proyecids

Tipos de documentos

Wistas Tahlas Mapas

Vistas

Sin titulo - 0

Muevo

Propiedades de la sesidn

Mombre de la sesidn:  Sin titulo
Guardado en:
Fecha de creacidn: 06-5ep-2008

Fropiedades

{ Aplicacidn iniciaca / 6

N

- 1. Title bar: Located at the top of the gvSIG window. It contains the programme name,
i.e. “gvSIG” in this case.
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2. Buttons to maximize or minimize the programme’s active window or to completely
close it.

- 3. Main window: Work area in which the different “Project Manager” windows and the
different gvSIG documents are located.

- 4. Menu bar: Some of the gvSIG functions are grouped into menus and sub-menus in
the menu bar.

- 5. Toolbar: The toolbar contains the icons for the standard commands and is the
easiest way to access them. By clicking and dragging the toolbars we can move them
to different positions. It is not necessary to memorize the meaning of every single icon.
When you place the mouse pointer over them a message with a description of their
function immediately appears.

6. Status bar: The status bar provides information about coordinates, distances, etc.
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3 gvSIG Projects and documents

In gvSIG all the activities are located in one project. This project is made up of different
documents. There are three types of documents in gvSIG: views, tables and maps.

Document types

' -1‘ ---------------- &l}}*i;

WiEws Tahles r'-"IEI.F:lS

7.,.!‘
=

- Views: Views are the documents in which we work with graphic data.
- Tables: Tables are the documents in which we work with alphanumeric data.

- Maps: A map generator which allows the different cartographic elements included in a
map (view, legend, scale...) to be inserted.

Projects are files with a “.gvp” extension. These files do not include spatial data and
associated attributes in the shape of tables. Instead they save references to the places the
data sources are stored (the path to be followed in the disk in order to find the files). If the
data changes the updates will be shown in all the projects they are used in.

The menu which allows you to access the project management options is located in the
“File” menu

File show  Window  Wiew

D Mewy project Alt-H
| B> open project  Alt-a
EI Sawve project Alt-0

EI Save as...

& open template

Scripting ¥

| Exit At
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And in the following toolbar buttons (“New project”, “Open project” and “Save project”).

0O e
3.1 Saving a project

1. Click on “File” in the menu bar and then on “Save project”. Alternatively, press the
“Alt+G” key combination, or the “Save” button in the toolbar.

[

2. When the file manager window is opened you can name the project and choose
where to save it.

2 swe FoH e

Sawe |n: |I‘ZI falario "| |§| |§| |§| |%|E

3 datos

C3 Desktop

3 docu

C3 Examples
£ gusIG

C3 gwslG_1.0rcl
£ workspaces

File Marre: || |

Files of Type: | GvSIG project filegr. GvP) -

| Save || Cancel |
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3. The project is saved in a file with a “.gvp” extension.

3.2 Saving and Closing a project

When you decide to finish a session in gvSIG, a window such as the one shown below
appears:

b Save resources =Dl(==]

Before exiting, the selected resources will be sawved

gjes.shp
% Unnamed

Select all || Clear selection |

| Ok || Discard changes || Cancel |

The text box shows both the name of the project currently in use as well as the layers and
tables which were being edited before the decision to close the project was made.

The “Select all” and “Clear selection” buttons allow you to enable or disable the check
boxes in the text box which correspond to the project or to the layers being edited.

If you click on “Ok”, the changes made to the enabled elements in the text box will be
saved.

If you click on “Discard changes”, none of the changes made in the project will be saved
irrespective of whether they have been enabled or not.

The “Cancel” button allows you to exit the window.
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3.3 Opening an existing project

1. If you wish to open an existing project to see or modify it, go to the “File” menu and
click on “Open project”. Alternatively, press the “Alt+A” key combination or the
“Open project” button in the toolbar.

=

2. When the project manager window is open, look for the “.gvp” file which contains
the project you wish to open.

:_: Open E E

Look In: |EI falario -| |§| |§| |@| |E|E

3 datos

C3 Deskiop

3 docu

£ Examples
C3 gusIC

C3 gwsIS_1.0rcl
£ woarkspaces

File Marne: || |

Files of Type: | ovSIG project file(®. GvP) ~|

| Qpen || Cancel |

3.4 New project

1. Click on “File” in the menu bar and then on “New project”. Alternatively, press the
“Alt+N” key combination or the “New” button in the toolbar.
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2. If you are already working on a project, the following message will appear when the
button is pressed.

If you press “Yes”, a window will open so you can save your current gvSIG project.
When the previous project has been saved a new blank project will appear on the
screen.

3.5 Preference window

The preference window allows you to customise gvSIG.

You can access the preference window by going to the "Window" menu then to
"Preferences"

Window Wiew Help

2~ Preferences

or by clicking on the “Preferences” button in the tool bar.

tdl
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When you have accessed the tool, a new window appears in which you can configure your
preferences.

B General General
Metwork
Lo

Restore defaults ‘ ‘Accept H Cancel |

Select the property you wish to access from the tree on the left and the preferences you
can configure will appear in the space on the right.

3.5.1 Editing

This allows a series of default colours used in a gvSIG editing session to be chosen. A
detailed explanation is provided below:
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T Preferencias

[* General P, .
Mapa ~ Edicidn
Met Lnalyst

Preterencias de las anctationes e
[+ Red
ista

Cambio colores de edicidn.

~Colar de ssleccidn

Rellenarl— E]Alpha '7]

~Color de eje de referencia.

Relenar| s [ Japha = |

~Color geometria de seleccidn.

Rellenarl— E]Alpha '7]

~Color de handler de seleccion.

Rellenar (- JBore| ™ (Jabpra |

[ Restaurar opciohes por defecto ] [ Aceptar ][ Cancelar

3.5.1.1 Colour of the selection

This allows you to set the default colour for the selected geometry of a layer which is being
edited.

“7 gvS1G:Sin titulo

Archivo Ver Capa ventana Vista Geome!

metria
DeE B XIS MR

Tabla  Ayuda

Z @ =S X R NaoD vom @ B |

e Tac@mOoRRIx I BEIDDF

= M Ipd_muns.;

[ petautt

&
2
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3.5.1.2 Colour of the reference axis

This allows you to set the colour of the reference axis which will guide you through any

editing operations, for instance operations such as “symmetry”, “rotate” etc...

7. gvSIG:Sin titulo

Archivo Wer Capa Yentana Yista Geomstria Tabla Ayuda

Del éﬁ@qqgiiiiﬁ H@eRd X yNGHD: vO@m @ B IFE #*
e Rhocmoar kB bl
@ Vista : Sin titulo - 0

= A 1pd_muns.

[ pefaut

' §

3.5.1.3 Colour of the selection geometry

I
[~

This allows you to set the default colour of the selection frame used to select the required
geometry.

L EEEEEEEEEREEEEEESSSSSs.
June 2007 Page 24 of 409



sl

gvSIG - User guide

i gwSIG:Sin titulo

archive Ver Capa %Yentana Vista Geometria Tabla  Ayuda

DPE S AISHEK V@D OHS X rNEGomM YyOE
emLTmoocmo Ry EH DR W

2 Vista @ Sin titulo - O

= A Ipd_muns.
[ Detaut
< i | k3

3.5.1.4 Colour of the selection handler

This allows you to set the default colour for the “Handlers”, in other words the vertexes
which make up the selected object. In this case, the colour of the outline can be selected,
as can the colour of the inside of the handler.

- gw5lG:1001_shp_espafia.gvp

Archiva Wer (Capa Ventana \Vista Geometria Tabla  Ayuda  Red

NoE 5 CXASHELK @O OXAS X ANROS ¥vO
e tamcmoarh i B bR T
S ¥ista : georref1001
M ccas shp

= A espanaccaa.shp

Wl Detoutt

£ 2l
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3.5.2 General
This tool establishes whether gvSIG needs to remember the project windows’ position and
size.

E+General
| ~Bxtensians directory.
i~Language
---Extenslons [[] Remember window pasition.
[ Appearance [l Remebember window size.
B Metwork
=

A, (L)
-§'/ General

Restore defaults ‘ ‘ALEED( H Cancel |

If you pull down the tree (click on “+”), the properties you can configure in “General” will
appeatr.

3.5.2.1 Extension directory
This tool defines the directory for the extensions that gvSIG must use.

F—
—

' S| Extensions directory.

Directory

|g*u'SIG,fE}{ten5iunE5 || Examine
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3.5.2.2 Language

This allows you to select the language in which gvSIG must be shown. To select a
language, click on the pull-down menu and select the language from those available.

:. Language

idioma

English -
English =
French —
Italian
Yalencian
_zech
Basoue
Fortuguese
Cerman

Jl

Remember that gvSIG must be restarted for the language change to take effect.

3.5.2.3 Web browser

This allows a default web browser (for the Linux operating system) to be specified for any
search carried out from gvSIG to any of the hyperlinks found in the application.

The first option contains the pull-down menu in which the different supported browsers are
located.

The second option can be used to specify which browser you want to open the different
URLs included in the application such as the URLs in the “Help” menu (Example: firefox
Y%WWW.gVvsig.gva.es).
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& Preferencias =2=
~~Edicidn
El-Ceneral EE Navegador weh
----- Apariencia
)))) Carp.etas . (3) Selaccionar un navegador conocido. |K0nqueror -
+~Configuracion de pantalla e
----- Directorio de las extension _ Ejecutar un comando propio.
E-Extensiones (I Ej.: firefox surl
_____ Idiama {donde %url es la URL a cargar)
----- Mavegador web
-Mapa
et Anakyst
El-Red
Pl Firewvall [Proxy
----- Wista

] T

| Restaurar opciones por defecto | |Aceptar || Cancelar

3.5.2.4 Extensions

This allows you to configure the extensions that gvSIG uses while running. Pull down the
extension tree and select the required extension.

Preferences
E-Extensions |=|
~-COM. ver. Cit. @wsig. wim s W SClientExtension _ i@ Extensions
- CoMn. e, Cit. gvsig.wine. ExportWebM apContextExtension ||
~-Cam. iver. cit. gwsig. winc. ImportiwelM apCaontextExtension Configure all the extensions
- COM.IVer. gvsig. Centervewpoint. CenteryiewT oPointExtensi
--COMm.iver. gvsig. datalocator. DatalocatorExtension
- COm.iver. gvsig. addeventtheme. AddEventThermeExtension
-~ COMLIver. Cit, gwsig.ws, WCSClienExtension
=+ COM.Iver. Cit, gwsig. Createewlayear
=+ Cam. iver.cit. gwsig. StartEditing
-+ Cam. iver. cit. gwsig. StopEditing
~-cam.iver.cit. gwsig. ExportTo |
¥ it o Cocl Cact oin = L
4] il [»]
Restore defaults | | Accept || cancel |

A description of the selected extension is displayed. You can activate or deactivate the
extension and modify its order of priority in the list.
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Eh-Extensions

-~ COML VR, Cit. gvsig.wims. WMSClientExtend -

~-Carm. iver. cit. gvsig.wimc. ExportWebMapd =

= L0 iver. Cit. gwsig.wmc. Importiekb M ap I |

- COMLver. gwsig.centerviewpoint. Centery

- Com.iver. gwsig.datalocator. Datalocatarl

-~ COFA. fver. gvsig. addeventtheme. AddEve
com. iver. cit. gwsig.wes, WCSClientExtensi

-~ L0, IVer. cit. gvsig. CreateMewlayer

- COMLiver. Cit. gwsig.StartEditing

LA, iver. Cit. gvsig. StopEditing

- COMLiver. Cit. gvsig.ExportTo

= COm.iver. cit. gvsig. RedoviewExtension

-~ COmm.iver. Cit. gwsig. UndoYiewExtension

= L0Mm i\ﬂar.cil.g\rsig.\/iEWCummandSlacI-(ET

Preferences

3 I

»'§" com.iver.cit.gvsigwms. WMSClientExtension

= Sl

Description

Tl

[»]

Active extension. Priority

| Restore defaults |

|Accepl || Cancel |

N.B.: If you activate an extension, you will have to restart gvSIG to use it.

3.5.2.5 Appearance

You can use this tool to modify gvSIG’s appearance. Pull down the box with the available
options and select the required option.

N.B.: You will have to restart gvSIG for this change to take effect.

3.5.2.6 Folders

=1
& =& Appearance

vy

Use appearance (needs restar) |F‘Iasti|: HP v|

M etal
CDE/Matif
Flastic ¥P

You can use this option to create a shortcut to the folders your projects (.gvp), data (raster
and vector) or templates (.gvt) are saved in.
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=-Ceneral
+--Extensions directory. \d‘ Foders
+-Language A
, -~Extensions Projects folder
- Appearance | I Browse |
i - Foders
Metwark Geographycal data folder
Sl I Browse |
Template folder
I Browse |
Restore defaults | | Accept || cancel|
- - -
3.5.2.7 Display configuration
S Preferencias (=E=
E-General
- Apariencia “-. | Configuracion de pantalla
~-Carpetas
~-Configuracion de pantalla Resolucian

~-Directario cle |as extensiones.

Medida de prueba
Bt-Extensiones 1

ldioma I 1
~omapa
F-Red La longitud de la linea de arriba es:
eyista |5,61 |Cent|’metros -

| Calcula resalucidn |

Restaurar opciones por defecto | |A1:eptar || Cancelar

You can specify the points per inch for your display in the “Resolution” text box.
gvSIG allows you to calculate the exact resolution of your display as follows:

e Place a ruler on the screen to measure the straight line drawn in the “Test
measurement” box.

e Write the measurement obtained in the text box underneath (the value 5.61 has
been inserted in this example) and the units in which this measurement was taken
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(“Centimetres” in our case).
e Click on the “Calculate resolution” button.

e @vSIG automatically provides a points per inch value for the resolution of your
display. This appears in the corresponding text box (the result in our case is 95ppi).

3.5.2.8 Map

This section of the preference window can be used to customise how you wish to work with
your map documents.

You can define both the horizontal and vertical grid spacing values and decide whether the
grid should be displayed, enabled or disabled and whether the ruler should be enabled or
disabled simply by clicking on the required check boxes.

When you have selected your preferences, click on “Ok”.

d Preferendias ==
E-General i ;\ o
N §
- Aparientia -A\‘,,ﬁ} AE Mapa
-Carpetas \ ;[/
s-Configuracian de p
----- Directorio de las e Espariado horizontal de la malla |2.25
(-Extensiones Espaciado wertical de la malla 0.25
“Iioma
i Wisualizar malla
..... Mapa
B-Red I:‘ Malla activada
----- Wista [v] Activar regla

1

| Festaurar opciones por defecto | |A1:eptar | | Cancelar

3.5.3 Annotation preferences

The annotation preferences allow you to define the default characteristics you wish the
annotation layers to have.
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i

Preferen a
-~ Edicidn
i Preferencias de las anotationes
[ =ferencias de las anotationes o

Cambio opciones de las anotaciones

Texta

Tipo de fuente Arial w

Estilo del kexto Plain -

Altura del bexta 10

Rotacidn del kexta) 0

Color del kexto I E]

Restaurar opciones por defecto ] Aceptar ] [ Cancelar

You can predefine the default characteristics you wish the annotation layers to have.

Text

You can select the default text to be written in the annotation layer if the record of
the field you have chosen to label is blank. You can choose not to write anything in
the record if you wish so that it remains blank.

Font type

You can select the default font type in which you wish the annotation layer’s text to
be written.

Text style

You can select the default text style you wish the annotation layer to have.

Text height

You can select the default text height you wish to be used in the annotation layers.
Text rotation

You can use the text rotation option to select the default orientation that the text in
the annotation layers will have. For example, if you want the text to be shown
horizontally, input “0 degrees”. If you want the text to be shown vertically, input 90°.
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Remember that gvSIG uses sexagesimal graduation and this turns anti-clockwise.
e Text colour

You can select the default text colour you wish the text in the annotation layers to be
shown in.

3.5.4 Network

gvSIG allows you to check the status of a network connection.

w, Network

Metwork status:  Press button to test the connection

Check now

3.5.4.1 Firewall/Proxy

If you use a proxy connection, you can configure your connection parameters so that
gvSIG can use them.

@ Firewall { Proxy

[ Use proxy HTTP server
HTTP proxy server:

HTTP proxy part:
Usernarme:

Passward:

Caonnect directhy to:

[ Use proxy SOCKS server
SOCKS proxy host:

SOCKS prowy port:

3.5.5 View

You can configure the values that gvSIG will use for zooming in or out of a view and
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changing the selection colour which by default is "Yellow".

E-General

You can also use this window to define map and measuring units for gvSIG.

s hparientia
Carpetas

Preferencias

Yista

---Extensiunes
“ldioma
-Mapa

G-Red

—Nista

s~ Configuracion de pantalla
+-Directorio de las extensiones.

Factor zoom mas:

2.0
Factor zoom menos: 0.5
Color de fondo de la wista por defecto | . |
Color de la seleccidn par defecto | - |
Unidades de mapa |Metros v|
Unidades de medida |Metros v|
4 AD
| Festaurar opciones por defecto ‘ |AJ:eptar || Cancelar

Proveccidn actual:  EPSG:22030 | |

["] Afiadir nuewas capas en moda invisible

You can use this window to change the view projection by clicking on the "Change" button.

A dialogue box appears from which you can choose the reference system.

June 2007

Page 34 of 409



S| §3
gvSIG — User guide ) d

4 Copying and pasting documents in gvSIG

If you copy and paste a document, you should remember that if this document has any
other documents associated with it these will also be copied (example: if a map is copied
the views it includes will also be copied).

N.B. You can select several documents to be copied at the same time.

N.B. Remember that if you press “No” or “Cancel” in any of the dialogue boxes which
appear during the process, none of the changes you have made in the process will be
saved.

41 Copying/Pasting Views

Select the view you wish to copy from the “gvSIG Project manager”, right click and select
“Copy” from the contextual menu.
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% Project manager *

~Document types

EEEEEEEEEEEEEE . o

e
}1{:‘ =

W iEvs Tahbles Maps
~Yiews

s m [ =0 J
Lt [ Open J

Faste
[ Fename J
[ Deleta J
[ Properties J

~Session properties

Session name:  Untitled
Saved in:
Creation date: Sep 28, 2006

If you wish to copy the view to another gvSIG project, select “Paste” from the contextual
menu. If a project already has a view with this name a message will appear to indicate that
you must change the name of the view you are trying to paste.

Paste views

You will need ta write new names for the wigws
There will not be any pasted table
A00 w0 weant to continue?

7 ¥ou are thying to paste wviews whaose names already exist in the current project
L]

VEs | | Mo

L EEEEEEEEEREEEEEESSSSSs.
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N.B. The message “No table will be pasted” means that the tables which are active in the
source view will not appear in the target view unless they are activated in this view.

If you wish to cancel the operation, press “No”.
If you press “Yes” a new dialogue box will appear so the view can be given a new name.

B Input e

Write the new name for the wiew gwslG:
* | masid |

[ 0] I| Cancel |

Write the new view name and press “OK”. This view will be added to the project.

If you press “Cancel” the process will be terminated.

4.2 Copying/Pasting Tables

The procedure for copying/pasting tables is similar to the procedure described above.
However, in this case tables with the same name can exist in a project.

Tables

Tahle_guslG
Table_gwslG Mew

4.3 Copying/Pasting Maps

The procedure for copying and pasting maps is similar to the previous two cases.
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Select the map you wish to copy from the “Project Manager”, right click and select “Copy”
from the contextual menu.
If you wish to paste the map to a project which already has a map with the same name, the

following message will appear.

K Paste maps fores
? ¥ou are thdng 1o paste maps whose names already exist in the current project
o You will need to write new names for the maps

If you press “No”, the operation will be cancelled.
If you press “Yes”, a new dialogue box will appear. Write the new name for the map in the
box and press “OK”.

E Input feae]

e

Write the new name for the layver map:
b |map Z |

[ 0] ” Cancel |

If you press “Cancel” the process will be terminated.
If any of the views associated with the map already exist in the current project the following
message will appear.

Paste maps

You are trdng to paste wviews whose names already exist in the current project
The conflicting wiews swill not ke pasted
A00 w0 weant to continues

*~d

fes | | Mo
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If you press “Yes”, a new map document will be created.
If you press “No” the operation will be cancelled.

N.B. The message “The conflicting views will not be pasted” indicates that the views the
maps are associated with will not be added. Instead, the views which already exist in the
current project with these names will be used (example: You have copied a map with an
“A” view and a “B” view. When you try to paste the map into the project, you find that an “A”
view already exists. The operation will add the “B” view and will leave the “A” view intact so
that the map will use the pre-existing “A” view).

Maps

mzi ; | Ny |
| open |
| Rename |
| Delete |
| Properties |

4.4 “Cutting” documents in gvSIG

Use the “Project manager” to select the document you wish to cut. Right click and select
the “Cut” option from the contextual menu. The following window will appear.

Qi Select an Option ——

? s00 wou really want 1o delete the selected documents?

| fes || Mo || Cancel |

If you press “Yes” the selected document will be “cut” from your project.
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5 Views

Views are the gvSIG documents used as the working area of cartographic information.

A view can contain different layers of geographic information (hydrography, transport
infrastructures, administrative regions, contour lines, etc.).

" View : Untitled - 0
P—

-] @ provincias.shp

----- [ Default
----- B ALBACETE

----- M BaDaj07
I EARCELONA

----- [ BURGOS

----- B CAMTABRIA

----- I CASTELLOM

----- [ ceuTa

----- B ClUDAD REAL

----- B CLENCA

----- [] CACERES

----- M cipiz

----- [ corDoBa

i 110434843 > ||Metros [ = -889,583.64 |f = 4,822,802.41 |EPSG:230320

When one of the views that make up a project is opened, a new window appears divided
into the following parts:

- Table of contents (ToC): The ToC is located on the left-hand side of the window.
The Table of Contents lists all the layers it contains and the symbols used to
represent the elements which make up the layer.

- Display window: The display window is located on the right-hand side of the
screen. The project’s cartographic data are shown in this display window.
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Locator: The locator is situated in the bottom left-hand corner. The locator allows
the current frame to be situated in the work area as a whole.

When a view is opened, the main window increases the number of menus and buttons,
thus adding the tools required to work with the elements which make up the view.

The size of the ToC can be enlarged to show a full description of all the themes by simply
dragging its edge to the right or downwards.

5.1 Creating a view.

To create a “View” in gvSIG go to the “Project Manager” window (“Show” menu / “Project
window").

&4 Project manager

Document types
AR oA o
b [ XE
Yiews Tables Maps

Yiews

Untitled - 0

ey

Session properties

Session name:  Untitled
Saved in:
Creation date; Oct 3, 2006

Properties

1. In the “Project manager” window, select “Views” in the document type.
2. Then click on the “New” button.

3. A document in “Views” is created (immediately) which by default is called “Untitled - 0”.
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4. The name of the “View” can be changed by selecting the document from the list and
clicking on the “Rename” button. A window appears in which the name of the “View” can
be changed.

m Rename
? Twpe the new name
* | |Untitled - of |

[ o

¥

5. To access the “View properties” window, click on the “Properties” button.

5.1. It is important to select the cartography units and the distance units for the
“View”. Their default values are expressed in metres.

5.2. The “View” background colour can be configured. It is white by default.

4 View properties

Mame: Creation date; |Umit|Ed -0

Owmer: |10/2/06 6:46 PM
Map units: [Meters ~|
Measuring units: [Meters -

Current projection:  EPSG: 22020 |

Camments:

Background colar: | |

Ok, || Cancel |

5.3 From gvSIG version 0.3 onwards, the “Views” support different projections
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and reference systems. You must select the reference system the cartographic
information is to be displayed with.

o Nueve CRS =]

Seleccione CRS de la vista

Tipo: Eecientes -

Otimos CRSs utilizados:

Coordinate Reference Systems

Fuenta | Codigo | Mombra
EPSG 4326 WCSS84
EPSC 23030 EDSOfUTMzoneZ 0N
EPSG 22021 EDSO/UTMzone3 1M
LCancelar || Areptar

5.2 Properties of a view in gvSIG

To access the properties window of a view, go to the “View” menu and select “Properties”.

Wiew  Help
Export b
Impaort b
Centrar_la_Vista_sobre_un_punto
Mew [aver »
J'g Add lawer Alt-0
Mavigation [
QEry b
Set layers as b

Configure locataor map

Selection [

Froperties
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The properties you wish your view to have can be configured via the following window.

@ View properties

Marme: Creation date: |L|miT.IEd -0 |

Crwmer: 1107406 9:10 AM |

|Falari|:| |
Map units: \Meters ~|
Measuring units: |Meter5 v|

Current praojection:  EPSG:Z23030 |

Camments:

Background colar: | |

If you click on the “Current projection” button, a new window will appear in which the view’s
datum, projection and time zone can be selected.
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# Nuevo CRS e

Seleccione CRS de la vista

Tipo: Fecientes -

Otimos CRSs utilizados:

Coordinate Reference Systems

Fuente Cadigo | MNombre
EPSC 4226 WoSE
EPSG 23030 EDS0/UTMzaone3 OM
EPSG 23031 EDSOfUTMzone3 1M

Lancelar || Areptar

If you click on the pull-down menus, the different options available for each element in the
reference system are shown. If you make any changes, click on “Apply” and then “Ok”.

When you have configured the view’s properties, click on “Ok”.

5.3 Layer data source

Different types of cartographic information can be added to a view. Vector and raster files
can be loaded. Each of these groups can contain a wide range of formats.

GIS data: The standard GIS format is the shape, which stores both spatial data and their
attributes. A shape (also called “Shape file”) is actually three or more files with the same
name and different extensions (even though in gvSIG it is handled as one file):

dbf: Table of attributes.
shp: Spatial data.
shx: Spatial data index.

From version 0.5 onwards, gvSIG also has the capacity to access the MySQL Spatial and
PostGIS spatial data bases via a new driver which uses JDBC.

CAD data: These are vector drawing files which support the dxf and dgn formats. The
CAD files may contain information on points, lines, polygons and texts. From version 0.4
onwards, gvSIG also allows access to the information contained in Autodesk’s 2000 dwg
files.
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WMS data (Web Mapping Service): gvSIG can be used to consult WMS data, i.e. data
available on the web.

WFS data (Web Feature Service): From version 0.5 onwards, gvSIG can be used to
download WFS vector layers from servers that comply with the Open Geospatial
Consortium (OGC) Standard.

WCS data (Web Coverage Service): From version 0.4 onwards, gvSIG allows access to
remote information based on the OGC’s WCS protocol.

GML (Geography Markup Language): From version 1.0 onwards, gvSIG allows GML
documents to be displayed and exported. Geography Markup Language (GML) is an XML
format to transport and store geographic information whose design is based on
specifications produced by the OGC group.

Images: gvSIG can display different raster images (tiff, jpg, ecw, mrsid, etc.). From version
0.4 onwards, gvSIG can save images which have been modified in these formats.

From version 0.5 onwards, “colour palette” (GlIFs, 8-bit PNGs, etc.) raster files can be
opened and raster files without georeferencing can also be opened. Moreover, this new
version supports GIF, BMP y JPEG2000 formats.

5.4 Adding a layer to gvSIG

Firstly, open a “View” document in gvSIG.

You can access this option by going to the "View" menu and then to "Add layer" or by using
the “Control + O” key combination

Wiew  Help
Expart b
[mport b
ey [aner }

= Add layer Alt-O

Froperties

or by clicking on the "Add layer" button in the tool bar.
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A window appears in which you can select and configure the layer's data source by its
type:

L ahadir capa [oaesl
Archivo | GeoBD |, Georreferenciar | WFS | Anotacidn | WMS | WS '\ ArciMS |
Capas |

5.4.1 Adding a layer from a disk file
Click on the “Add” button

m Open layer E
File', Georeference ', IDBC | WFS |, wMs | WCs b arcims |
Layers

Current projection:  EPSC: 23030

ok || cancel
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5.41.1 Selecting layers

The "Add” dialogue window allows you to move around the file system to select the layer to
be loaded. Remember that only the files of the type selected will be shown. To indicate the
type of file to be loaded, select a file from the “Files of type” pull down menu.

E Open E E

Look In: |EI datos '| |§| |E| |§| |E|E

£3 Do Y
£ dwg C3 Taklas
C31 DxF

£ espaciales

£ gmils

3 Ortosvalencialocal

£ Provectos

Cd RASTER

C3 SHP

File Marre: | |

Files of Type: | G4IG shp driver |

L

If several layers are loaded at the same time, the order in which the themes will be added
to the view can be specified with the "Up" and "Down" buttons in the “Add layer" dialogue.

5.4.2 Adding a layer using the WFS protocol

5.4.21 Introduction

The Web Feature Service (WFS) is one of the OGC standards
(http://www.opengeospatial.org) which is included in the list of standards (of this type) that
gvSIG supports.
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WES is a communication protocol via which gvSIG retrieves a vector layer in GML format
from a supporting server. gvSIG retrieves the geometries and attributes associated to each
"Feature” and interprets the contents of the file.

5.4.2.2 Connecting to the server
Go to the “Add layer” and then select the WFS tab.

E Open layer

File |, Georeference | JDBC ' WES | WS '\ WCS | ArciMS |

¥

Server

|hnp 1 fwewwi2 cimsolutions. ca/cgi-bin, mewfs_grag| |=

["] Refresh cache Connect |

Description

Mame: DM Solutions' WFS Demo Server

This demonstration server was setup by DM Solutions Croup

thitp: f fweeey drmsolutions. cafy and is powered by MapServer

thitp: ffmapserver. gis.umn.edu/). This server uses Canadian source data
(2000, Government of Canada with permission from Matural Resources
Canada from MRCan's GeoGratis web site (hitp:/fgeogratis. cadi.gc.caf).

Server Type: WES 1.0.0 [ et |

| cancer |

1. The pull-down menu shows a list of WFS servers (you can add a different server
if you don't find the one you want).

2. Click on “Connect”. gvSIG connects to the server.

3. and 4. When the connection is made, a welcome message from the server
appears, if this has been configured. If no welcome message appears, you can
check whether you have successfully connected to the server if the “Next” button is
enabled.

5. The WFS version number that the server you have connected to is using is
shown at the bottom of the box.

N.B. You can select the “Refresh cache” option which will search for information from the
server in the local host. This will only work if the same server was used on a previous
occasion.
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5.4.2.3 Accessing the service
Click on “Next” to start configuring the new WFS layer.

When you have accessed the service, a new group of tabs appears. The first tab
(“Information”) shows all the information about the server and about the request that is to
be sent. This information is updated as more layers are selected.

E__ e &
File ', Genreference |, JDEC  WFS | WS ', WCS | ArciMS

Information \. Layers \Anrihutes \Opliuns\

Service information
Server http:f fwww? dmsolutions. cafogi-hin/ mswis_gmap
Server Type Wrs 1.0.0
Title DM Solutions' WFS Dema Senver

Summary This demanstration server was setup by DM Solutions
Group ¢http: £ fanev dimsolutions caf) and is powered by
MapServer (http: ffmapserver.gis. urmn.edu/). This server
uses Canacian source data (02000, Government of
Canada with permission from Matural Resources Canada
from MECan's GeoGratis web site
(hitp: f fgeogratis.caci.ac.caf)

Properties
Timeout 10000
Buffer 1000

Server Type: WFS1.0.0 Previous | | Mext |

| cancel |

5.4.2.4 Selecting “Layers”

The “Layers” tab can be used to select the layer you wish to load. A two-column table
appears in which the layer name and the geometry type are shown. As the geometry type
is obtained by clicking on the layer (it needs to be obtained from the server), this column is
completely blank at the start.

The “Show layer names” option shows the name of the layer as it is recognised by the
server and not by its description, which is what appears in the table by default.
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Bl
B Open layer

(]

File |, Georeference | JDBC ' WES | WS | WCS | ArciMS |

Infarrnation * Layers \ Attributes | Options 'y
Layer name
Canadian Land |

Select the layer
Layer name Geometry type ‘

Grid

Railroads

L5 Lakes

Roads Ceometry
Federal Limit

Canadian Land GCeometry
Farks

Lakes

Provincial Borders

Cities

S Land

[] showe layer names

Server Type: WFS 1.0.0 | Previous | | Mext |

[ ok J[ canca |

5.4.2.5 Selecting “Attributes”

The “Attributes” tab allows the fields (or attributes) of the selected layer to be selected.
When the layer is loaded, only the fields that have been selected are retrieved.

To select the attributes, enable the check box which appears to their left.
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o Ahadir capa ——
Archivo ', Georreferenciar | JDBC © WES | WS | WCS ' ArciMs

Informacién |, Capas ' Atributos | Opciones ' Fiftro |

Seleccionar campos de la capa

Mombre | Tipo
grid gridType

--[v] msGeametry Ceometria
] FNODE_ string

THODE_ string
t[w] LPOLY string
e [v] RPOLY string
t[w] LENGTH string
i GRID string
- GRID_ID string
] F_CODE string
B F_TYPE string

Tipo de servidor: WFS 1.0.0 | Anterior | | Siguiente |

| Aregtar H Cancelar |

5.4.2.6 “Options” tab

The "Options” tab shows information about user authentication and the connection. The
“User” and “Password” fields are used in the WFS-T to be able to identify a user in the
server so that writing operations can be carried out (not yet implemented).

The connection parameters are:

- Number of features in the buffer, i.e. the maximum number of elements that can be
downloaded.

- Timeout. This is the length of time beyond which the connection is rejected as it is
considered to be incorrect. If these parameters are very low, a correct request may not
obtain a response.

The Spatial Reference System (SRS) is another important parameter. Although this cannot

currently be changed, it is hoped that this will be possible in the future. In any case, gvSIG

reprojects the loaded layer to the spatial system in the view.
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5.4.2.7 Filter

[ Open layer =]

File |, Georeference | JDBC ' WES | WS | WCS | ArciMS |

Information | Layers | Attributes © Options |

rSrs

rConnection

Tirmeout

Server Type: WFS 1.0.0

You can use this tab to apply filters to your WFS layers.

Click on the “Filters” tab in the window.

[ Ajustar capa WF5S 2

Informacidn \ Capas \ Atributos \ Opciones  Filtro \\'
rFiltro sobre una capa WFS

Carnpos valores:

[N [
Lena] Cor J (i) [0

[ Eorrar texto |

Cancelar ] ’ Aplicar ]i Areptar
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The “Fields” text box shows the layer’s attributes which can be used as a filter. Click on the
selected field to see its values.

When the layer is loaded for the first time, the values in the column cannot be selected.
However, if you have a filter sentence for the layer you can apply it in the filter text area and
the filtered layer will be loaded directly.

If you do not have a filter sentence, load the WFS layer into the ToC, then right click on the
mouse and select the “WFS properties” option from the contextual menu.

To create the filter for the WFS layer, double click on the field you wish to use as a filter
and it will appear in the bottom text area. Then click on the operator you wish to apply and
finally select the value in the “Values” text area by double clicking on it.

3 Ajustar capa WFS x

Infarmacidn \'. Capas \Alributns \'. Opciones * Filtro \
Filtro sobre una capa WF5s

Carpos: Yalores:

- gid Acleducto Tajo-Segul®
~entity Canal Baix de I'Algar |
layer Canal Primera Deswia
el la=all L=l | Date | |canal Xlguer-Tdria

----- elevation | <« Il # || «= || == | |Canal d'El Progrés
ecal Canal o'El Progrés - =
- EE;;D Land | [ or J{ Nt J[ 0 J|cana areix =
L tipo | Borrar texto | [Canal de Benagéher

Canal de las 5alinas
Canal del Jucar

"codign” < » 'Canal Xoguer-Taria'

Cancelar | | Aplicar || Arceptar

When you have created the required filter, click on “Ok” and it will be applied to the WFS
layer.

5.4.2.8 Adding the layer to the view

When all the parameters have been configured, click on “Ok”. The layer will be loaded into
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a gvSIG view.

5.4.2.9 Modifying the layer’s properties

By right clicking on the layer, its contextual menu appears. If the “WFS Properties” option
is selected, an option display opens (similar to the “Add layer” display). This can be used to
select new attributes and other layers and change the layer’s properties.

" view : Untitled -

E}"' @ Car—= il [
e Change colar
|

dd B

::—_l Gro Rename

Zoom to layer

Delete layer
Reload

Group layers

o Bring to front

Copy
Cut

5.4.3 Adding a layer using the WMS protocol

5.4.3.1 Introduction

Part of the gvSIG philosophy in its creation included the implementation of open standards
for access to spatial data. Thus, gvSIG includes a WMS client which complies with the
current OGC (Open Geospatial Consortium, http:/www.opengeospatial.org) standard.

5.4.3.2 Connecting to the service
Go to the "Add layer" window and then select the WMS tab.
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m Open layer

File |, Georeference | JDBC | WFS ' WMS | WCS | ArciMS |

]

Server

|http:,f,fmﬂ:.catastm.meh.es,fCanugrafia,fWMS,fSENidDrWMS. aspx |v|

[ ] Refresh cache Caonnect |

Description
Marnea:

Cartografia Catastral de la Direccidn General del Catastro.

Este servicio es de uso libre v gratuita.

La cartografia se actualiza diariamente descde
las bases cartograficas del Catastro.

Mo tiene la categoria de cartografia oficial,
por 1o gue no cdebe ser utilizada para ningdn tipo de certificado.

Mo esta permitida la descarga masiva de
porciones de cartografia.

La DG, del Catastro se reserva el derecho de
restriccion del servicio por abuso del mismo.

Server Type: W/MS1.1.1

ext |

| Cancel |

1. The pull-down menu shows a list of WMS servers (you can add a different server

if you don’t find the one you want).

2. Click on “Connect”.

3. and 4. When the connection is made, a welcome message from the server
appears, if this has been configured. If no welcome message appears, you can
check whether you have successfully connected to the server if the “Next” button is

enabled.

5. The WMS version number that the connection has been made to is shown at the

bottom of the box.

5.4.3.3 Accessing the service

Click on “Next” to start configuring the new WMS layer.
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When you have accessed the service, a new group of tabs appears.

The first tab in the adding a WMS layer wizard is the information tab. It summarises the
current configuration of the WMS request (service information, formats, spatial systems,
layers which make up the request, etc.). This tab is updated as the properties of its request
are changed, added or deleted.

m Open layer ﬁ

File |, Georeference | JDBC | WFS " WMS | WCS | ArciMS |

Information \ Layers \St\,-des \Dimensinns \ Farmats \

Service information

Server http:fjowvc catastro meh. esfCartografiaf ks Semvidarithd s
.aspx

Server Type k5 1.1.1
Title -

Summary Cartografia Catastral de la Direccidh General del
Catastro. Este sernvicio es de uso libre v gratuito, La
cartografia se actualiza diariamente desde las bases
cartograficas del Catastro. Mo tiene la categoria de
cartografia oficial, por lo gue no debe ser utilizada para
hingun tipo de cenificado. Mo esta permitida la descarga
rmasiva de porciones de cartografia. La DG, del Catastro
se reserva el derecho de restriccion del servicio por
abusa del misma.

Properties
Format Mone zelected

SRS Mone selected

Server Type: WHMS1.1.1 Prewioys | | Mext |

| Cancel |

5.4.3.4 Selecting “Layers”

The wizard’s “Layers” tab shows the WMS server’s table of contents.

© 2007 Conselleria de Infraestructuras y Transporte Page 57 of 409



S1G,
gvSIG — User guide y

m Open layer ﬁ
File |, Georeference | JDBC | WFS " WMS | WCS | ArciMS |
Information Lax-"Er’S\SMES\DimEnSiDnS ', Farmats ',

Layer name
|WMS Layer

Select raster layers

(= [Catas...
[ [Carto...

[Cartografia] Catastro

[+ 12]

Maintain layer structure

[#] Show layer names | Add || Remowe

Server Type: WS 1.1.1 | Previous | | Mext |

Select the layers you wish to add to your gvSIG view and click on “Add”. If you wish, you
can choose a name for the layer in the “Layer name” field.

N.B. Several layers can be selected at the same time by holding down the “Control” key
and left clicking on the mouse.

N.B. To obtain a layer description move the cursor over a layer and wait a few seconds.
The information the server has about these layers is shown.

5.4.3.5 Selecting “Styles” for the WMS server layers

The “Styles” tab allows you to choose a display view for the selected layers. However, this
is an optional property and the tab may be disabled because the server does not define
styles for the selected layers.

June 2007 Page 58 of 409



S|

gvSIG — User guide &
:_: Open layer E
File |, Georeference | JDBC | WFS " WMS | WCS | ArciMS |
Information | Layers * Styles | Dimensions | Formats |
= Selected layers
-G [Cartografia] Catastro
“ (@ Default
Server Type: WS 1.1.1 Prewious | | Mext |
| Cancel |

5.4.3.6 Selecting values for a WMS layer’s “Dimensions”

The “Dimensions” tab helps to configure the value for the WMS layer dimensions.
However, the dimensions property (like the styles property) is optional and may be
disabled if the server does not specify dimensions for the selected layers.
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m Open layer ﬁ
File |, Georeference | JDBC | WFS " WMS | WCS | ArciMS |
Information |, Layers |, Styles  Dimensions \ Formats ||

Dimension
Settings

Settings editor

TIME Value: 1983-0&-30

= —
IR L/ 96 [LAL]
() Single wvalue
() Multiple walue
) Interval
| g || Clear |
| |
| Sat |

Server Type: WMS1.3.0 | Prewious | | Mext |

| Cancel |

No dimension is configured by default. To add a dimension, select one from the “Settings
editor” area in the list of dimensions. The controls in the bottom right-hand corner of the
tab are enabled. Use the slider control to move through the list of values the server has
defined for the selected dimension (for example “TIME” refers to the dates the different
images were taken). You can move back to the beginning, one step back, one step forward
or move to the end of the list using the navigation buttons which are located below the
slider control. If you know the position of the value you require, you can simply write it in
the text field and it will move automatically to this value.

Click on “Add” so that you can write the selected value in the text field and request it from
the server.

gvSIG allows you to choose between:
Single value: Only one value is selected
Multiple value: The values will be added to the list in the order they are selected in
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Interval: An initial value and then an end value are selected

When the expression for your dimension is complete, click on “Set” and the expression will
appear in the information panel.

N.B. Although each layer can define its own dimensions, only one choice of value is
permitted (single, multiple or interval) for each variable (e.g. for the TIME variable a
different image date value cannot be chosen in each layer).

N.B. The server may come into conflict with the layer combination and the variable value
you have chosen. Some of the layers you have chosen may not support your selected
value. If this occurs, a server error message will appear.

N.B. You can personalise the expression in the text field. The dialogue box controls are
only designed to make it easier to edit dimension expressions. If you wish you can edit the
text field at any time.

5.4.3.7 Selecting the format, spatial system and/or transparency

The “Formats” tab allows you to choose the image format the request will be made with,
specify if you wish the server to hand in the image with a transparency (to superimpose the
layer onto other layers the gvSIG view already contains) and also the spatial reference
system (SRS) you require.
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m Open layer ﬁ
File |, Georeference | JDBC | WFS " WMS | WCS | ArciMS |

Infarmation \ Layers \Stwes \Dimensinns " Fortmats ‘\‘

Select formats

imagefpng
imagefjpeg
imadge fgif
imagefbmp
imadge ftif
image fwrmf

[v] Transparency
Select SRS

EPaG:23029
EPSGI22020
EP3Gi23031
EPSGi32627
EPzGiZ2628
EPSG:32623
EP3GI22630
EPSGi32631

il

Server Type: WMS 1.1.1 | Prewious |

| k. || Cancel

5.4.3.8 Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button is enabled. If
you click on this button, the new WMS layer will be added to the gvSIG view.
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& view: Untitled -
=¥ [Z] Catastro

- [

- Rename

15
Zoom to layer

Delete layer

Ering to front

Copy
o [] Cut

WS Properties

Raster properties

5.4.3.9 Modifying the layer's properties

Once the layer has been added its properties can be modified. To do so, go to the Table of
contents in your gvSIG view and right click on the WMS layer you wish to modify. The
contextual menu of layer operations appears. Select “WMS Properties”.

The “Config WMS layer” dialogue window appears. This is similar to the wizard for creating
the WMS layer and can be used to modify its configurations.

5.4.4 Adding a layer using the WCS protocol

5.4.41 Introduction

The WCS (Web Coverage Service) is another of the OGC standards supported by gvSIG.
The WCS is a coverage server. It is different from WMS as this standard defines a map as
a representation of geographic information in the shape of a digital image file which can be
shown on a computer screen. The map does not include its own data but WCS, however,
does provide its own data, which can subsequently be analysed. WCS therefore allows
raster data to be analysed just as WFS allows vector data to be analysed.
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m Open layer
File |, Georeference | JDBC | WFS | WMS * WCS | ArcIMS |
Server

http: fimaps. gdal. org/cgi-binf/mapsery_dem

Description
Marne: SRTMZ0PIUs WS Server

Connect

|v|

Mext

H

| cancel

1. The pull-down menu shows a list of WCS servers (you can add a different server

if you don’t find the one you want).

2. Click on “Connect”. gvSIG connects to the server.

3. and 4. When the connection is made, a welcome message from the server
appears, if this has been configured. If no welcome message appears, you can
check whether you have successfully connected to the server if the “Next” button is

enabled.

5.4.4.2 Accessing the service
Click on “Next” to start configuring the new WCS layer.

When you have accessed the service, a new group of tabs appears.
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The first tab in the adding a WCS layer wizard is the information tab. It summarises the
current configuration of the WCS request (service information, formats, spatial systems,
layers which make up the request, etc.). This tab is updated as the properties of its request
are changed, added or deleted.

m Open layer ﬁ
File |, Georeference | JDEC | WFS | WMS * WCS | ArcIMS |

Information | Coverage | Format | Time ' Parameters

Service information
Server -
Server Type WCs 1.0.0
Title 5RTMZ3OPIus WCS Server

Summary

Properties
Format Mone selected

CRS Mone selected

Prewious | | Mext |

| Cancel |

5.4.4.3 Selecting “Coverages”

Select the coverage you wish to add to your gvSIG view. If you wish, you can choose a
name for your layer in the “Coverage name” field.
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:_: Open layer m

File |, Georeference | JDBC | WFS | WMS * WCS | ArciMS |

Information | Cowerage \ Format ', Time ' Faramaters '

rCoverage's name
|SRTM 30 Plus DEM

rSelect Coverages
SETM 20 Plus DEM

[ ] 5howe layer names

[ Prewious l[ Mext l

5.4.4.4 Selecting the “Format”

You can choose the image format you wish to use to make the request and reference
system (SRS) in the “Format” tab.

L EEEEEEEEEREEEEEESSSSSs.
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H

m Open layer
File |, Georeference | JDBC | WFS | WMS * WCS | ArciMS |
Infarmation ', Coverage ' Farmat \Time Y Parametars

Select format
CEOTIFF_IMT 16

Select CRS

EP5C 4265
EPSC:4226

| Previous |

| k. || Cancel

N.B. Tabs such as “Time” and “Parameters” are disabled in this case. Configuring these
variables depends on the server chosen and the type of data it has access to.

5.4.4.5 Adding the layer to the view

As soon as the configuration is sufficient to place the request, the “Ok” button is enabled. If
you click on this button, the new WCS layer will be added to the gvSIG view.
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5.4.4.6 Modifying the layer’s properties

Once the layer has been added its properties can be modified. To do so, go to the Table of
contents in your gvSIG view and right click on the WCS layer you wish to modify. The
contextual menu of layer operations appears. Select “WCS Properties”.

The “Config WCS layer” dialogue window appears. This is similar to the wizard for creating
the WMS layer and can be used to modify your configurations.

5.4.5 Adding a layer using the ArcIMS protocol

5.4.51 Introduction to ArcIMS

In the proprietary software environment, ArcIMS (developed by Environmental Sciences
Research Systems, ESRI) is probably the most widespread/popular widely used (Internet)
cartographic server on the Internet thanks to the number of clients it supports (HTML,
Java, ActiveX controls, ColdFusion...) and to its integration with other ESRI products.
ArcIMS is currently one of the most important remote cartographic information providers.
Although the protocol it uses does not comply with the Open Geospatial Consortium
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(because it was created long beforehand), the gvSIG team believes that offering support
for ArcIMS is important.

5.4.5.2 Connecting to image services

The extension can access image services offered by an ArcIMS server. This means that,
just like a WMS server, gvSIG can request a series of layers from a remote server and
receive a view rendered by the server containing the requested layers in a specific
coordinate system (reprojecting if necessary) and in specific dimensions. In addition to
displaying geographic information, the extension allows you to request information about
the layers for a particular point via the gvSIG standard information button.

ArcIMS is slightly different in its philosophy from WMS. In WMS, the request is normally
made by independent layers whilst in ArcIMS the request is global.

The steps required to request a layer from an ArcIMS server and to request information for
a particular point are listed below.

5.4.5.3 Adding a layer using ArclMS

Our example uses the ESRI ArcIMS server. Its URL is http://www.geographynetwork.com.
This is the address a web browser requires to access the HTML visual display unit.

Before loading a layer from this server, the datum WGS84 in geodesic coordinates (code
4326) has to be set up previously as the view’s spatial system.

5.4.5.3.1 Connecting to the server

If the extension is loaded correctly, a new ArcIMS data source will appear in the “Add layer”
dialogue box (fig. 1).
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Open layer

File |, Georeference | [DBC |, WFS | WMS | WCS " ArcIMS |

Server

|http:wa.geugraphwetwnrk.cnm ||

[ twverride services list Connect |

Service name

Available services

SBEMRF WErSinn: -

| Cancel |

Figure 1: Adding a new layer to the view

If the server has a standard configuration, simply indicate its address. gvSIG will try to find
the servlet’s full address." If the servlet has a different path, you will have to write it into the
dialogue box.

When the connection has successfully been made, the server version, its compilation
number and a list of image and geometry services available are shown.

1In our case, the full address is
http://www.geographynetwork.com/servlet/com.esri.esrimap.Esrimap
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The service can be selected from the list or can be written in directly.

Finally, if the “Override service list” check box is enabled, gvSIG will delete any catalogue
that has already been downloaded and will request them again from the server.

Open layer

File |, Georeference | [DEC | WFS | WS | WCS * ArciMS |

Server

|http:me.geugraphwetwurk.mm [=]

[ ] Owerricle services list Connect |

Service name

|Cen5u5_PDpuIati|:|n |

Available services

Marme Twpe Status |
Arlas_States_Counties mage=erver EMABLED E
Arlas_Timezones mage=erver EMABLED
Arlas_Watersheds mage=erver EMABLED —
CEl_Eelief Imageserver EMABLED
Calif_Watershed mage=erver EMABLED _
Census_Density mage=erver EMABLED
Census_Diversity mage=erver EMABLED
Census_Population mageserver EmMLARLED
Census_Population_F3 Featureserver EMABLED
Census_TIGERZ QOO mage=erver EMABLED
EDU_Ajrport_Fs Featureserver EMABLED
ECU_Flaorica mage=erver EMABLED
ECU_Philippines mage=erver EMABLED
EDU_%equoia mage=erver EMABLED =

Server version: 9.1.0{1084.2174) | Mext |

Figure 2: List of services available

5.4.5.3.2 Accessing the service

The next step is to select the ImageServer type service required by double clicking or
selecting it and clicking on "Next". The dialogue box changes and an interface with two
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tabs appears (fig. 3). The first tab shows the metainformation given by the server about the
service’s geographic limits, the acronym of the language it has been written in, units of
measurement, etc. It is a good idea to find out if a coordinate system has been defined in
the service (using EPSG codes) as this can directly influence the requests made to the
server, as Figure 3 shows.

N.B. If no coordinate system has been defined in the service, the extension will assume
that it is the same coordinate system as the one we have defined for the view.
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Sl

Open layer

File |, Georeference | [DEC |, WFS | WMS | WCS " ArcIMS |

Information ‘1 Layers ".I

Data source

SEernver

Service

Service type
Properties

X range

¥ range

Language

Units

Country

Coordinate
System

DPI

Max. humber of
pixels

hitp: S Masatie. geOgraphsynetwork. camfservetfcam. esri
.esrimap. Esrimap

Census_Population

Faster serdce

[ -170.0, -66.0 ]
[ 160, 72.0]
English

Decimal dearees
United States

Mot available

96
1048576

SBEMRF WErSinn:

9.1.0(1084.2174 |  Previous ||

Mext

| Cancel

Figure 3: Metadata from the ArcIMS server

We can continue by clicking on "Next" or return to the previous dialogue by clicking on

"Change service”.
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5.4.5.3.3 Selecting layers

The last dialogue box is the layer selection. We can define a name for the gvSIG layer or
leave the default value (the service name) in this window. A box appears below with a list
of the service layers in tree form. When the mouse is moved over the layers, information
about these layers appears: extension, scale ranges, type of layer (raster or vector image)
and if it is visible by default in the service (fig. 4).

Open layer

File |, Geareference | DBC | WFS |, WMS | WCS "~ ArciMS |

Information Lavers \".

Mew layer's name
|Cen5u5_F‘upuIati|:|n

Available layers

= Sendce: Census_Population | 4
----- [ Oceans and Seas
----- ] Mon-U.5. Land

----- [ Population b State

""" 0 Popuid 1o Nan-us. Land
----- {1 Populd Mame: Mon-U.S. Land =
= Tyhe: Feature class

Wector tyine: Polygon

[ ] Show layer | Max. scale: Mot available

Min. scale: Mat awvailakle

YWisifble: true

Selected laye  prupiope o ranger: [ -180.0, 180.0 ]
Emvelope & range): [ -90.0 , §3 623596 | T

(CIPMG24

| Add all

|
|
| Femowe |
|

EY
k*

| Femove all

Server version: 9.1.0({1084.2174) |  Previous |

Figure 4: Metadata from a service layer
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We can view each layer’s ID via the “Show layer ID” check box. This check box is useful
when there are layers whose descriptor is repeated. Therefore, the only way to distinguish
between them is via an ID, which will always be unique. A combo box is also available to
select the image format we wish to use to download the images. We can choose JPG
format if our service works with raster images or one of the other remaining formats if we
want the service to have a transparent background.

N.B. The transparency in 24-bit PNG images is not correctly displayed in gvSIG 0.6. This
type of files will be supported in gvSIG 1.0.

The box with the layers selected for the service appears below. If you wish, you can add
just some of the service layers and also reorganise them. This makes the service view
totally personalised.

N.B. The configuration cannot be accepted until a layer has been added.

N.B. Multiple selections of service layers can be made by using the Control and CAPS
keys.

5.4.5.3.4 Adding the layer to the view

When the “Ok” button in the dialogue box is pressed, a new layer appears in the view (fig.
5). If no layer has been added previously, the extension of the ArcIMS layer is shown, as
per the standard gvSIG procedure.
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Figure 5: ArcIMS layer added to the gvSIG view.

It must be remembered that when the layer extension is shown, the layers that make up
the chosen configuration may not appear and a blank or transparent image appears
instead. If this occurs, use the scale control dialogue box (V. Information about scale limits
section).

5.4.5.4 Points to remember about spatial reference systems

An ArcIMS server does not define the spatial reference systems it supports as opposed to
the WMS specification. This means that a priori we do not have a list of EPSG codes that
the map server can reproject. In short, ArcIMS can reproject to any coordinate system and
leaves the responsibility of how the projections are used to the client.

Therefore, if our gvSIG view is defined in ED50 UTM zone 30 (EPSG:23030) and we
request a global coverage service (stored for example in the geographic coordinates
WGS84, which correspond to code 4326) the server will not be able to reproject the data
correctly because we are using global coverage for a projection of a specific area of the
Earth.
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However, the procedure can be carried out in reverse. If we have a view in geographic
coordinates (and thus global coverage), services defined in any coordinate system can be
requested because the server will be able to transform the coordinates correctly.

In short, requests to the ArcIMS server must be made in the view's coordinate system and
they cannot be requested in another coordinated system.

Moreover, as we mentioned above, if an ArcIMS server does not offer information about
the coordinate system its data is in, the user will be responsible for setting up the correct
coordinate system in the gvSIG view. Thus, if a user with a view in UTM adds a layer which
is in geographic coordinates (even though the server does not show it), the service will be
added correctly but will take the view to the geographic coordinates domain (in
sexagesimal degrees).

An additional effect is that if the view uses different units of measurement from the server,
the scale will not be shown correctly.

5.4.5.5 Modifying the layer's properties

The layers requested from the server can be modified via a dialogue box, which can be
accessed from the layer’s contextual menu (fig. 6) just like the WMS layers. This dialogue
box is similar to the box used to load the layer, apart from the fact that the service cannot
be changed.
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Figure 6: Properties of the ArcIMS layer

Information about scale limits

The extension allows us to consult the layers' scale limits which make up the requested
service via a dialogue box which can be maintained in the view during the session (fig. 7).
This window shows the layers on the vertical axis and the different scale denominators on
the horizontal axis via a logarithmic scale. This box is small on screen but can be enlarged
to improve the difference between the scales.

The vector layers, raster layers and the layers that can be seen on the current scale
(marked with a vertical line) in a darker colour and the layers we cannot see above or
below the current scale are differentiated by different coloured bars (described in the
window legend).

June 2007

Page 78 of 409



S| gg
gvSIG — User guide ) d

@ Capa: ESRI_Satellite - Estado de los =10l x|
sible
- - T 1
Limites de escala Vortoria) EEE
Raster
Escala
=0 o o S SES S s
LE & 8T §ES §ES 6 ®
Satellite ma..
ggz:::”;%.tfllite Imagery Sk] Sakelite Imagery (Skm |
Country Bou..
Country Bou..
Administrati..
E ila actual

Cerrar |

Figure 7: Scale limits status

5.4.5.7 Attribute information requests

Attribute information requests about the elements for a particular point is one of gvSIG’s
standard tools. Its functionality is also supported by the extension.

The WMS specification allows information about several layers to be requested from the
server in one single query. This is different in ArcIMS. We need to make one server
request per layer required.

This means that no requests for unloaded layers or unseen layers that are not visible on
the current scale or layers whose extension is outside the view will be made. Even if all
these layers are filtered, the information request usually takes longer than is desirable
because of this intrinsic feature of ArcIMS.

When all the request responses have been recovered, the standard gvSIG attribute
information dialogue appears with each of the layers (LAYER) which return information as
atree. If we click on a layer, its name and ID appear on the right (fig. 8).

Under this node, if we are talking about a vector layer, all the records or geometric
elements the server has responded to appear, and give each one their corresponding
attributes (FIELDS).
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If it is a raster layer, such as an orthoimage or a digital terrain model, it returns the values
for each of the bands (BAND) in the requested pixel colour, instead of records.

E'B R

55

Figure 8: Displaying attribute information

5.4.5.8 Connecting to geometry services

The extension allows access to both ArcIMS image services and geometry services
(Feature Services). This means that a server can be connected to and geometric entities
(points, lines and polygons) and their attributes obtained. This is not dissimilar to WFS
service access.

However, the variety of existing geometry services is much lower than the variety in the
image server. There are two main reasons for this. On one hand, providing the public with
vector cartography implies security problems because many bodies only want to offer the
general public views and images. The vector data becomes either an internal product or
must be paid for. On the other hand, this type of services generate much more traffic on
the network and in the case of basic information servers could become a problem.

5.4.5.9 Adding a geometry layer

Loading a geometry layer is practically the same procedure as loading the image server as
mentioned above (Accessing the service section and the following sections). In this case,
the number of layers to be selected must be taken into account. If we wish to download all
the layers offered by the service the response time will be very high.
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The only difference between loading an image layer is that in this case we can choose
whether we wish the layers to be downloaded as a group via a check box. This is useful for
processing the vector layers as one layer when it needs to be moved and activated in the
table of contents.

Unlike the image service, in which all the service’s layers appear as one unique layer in the
gvSIG view, in this case each layer is downloaded separately and appears in the view
grouped under the name defined in the connection dialogue.

5.4.5.10 ArcIMS symbols

Cartography symbols are configured in the server in one AXL extension file for both
geometry and image services. We can divide symbol definition into two parts. On one
hand, we can talk about the definition of the symbols themselves, i.e. how a geometric
element, such as a line or polygon, should be presented. On the other hand, we can talk
about the distribution of these symbols according to the cartographic display scale or to a
specific theme attribute.

In ArcIMS terminology symbols are different from legends (SYMBOLS and RENDERERS).

5.4.5.11 Symbols

There are various types of symbols: raster fill symbols, gradient fill symbols, simple line
symbol, etc. The extension adapts the majority of the symbols generated by ArcIMS. Table
1 shows the ArcIMS symbols and indicates whether they are supported by gvSIG.

‘Label Hdescription H Supported
CALLOUTMARKERSYMBOL Balloon-type label .~ NO
CHARTSYMBOL Pie chart symbol .~ NO
GRADIENTFILLSYMBOL  Fill in with gradient .~ NO
RASTERFILLSYMBOL Fill with raster pattern .~ YES
RASTERMARKERSYMBOL  Point symbol using pictogram .~ YES
RASTERSHIELDSYMBOL  Customised point symbol for US roads .~ NO
SIMPLELINESYMBOL Simple line . YES
SIMPLEMARKERSYMBOL  Point ~YES
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SIMPLEPOLYGONSYMBOL  Polygon YES
SHIELDSYMBOL Point symbol for US roads .~ NO
TEXTMARKERSYMBOL  Static text symbol .~ NO
TEXTSYMBOL Labelling symbol . YES
IRUETYPEMARKERSYMBO Symbol using TrueType font character NO

Table 1: ArcXML symbol definition labels

In general, the most common symbols have been successfully “transferred”. Some of the
symbols cannot be obtained directly from gvSIG (at least in the current version), such as
the raster fill symbol or they need to be “adjusted” such as the different types of lines. This
means that a raster fill symbol is not a symbol that can be defined by the gvSIG user
interface, but it can be defined by programming.

5.4.5.12 Legends

gvSIG supports the most common types of legends: unique value and range and value
themes as well as the scale-range control over the whole layer. ArcIMS goes much further
in its configuration. It can generate much more complicated legends in which symbols can
be grouped together, scale-range controls can be established for labels and symbols and
different labelling based on an attribute can be shown (as though it were a value theme for
labelling).

This group of legends can generate very complex symbols for a layer in the end. The
current implementation status of the gvSIG symbols needs to be simplified to reach a
compromise to recover the symbols that best represent the layer as a whole.

Label HDescription

GROUPRENDERER HLegend which groups others together \
SCALEDEPENDENTRENDERER Scale dependent legend |
SIMPLELABELRENDERER Labelling layer legend |
SIMPLERENDERER Unique value layer legend |
VALUEMAPRENDERER Value and range themes |
VALUEMAPLABELRENDERER  Labelling themes |

Table 2: ArcXML legend definition labels
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When a GROUPRENDERER is found, the symbol ArcIMS draws first is always chosen.
Thus, in the case of the typical motorway symbol for which a thick red line is drawn and a
thinner yellow line is drawn over it, gvSIG will only show the red line with its specific
thickness.

If a scale dependent legend is discovered during a symbol analysis, this is always chosen.
If more than one is discovered, the one with the greatest detail is chosen. For example, in
ArcIMS we can have a layer with simple road symbols (only main roads are drawn) on a
1:250000 scale and based on this a different theme is shown with all types of roads (paths,
tracks, roads, etc.). In this case, gvSIG will show this last theme as it is the most detailed.

If a labelling legend is discovered during a symbol analysis, it will be saved in a different
place and will be assigned to the selected definitive legend. In the case of the
VALUEMAPLABELRENDERER label, only the legend of the first processed value will be
obtained as a label symbol. The rest will be rejected.

In short, it is obvious that the failure to adapt the legends for gvSIG is a simplification
process in which different legend and symbol definitions must be rejected to obtain a
legend which is similar to the original as far as possible. It is to be expected that the gvSIG
symbol definition will improve considerably so that it can support a larger group of cases in
the future.

5.4.5.13 Working with the layer

Working with the layer is similar to any other vector layer, as long as we remember that
access times may be relatively high. The layer attribute table can be consulted, in which
case the records will be downloaded successively as we display them.

If we wish to change the table symbols to show a unique value or range theme we must
wait as gvSIG requests the complete table for these operations. On the other hand, the
downloading of attributes is only carried out once per layer and session and therefore, this
wait only occurs in the first operation.

In general, if our ArclIMS server is in an Intranet, it will be relatively fast to handle, but if we
wish to access remote services we may be faced with considerable response times.

The main feature to bear in mind when working with an ArcIMS vector layer is that the
geometries available at any given time are only the ones displayed. This is because we
can connect to huge layers but only the visible geometries are downloaded. As far as
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gvSIG is concerned, the geometries shown on the screen are the only ones available and
thus, if we export the view to a shapefile for example, are only a part of the layer.

Finally, we need to remember that to speed up the geometry downloads they are simplified
to the viewing scale in use at any given time. This drastically reduces the amount of
information downloaded as only the geometries that can actually be "drawn" are displayed
in the view.

Loading a geometry layer is practically the same procedure as loading the image server as
mentioned above (Accessing the service section and the following sections). In this case,
the number of layers to be selected must be taken into account. If we wish to download all
the layers offered by the service the response time will be very high.

Unlike the image service, in which all the service’s layers appear as one unique layer in the
gvSIG view, in this case each layer is downloaded separately and appear in the view
grouped under the name defined in the connection dialogue.

After a few seconds the layers appear individually but are grouped under a layer with the
name we have defined for it.

The layer symbols are established at random. A pending feature is to recover the service
symbols and configure them by default so that gvSIG can display the cartography as
similarly as possible to how it was established by the service administrator.

5.4.6 Adding orthophotos using the ECWP protocol

If you wish to add an orthophoto to gvSIG using the ECWP protocol, first open a view and
click on the “Add layer” button.

Click on the “Add” button in the dialogue box. A file browser window appears.
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Choose the “gvSIG Image Driver” option from the “Files of type” pull-down menu.

r Open 2=
Look 1 21 SNEIREL:E
3 datos
3 instalar
File Marme: |El:wp:Hrazter.alava.net,fdatnsjecwmnufmn_SEJCIEJ.El:w |
Files of Type: | g4SIG shp driver ~|

| Qpen || Cancel |

Write the URL of the file you wish to load as follows in “File name”:
ecwp://server address/path of the file you wish to add.

For example:

ecwp://raster.alava.net/datos/ecw/Ortofoto_5000.ecw
ecwp://earthetc.com/images/geodetic/world/MODO0O9A1.interpol.cyl.retouched.topo.bathyme

fry.ecw

When you have input the data, click on “Open”.

The orthophoto will be added to the layer list.
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i Open layer =
File || Georeference | JDBC |, WFS | WMS | WCS | ArcIMS ',
Lavers
Ortofoto_S000. ey ’ A ]
I Delata ]

Select the new added layer and click on “Ok”.

The image will be added to the view.

" view : Untitled - 0

- [¢] |l onofoto_5000.ecw
g M pais.shp

L EEEEEEEEEREEEEEESSSSSs.
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oo [

(% Vista: Sin titulo - 0

..... Ml ortofoto_5000.ecw

i Aplicacidn iniciada Metros =519.297 27 [f=478461185 |1:453064 [EPSCI22030

5.5 Table of contents (ToC)

The “Table of Contents” is the area used to list the different layers which make up the
cartographic information.

A check box next to each layer indicates whether it is "visible” or not.

Remember that an active layer is not the same as a "visible" layer. When a layer is
“active” it is highlighted compared to the other layers included in the “Table of
contents”. When a layer is activated, gvSIG is notified that the elements of this layer can be
worked with.
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(% View: Untitled - 0

=-[v|] A carrilbici.shp

7 Defaun
=1 M riesgo_inundaci

[ Defaun
=] M provin.shp

o [ Defaun

The order of appearance of the layers in the “View” is important because it ties in with the
display order. Layers made up of text elements, points and lines are placed at the top
whilst the polygonal layers and images which make up the background of the view are
placed at the bottom.

To move the layers in the ToC, place the cursor over them, left click on the mouse and
drag the layer to the required position.

The layers in the ToC can also be selected by using the Control and CAPS keys.

5.5.1 Grouping and ungrouping layers

From version 0.4 onwards, gvSIG allows several layers to be grouped together. This is
useful because it means a large number of layers can be kept in the ToC without taking up
a lot of space.

This option also allows operations to be carried out on all the layers that make up a group
at the same time.

To group a set of layers together, select the layers, click and hold down the CAPS key and
right click on the mouse on any of the layers and select the “Group layers” option.
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(% View: Untitled - 0

A carrilbici.shp

- w7 Default

Change calor

Rename

Properties

Zoom to layer

Delete layer
Reload

Bring to front

Copy
F | ;.;.;.;.;.I Cut

Paste

Mame [Crouging |

When the name of the new grouping has been input, it appears in the ToC as shown
below.
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{4 View : Untitled - 0
=¥ 2] Grouping

i [v] M carrilbici.shp
A riesgo_inundac
2 provin.shp

To undo a grouping, right click on the grouping so that the contextual menu appears.
Select the "Ungroup layers" option.

5.6 Copying layers in gvSIG

You can also use gvSIG to copy documents and create copies of the layers you are
working with in your view.

Firstly, select the layer in the ToC and right click on it.

A new menu appears. Select the “Copy” option.

i View : Untitled - 0 3

=-[»] M pais.shp

...... - O Change calar
Rename

................... Properties

Zoom to layer

Delete layer
Reload

Group layers

Bring to front

Cut

Paste

e —————————————————————————————
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You can paste the layer you wish to copy in the same view as the one you are working with
or in a different view, either in the same project or in a different one.

N.B.: Remember that currently if you modify the layer, these changes will be reflected in all
the copies.

If you wish to “Paste” the layer, right click on the point you wish to paste the new copy and
select the “Paste” option.

# view : Untitled - 0

N.B.: You can use this method when working with layer groups.

If you create a layer group, place the mouse pointer over the group name and go to the
“Copy” option, you can “Paste” the whole layer group in the same way as you would with
an individual layer.
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% View : Untitled - 0
=-¥] =] Grouping2 :
P ?2214cuwas_nivel.sh§
M 72213curvas_nivel.sh
M 72212curvas_nivel.sh.
F. | ?2211cur'-.ras_nitrel.sh§

=¥ 2] Groupin

Rename

v [ o34

Zoom to layer

Delete layer
Reload

Qroup layers

Unaroup layers

Bring to front

Copy
Cut

Paste

5.7 Creating a new layer

gvSIG can create a new layer in the following formats: shp, dxf and postgis.
The tool can be accessed from the “View / New Layer” menu.

L

Exportar k

Impartar [ e
Mueyn SHF
Muewo DF

Muewo postgis

1= Afadir capa  AR-0

Propiedades
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5.7.1 Creating a new SHP file

Select the “New SHP” option opens the wizard which will help you create the new layer.

o Nusva capa

Introciucir nombre de la capa

[1aver1

Seleccione el tipo de geometria

Geometry_types

(= Tipo punto
() Tipo multipunto
() Tipa linea

() Tipo Poligona

| < pnterior | siguiente > | Cancelar |

The first window of the wizard allows you to choose the name you wish the new .shp file to
appear with in the ToC, in addition to the geometry type associated with it.
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3 Nueva capa =P
Define los campos
Campao | Tipo | Tamafio | |M|
Muewo_campol String 20 e —
Muewa_campnZ 5tring 20 | Borrar ca... |
Muewo_campos |String v|z0 -
Boolean
Date
Imeger
Cauble
S1ring
| < Anterior | Siguiente > | | Cancelar |

The second window of the wizard allows you to add all the fields you wish to the attribute
table associated with the layer and to define some of the properties of these fields.

To add fields to the table, click on “Add field”. One field is added every time you click on
this button.

If you wish to delete any of the fields created, simply select the field and click on the
“Delete Field” button.

You can edit the rest of the properties from the attribute table in which the fields are
defined.

- Field name: Place the cursor over the field name (“New field” by default) and write the
new name. The maximum number of characters allowed for the field name is 10.

4. Field type: Place the cursor over any of the files in the “Type” field. A pull-down
menu appears in which the type of field you wish to create can be selected.

BOOLEAN: Boolean type data admits “true” or “false” values.

DATE: This allows you to create a field which includes dates. The maximum
number of characters allowed is 8.

INTEGER and DOUBLE are two number type fields. The former is for whole
numbers and the latter for decimal values.

STRING: This is an alphanumeric field type. The maximum number of
characters allowed is 254.
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1. Field length: This allows you to set the maximum number of characters for the field
created (at present, this only applies to String-type fields).

Once the structure of the table associated with the shape file has been determined, click
on “Next”.

Nueva capa

Introducir la ruta del fichero

|
l j Proveccidn actual:  EPSG 220320 |:|

| < Anterior | | Cancelar |

You can save the file in the new window and choose the Reference System for the view
the new layer is going to be inserted into by clicking on the button to the right of “Current
Projection”.
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@ Nuevo CRS

rSeleccione CRS de la vista

Otimos CRSs utilizados:

Coordinate Reference Systems
Fuente Cddigo | MNombre
EPSG 4326 WoEE4
EPSG 22020 EDSO/UTMzone20M
EPSG 22021 EDSO/UTMzone3 1M
Lancelar ” Areptar

If other layers have been inserted in the view, this button will be disabled since the view
already has a selected reference system.

To save the new layer, indicate the file path to save the file in the text box.

Nueva capa

Introducir la ruta del fichero

Proveccidn actual; EPSC 23030 D

l < Anterior I Siguiente > l Fin ” cancelar ]

You can also open the search dialogue box to select the file path the new shape file will be

L EEEEEEEEEREEEEEESSSSSs.
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saved in. To do so, click on the button to the right of the text box. Write the name for the
new layer (remember that this name will appear in the source file of the shape file and that
it may be different to the name which appears in the ToC) and click on the “Save” button.

gvSIG - User guide

it Guardar @ @

Cuardar en; |C3 Muewva carpeta v| |§| |§| |§| |E|g_:

Mornbre de archivo: |NuevaCapa |

b |

Archivos de tipo: |Archi\ru shp

Guardar | | Cancelar |

When you have finished creating a new SHP file, it will be added to the ToC.

In addition, the editing tools will be activated to allow you to create the elements of the new
layer.

tR/000808

DeEzcaagxsixmness x
«+.tacoo BB
| # Vista: Sin titulo - 0

2| M layerl
e Default

et

5.7.2 Creating a new DXF file

The procedure to create a new DXF file is similar to that used to create a new SHP file, as
described in the previous section.
This tool can be accessed from the “View/New layer/New dxf” menu.
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- Ceometria  Tabla  Awuda

Exportar
Impartar
Centrar la wista sobre un punto

{Z Localizador por atributo

J'g Afiadir capa
Mavegacidn

e e

Ovom o

T

Muewa 5HP
Muewn DxF

Muewn postgis

If this tool is selected, the wizard will open a window allowing you to select a path for the
file which is going to create a reference system for the view.

Nueva capa

Introducir la ruta del fichero

Proveccidn actual; EPSC 23030 D

< Anterior I Siguiente > l Fin ” cancelar

5.7.3 Creating a new PostGIS file

If you wish to create a new PostGIS file, go to the menu “View/New layer/New PostGIS”.
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YWista GCeometria  Tahla  Ayuda
Exportar 3 w O G

Importar »

Centrar 12 vwista sobre un punto

CIJ Localizador por atributo

Muewa SHP
= Afadir capa Alt-0 Muewn DXF
Mawegacidn [ Muewo postgis

The initial steps to create a new PostGIS file are similar to those followed in the section on
creating a new Shape file.

The difference lies in the way the new layer is saved, as this is entered into a PostGIS data
base.

Fill in the fields which apply to your connection and click on “Finish”.

# Nueva capa ==
:- : MNombre de la conexidn: |z|
' MAguina; | |
\ J Puerto:
Usuario: | |
Clawe: | |
bd: | |
Driver: |PastGIS |DBC Driver -|
< Amerior [ mn || cancelar

5.8 Adding an Event layer
A new layer can be created from a table in gvSIG by using “Add event layer”.

There are two ways to do this: you can add a table to the project or you can work with a
table associated with one of the layers in the view in which you are working at a particular
time.
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5.8.1 Adding an event layer from a table

Firstly, the table needs to be loaded. To do so, go to the gvSIG “Project manager” and
select "Tables" in document types. Then click on "New".

G Project manager 3

~Document types

AL AE
s

Y ignis Tahles M aps

~Tahles

I ety

Fenatme

Delete

J
Open |
|
|
|

Froperties

~Session properties

Session name:  Untitled
Saved in:
Creation date: Oct 4, 2006

A search dialogue opens to add the table you require. Click on "Add".

L EEEEEEEEEREEEEEESSSSSs.
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Hew table

Ficherno "'. Base de datos "'.
Tables

o pad |

| Delete |

A dialogue box appears in which you can choose two types of data sources: dbf and csv.

A

E Open e e

Look ;. [£3 Tablas REIIE - S

[£] PUMTOS. csw

File Mame: PUMNT 05 cow

Files of Type: |8 string -

gdbms dbf driver

When you have found the table you require, select it and click on “Open”.

gvSIG automatically returns to the "New table" window and adds the table you require to
create the event layer in the text box.
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Hew table
Fichero | Base ce datos |
~Tables
PUMTOS. cow l Add ]
| Delete |
L u |
| Do |
(0]74 ” Cancel

Click on “Ok” to finish the process.

L EEEEEEEEEREEEEEESSSSSs.
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4 Table : PUINTOS.csv
M1 | N2

2 10277886 10035119 1004544  ACE -
3 10165221 10015745 1002541  ACE B
4 10163661 10022346 1002854 M
5 10108604 10016677 1002485 M
& 10110732 10009782 1001483  ACE
7 10016874 10000229 939863  ACE
8 10017934 10007356 1000637 M
3 10051644 9360722 1003378 ALC-30
10 10249102 9365569 1007040 M
11 10182296 9952562 1006062 M ||
12 10130579 9938422 1005885 M e
0 f 470 Total of selected records.

When the table has been added, a view must be active to create its corresponding event
layer and load it. If no view is active, you can return to the “Project manager” and add one
or create a new blank one. When you have activated this view, go to the “Add event layer”
by using the corresponding button in the tool bar:

B

A window with three pull-down menu bars appears.
We can select the table we need to add the new layer from the first pull-down menu bar.
Then, we can select the table fields which will become the X and Y values.

Tahle: PUNTOS. csv -
X N1 -
¥: N1 -

| ok || cancel |

If you click on “Ok”, a new points layer will appear based on the coordinates contained in
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the initial table.

@ View: Untitled - 0 3
=¥ M PUNTOS.csv
B = [Default

5.8.2 Adding an event layer from a table associated with a layer in the
view

If you wish to work with a table associated to the layers in the view, you will firstly have to
activate the attribute table of this layer. To do so, click on the following button in the tool
bar:

If you click on “Add event layer”
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you will see that the table has been added.

5.9 Layer properties

You can access the active layer's properties from its contextual menu (right click on the
layer).

5.9.1 Vector layer

5.9.1.1 Changing colours

Go to the layer's contextual menu and click on the “Change colour” option. A window
opens in which you can select the colour you wish to view the layer with.

Rename

Properties

Zoom to layer

Delete layer

Bring to front

Copy
Cut

There are three ways to select the colour depending on the window tab you select.

Swatches
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Select color

Sweatches \.IHSB \". RGE \'.

Fecent:

]

Preview

n - . Sample Text Sample Text

. . . Sample Text Sample Text -

|ox) [ Cancel ] lﬂeset ]

Selecting the colour from the “Swatches” tab is relatively easy. Place the mouse pointer
over the desired colour on the palette and left click.

The colours you have used recently appear in the "Recent” palette.
HSB

A colour can be defined by its hue, brightness and saturation values. Any colour can be
identified by values of these three variables. Black is obtained when there is an absence of
light. Grey is obtained when the saturation is low (high light interference or mixture). White
is the brightest colour of the greys (maximum frequency of different length waves).

This colour representation model is called HSB (Hue, Saturation, Brightness).

gvSIG has a colour selection window based on the HSB and RGB system which allows
colour to be selected via HSB attributes and also obtain RGB values to reproduce them on
the screen.

The following table shows the Hue variations which are represented on the horizontal axis
of the square. The Saturation variations are represented on the vertical axis and the
Brightness variations are shown on the side bar.
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Select color

Swatches '~ HSB | RGE |

Preview

] -

D Sample Text Sample Text

| oK | cancel | | Reset |

You can set one of the colour values by clicking on the corresponding check box. Click on
the square area to define the values for the other 2 parameters. Slide the horizontal bar to
set the value for the parameter marked with the check box.

When you have defined the colour you require, click on “Ok”.

RGB

RGB colour uses an additive model, in which the primary colours (red, green and blue) are
combined to make other colours.
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Select color

Swatches | HSE * RGE |

. Sample Text Sample Text

Sample Text Sample Text

#
-
Fed 216
-0 BS 170 255
Creen 125 =
0] B85 170 255
Elue 193 1=
0 BS 170 255
Preview:

Lok [ cancer | | Reser

In this case, each primary colour is coded with a byte, so that each value is in a natural
numbers [0, 255] interval. Thus, the RGB combination for black is R=0, G=0, B=0 and

R=255, G=255, B=255 for white.

5.9.1.2 Renaming

If you wish to rename the selected layer, right click on the layer and go to the "Rename”

option.
A new window appears:

i1
o
=
[
i

Write the new name in the text field and click on “Ok”.
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N.B.: When you do this, the layer name changes in the ToC, but the file name is not
changed.

5.9.1.3 Properties
Right click on the selected layer in the ToC to access the properties window.

E"' Iﬂ My P b |
|:| Change calor

Rename

Praperties

Zoam to layer

Delete layer

Ering to front

Copy
Cut

When you click on the “Properties” option, a new dialogue box opens. This can be used to
edit some properties.
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4 Layer properties

General\Symbnls\

MNarme; |muni10000.shp

[l Use spatial index
Scale range
(2) To show always

() Dan't show the layer when the scale

Properties Hyperlink

Extent . T .
— 4519293 26 31 Field [B.MUNICIP | Extension | |
Lower: 41591028.75 ) ) P
Left: GIEEE0 65 Predefined action |L|nktn image files v|
Eight: 81717607

Data arigin:
ST chim Alriuar

ACcept | | Apply | | Sawe legend... | | Load legend... | | Close

The layer name can be changed by writing the new name in the text field in the “General”
tab.

5.9.1.3.1 Using the spatial index

If you mark the “Use spatial index” check box, a spatial index will be created which makes
the layer loaded in the view appear more quickly. This is because the view is loaded using
this index.

If there are write permissions, a .qix file is created with the same name as the layer it is
associated with in the layer’s original directory. If there are no write permissions, the file will
be created in the user’s temporary file directory.

5.9.1.3.2 Scale range
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SCale range
(%) To show akways

() Don't show the laver when the scale

A viewing scale range (maximum and minimum) can be set in the properties window.

5.9.1.3.3 File extension and path

The file extension and path are shown in the actual properties section.

Properties

Extent =
Upper: 4519393 326 |
Lower: 4181039.75 [
Left: G2ERE0 65 §§§§§
Right: 81717607 Egggg

Data arigin: =

S chim Avivar B |

5.9.1.3.4 Hyperlink

A link can be set up between a text, html or image file and a layer element in the properties
window.

To provide a better idea of how the tool works, let us look at the following example. The
aim is to link the image torreelectrica.jpg to a specific element:

- Activate the view in the ToC.
Change the layer into editing mode (“Layer” menu then “Start edition”).

Open the table of attributes and edit the record you wish to create the link to. Write
the path of the file you wish to link without its extension. Press “Enter” to save the
modification made in the table.
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g-[¥] M cons_punt} i Table : Table of attributes: cons_punt.shp B E
' = Default o | mweL | cowor | TIPO |

0.0 E5.0 50 fhome ffalariof/Desktop/torreelectrica jpeg =
0.0 5.0 5.0 Tarre eléctrica ]
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 5.0 Torre eléctrica
0.0 55.0 20.0 Cantera
0.0 55.0 5.0 Torre eléctrica -
0.0 55.0 5.0 Taorre eléctrica e
1/ 349 Total of selected records.

Go to the “Hyperlink” table in the layer properties window and select the field the
record is located in which will be used to create the hyperlink. Write the extension of
the file you wish to link and whether it is an image file (gif, jpg, png) or a text file (at
present gvSIG can only link plain text files (txt, rtf...). Html files can also be linked. In
this case, write html in the “Extension” text box and select “Link to text files”.

Hyperlink

Field |TIPO  ~|Extension| |

Predefined action |Linl<tn:u itnage files v|

Link. to image files
Link. to text files

When all the requirements have been selected, click on “Apply” and then on “Ok”.
Then go the view tool bar and click on the hyperlink button.

oY
A

Select the view element that corresponds to the record which has the associated
link and place the cursor over it. Click on the element. A window appears with the
linked file.
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:_] HiperLink @ @

TIPD : fhomejfalario/Deskt. ..

5.9.1.4 Legend editor

This tool can be used to carry out theme mapping relatively easily.

To symbolise or represent the element data or variables in a layer, you can choose the
most suitable colour, pattern, etc. for each one.

Go to the “Properties” menu (right click on the layer) to edit the legend symbol properties.

E"' . muypinnn ok |
7 . Change color

Fename

Praperties

Zoam to layer

Delete layver

Bring to front

Copy
Cut

A new window appears. Click on the “Symbols” tab.
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'@ Layer properties

General * Symhals |

Legend: |P0r‘t Saplaya.dxf (Unigue wvalues) -

® [Unique symbols Show all the items of a layer using the same symbal

) Unigue walues

) Intervals

() Lakelling

Fill: f—
[T Fill:
Line o
[ 5trake:
[ Sincronize calor of stroke and fill:

D Line widith: 53: 10 20 30| 1

[}

Transparency EI

Arcept | | Apply | | Save legend... | | Load legend... | | Close

Use this tab to define the legend type you wish to use to represent the layer data more
specifically.

You can choose between the following:

Unique symbols: This is gvSIG’s default legend type and represents all the
elements of a layer using the same symbol. It is useful if you need to show the
location of a layer over and above any of its other attributes.

Unique values: Each record can be represented by a unique symbol according to
the value it has in a particular field in the table of attributes. It is the most effective
method to show categorical data, such as towns, types of land, etc.

Intervals: This type of legend represents the layer elements using a range of
colours. The intervals or graduated colours are mainly used to represent numerical
data which increase progressively or have a range of values, such as population,
temperature, etc.

Labelling: Texts or labels can be automatically added to the view according to the
values each element has in a particular field in its table of attributes.

The options shown in the symbols menu vary according to the type of layer (point, line or
polygon layer).

The options available for a polygon layer, which has the most configuration tools, are
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shown below.
A legend can be saved or loaded (recovered) at any time.

5.9.1.4.1 Unique symbols
The following symbol configuration options are available:
- Fill: Allows the fill colour to be selected.
Fill type: Allows the fill pattern to be selected.
Line: Allows the line colour to be selected.
Line style: Allows the style of the line to be selected.
Synchronising line and fill colours.
- Line width: Allows the width of the line to be defined.

Transparency: Gives the elements a degree of transparency so that polygon layers
can be superimposed and yet still viewed.
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% Propiedades de la capa

General* Simbalogia |

Lewenda: |c0ns_punt.shp(5imb0l0 unico) -

@ simkale dnica Muestra todos [os elementos de una capa usando el mismo simbolo

i alores dnicos

O Intervalos

O Etiquetados Tipo de simbolo:  Trigngulo [~]

Colar: _jf—
[ Tamafio en metras
| Aceptar | | Aplicar | | Guardar leyenda. .. | | Fecuperar levenda. .. | | Cerrar |

e Click on the “Symbol type” pull-down menu and select the symbol you wish the
layer to be displayed with. Select the colour and set the size of the symbol you have

chosen.
Click on “Apply” to see a

preview of the set configuration.

Click on “Ok” if you wish to make this configuration permanent.In point-type shape

layers you can use the “Unique symbol” option in the “Symbols” tab to define the
symbol type, the colour and point size you wish this layer to be displayed with.

5.9.1.4.2 Unique values

June 2007

Page 116 of 409



gvSIG - User guide

.:}_-;‘a Layer propertie
General " Symbals |
Legend: |P0r1 Saplaya. dxf (Unigue wvalues) -
) Unigue symbols Given a attribute field,5how the layers features using a each unigue wvalue symiol.
(@ Unigue walues
© Intervals Classification field |Calor v| [] Other values
(O Lakeling
Symbol Yalue | Label |
Cho -l 1
H H
[ VARCHE 5
L -6 &
O - 7 7
[ VARCRET] 10
Clo - 33 33
Ch™ - 150 150
c <
|,&dd all | | Add | | Remowe all | | Ramowe |
Accept | | Apphy | | Save legend... | | Load legend. .. | | Close

The following symbol configuration options are available:

- Classification field: A pull-down menu appears in which you can select the layer’s
table of attributes’ field which contains the data to be sorted.

- Add all/Add: Once you have selected the “Classification field”, click on the “Add all”
button to see all the different values. These values have all been assigned a
different symbol (colour). Click on these symbols to modify them. By default, the
label (the name which appears in the legend) is similar to the value it has in the
field. You can include new values to the list by pressing the “Add” button.

- Remove all/Remove: This allows all (Remove all) or some (Remove) of the
elements in the legend to be removed.

- Labels: Left click on any of the “Label” “cells” to modify the name they will have in
the legend.

5.9.1.4.3 Intervals
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| 8 Layer propertie

General * Symiols |

Legend: |Pcur‘t Saplaya. dxf (Unigue values) -

) Unique symhbals Show the layers features using a range of color according to values of a attribute field

) Unique values

(@ Intervals Classification field [ID -
O Labelling Interval type [Matural intervals ~| [] Other values

Begin color M| .. Endcolor: M| .. Nrofintenals

symbaol | Value | Label |

| Compute intervals | | Add || Remave all | | Remove |

Arcept | | Apphy | | Sawe legend. .. | | Load legend... | | Close

- Classification field: A pull-down menu appears in which you can select the layer’s
table of attributes’ field, which contains the data to be sorted. The field must be
numerical because this is a gradual classification (by ranges of values).

- Number of Intervals: This must indicate the number of ranges or intervals that
define its classification.

- Start colour and End colour: Select the colours to be graduated. The start colour
is for the lowest values and the end colour is for the highest values.

- Computing intervals: When you have defined the previous options, click on the
“Compute intervals” button to see the legend’s end result. The symbols and the
labels which appear by default can be modified by clicking on them, as in the
previous cases.

- Add: New ranges can be added to the computed intervals.

- Remove all / Remove: This allows all (Remove all) or some (Remove) of the
elements in the legend to be removed.

- Type of intervals: From gvSIG version 0.4 onwards, you can specify the interval
type you wish to divide the information into in order to represent it. You can choose
between the following options:

- Equal intervals: The number of intervals are specified and the sample is
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divided into this number of equal intervals.

- Natural intervals: The number of intervals is specified and the sample is
divided into this number of intervals according to the Jenk method of
optimising the natural breaks for the intervals.

- Quantile intervals: The number of intervals is specified and the sample is
divided into this number of intervals but the values are grouped together
according to their order number.

5.9.1.4.4 Labelling

G Layer properties :
General " Symbols |
Legend: |P0r‘t Saplaya. dxf (Unigue walues) -
O Unique symbaols Allows to set label of the map elements with the value of a particular field.
) Unigue walues
O Intervals
(@) Labelling Enakle lakelling
Labelling field Text 4 R
i igth: Height Text
Text fiald heigth: |Heig v/ S—
Ratation field |[RotationText | -|_|
Fixed text height —
(@) In meters
v| Draw text onl
O In pixels ¥
Arcept | | Apply | | Sawve legend... | | Load legend... | | Close

- Enable labelling: Activate the check box to make the labelling visible in the view.

Labelling field: This is a pull-down menu which allows you to choose the layer’s
table of attributes’ field, which contains the values to be shown as labels.

- Text height field: This allows you to choose the layer’'s table of attributes field
which contains the values to be used for the label height.

- Text rotation field: This allows you to choose the table of attributes field which
indicates the label rotation angle.

- Text colour: Allows the text colour to be selected.
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Font: Allows the type of font to be selected.

Constant text height: Select the units (metres or pixels) and the text size. If you
select “pixels”, the apparent text size will remain constant, even if you change the
viewing scale; if you select “metres”, the text height on the display will vary
according to the scale you are working in but will remain constant in geographic
units.

5.9.2 Raster layer

5.9.2.1 Raster properties

Right click on a raster layer and select the "Raster properties" option. This opens a menu
in which we can carry out various operations on the raster layer.

""" . Ce Rename

Zoam to layer

Zoom to raster resolution

Delete layer

Bring to front

Copy
Cut

Raster properties

This menu is divided into five tabs:
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m Raster properties

(]
)

[nfarmation ‘\ Bands \Transparencv‘l.l Enhance ‘I, Pangharp‘l.l

Information =3
File: fx/fdatos/RASTER/jpg/COY _005Y(PCW
distintas lineas). jpa

Sizer 2513269 Indes
Wicth x Height: 8932, 8959

Format: jpg
Ceoreferenced: wes

Band count: 2

Geographic coordinates
Minimum X 420585 .72 -

|MEEDI | | Cancel | | ,&pplﬂ

- Information: Provides general information about the raster layer, the file path, the
number of bands, the pixel dimensions, the file format, the data type and the
geographic coordinates of the corners.

- Bands: Provides tools to change the mode in which each image band is viewed.

- Transparency: Provides tools to change the transparency levels that can be
applied to a raster layer.

- Enhance: Provides a tool to enhance the raster layer.

- Pansharpening: Provides a tool to increase the satellite image resolution if the
panchromatic band for these images is available.

In the “Bands” tab you can make compositions using the different bands in a raster image.
You can also add more bands from other files. This is useful when working with Landsat-
type images, in which each band is delivered in a different file.
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m Raster properties E ﬁ

Inforrmation * Bands \Transparencv\ Enhance \ Pansharp \

Fufdatos fRASTERS jpgfCOy 005 (JPCW distintas lineas). jp

e ][ v

R|c] 8] Band |
(2) () () 1[8U] COW_00SY{PCW distintas lineas). jpg

¥ )2 [BU] COW_00sY(PCW distintas lineas). jpg
(=) 3 [8U] COv_005V{PCW distintas lineas). jpg

|A1:cept | | Cancel | | ,&pplﬂ

In addition to the “Transparency” option in gvSlg version 0.3, which is now called “opacity”,
and which indicates the "occlusion” percentage of this layer over the previous ones, there
is now a transparency option which allows the indicated colour groups (RGB) to be
completely transparent. This is very useful to eliminate visual artefacts as a result of
missing data in orthophotos or satellite images and to remove borders in an image mosaic.

To access the options, click on the corresponding “Activate” check boxes.
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Raster properties

Information \ Bands ' Transparencv\ Enhance \ Pansharp \
rTransparency per pixel

ACtivate

— N
o] 4
——e T

rOpacity

[¥] Activate © )

[Accept ] [ Cancel ] [,&pplv]

The “Enhance” tab can be used to modify the image brightness, contrast and

enhancement. This last option is essential to be able to view 16-bits per band images
correctly.

Raster properties

Information \ Bands \Transparencv‘ Enhance \ Pansharp \

-Brightness and contrast rEnhance
[¥|Brightness and contrast [v|Direct lingar
Erightness FEemove edges
Tail trimming { % )
Contrast
[w]Preview

[Accept ] [ Cancel ] [,&pplv]

The “Pansharpening” tab can be used to increase the resolution of satellite images if the
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panchromatic band for these images is available.

N.B.: If the image bands are in different files, they must be added to the layer using the
“Bands” tab.

Use the “Bands” tab to find the best band combination for the view. In this section, you can
load the image which corresponds to the panchromatic band but you must not select it to
be visualised.

&3 View : Untitled - 0

...... Bl 034uG23153:

Raster properties

Information * Bands ‘\Transparencv\ Enhance \. Fansharp \

Sxfdatos/RASTER fpansharpening2 fOz ALG231533250-M2
Sxfdatos/RASTERfpansharpening2 fOZAIGZ21533250-P24

[»

Band
(2) 1 [8U] 03AUG23153350-M245-000000122423 _01_POOLTIF
2 [BU] 02AUGZ3153350-M2A5-000000122423 _01_POOLTIF
2 [BU] 02AUGCGZ3153350-M2A5-000000122423 _01_POOLTIF
4 [BU] 02AUGZ3153350-M2A5-000000122423 _01_POOLTIF
) 1 [BUO3AUGZE153350-P2A5-000000122423_01_POOL.TIF

|ACEE[:II | | Cancel | | Applv|

When the bands have been loaded, you can carry out the pansharpening. Go to the
“Pansharpening” tab and activate it by clicking on the “Activate Pansharpening” check box.
Select the panchromatic band with which the pansharpening is to be carried out from the
band list. Finally, select an algorithm to be applied. There are two methods available,
“Brovey” and “HSL". Both of them have a slide bar control to carry out adjustments.

In “Brovey” the general brightness of the resulting image is increased or decreased.

In “HSL’ the coefficient which is added to the brightness taken from the
pansharpening band varies before it is replaced in the output image. This coefficient
can vary between 0.15 and 0.5. When modified, the obtained result also influences
the output image’s general brightness.
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If you click on the "Apply" or “Ok" buttons, the pansharpening will be applied on the image
in the view, thus increasing the image resolution.

(% View : Untitled - 0

v Bl 03A0G23153:

Raster properties

Information "'. Bands ‘\Transparencv‘\ Enhance ' F‘ansharp",l

Pancromatic Band Selector

[w] Activate pansharpen. ..

Orovy @ o]
oML @ .
Band |

'Zf:Z' 2 [8U] 0ZAICZ23153350-M2A5-000000122423 01 POOLTIF [
(%) 2 [8U] 02AUG22152350-M2A5-000000122423_01_POOLTIF |«

) 1[BU] 0zAUCZII53350-M2A5-000000122423_01_PODLTIF ﬁ

| Accept | | Cancel | | Apply |

5.10 Navigating around / Exploring the view

There are several tools you can use to navigate around the map. These are basically
zooms and panning.

tAASHRK "D
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5.10.1 Zooms and panning

You can activate these tools by clicking on the "View” menu and then on “Navigation".

W

Wiewe Help

Export

Import
Centrar_la_Vista_sobre_un_punto
G Locate by attribute

Mew laver
J'g Add layer

Mavigation
Query
Set layers as

Configure locator map
Selection
Froperties

£ Ceoprocessing Wizard

Alt-0

» o@oE o (B[

Frevious zoom

o
v | S Zoom In
Jiey
£Z Full extent

e
r AR

KA
oy

™ Panning

Zoam out

Zoom in

Zoom out

or by using the button bar which is quicker.

Zoom in: Enlarges a particular area of the view.

o

Zoom out: Reduces a particular area of the view.

oy

Zoom Manager

&

Previous zoom: Goes back to the previous zoom used.

o)
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Full extent: Full zoom of the total area included in all the layers of the view.

=

Panning: This allows you to change the view zoom by dragging the viewing field all over
the view with the mouse. Click and hold down the left button of the mouse then move the

mouse in the direction you require.

Zoom to selection: Full zoom of the total area of all the selected elements.

=

¥

Zoom to layer: To zoom to the layer, right click on the selected layer in the ToC, or click on
the “Zoom to layer” option in the contextual menu.

- |

= ."! rie

5.10.2 Zoom manager

Change calaor

Rename

Properties

Zoam to layer

Delete layer

Bring to front

Copy
Cut

You can access the “Zoom manager” from the tool bar by clicking on the following button:
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2

or from the “View” menu, then “Navigation” and “Zoom manager”.

By clicking on the “Zoom manager” you can save a zoom so that you can go back to it at a
later stage.

This tool can be used to name the current zoom of the view with the text bar which
appears in the window.

Click on “Save” and the zoom currently in the view will automatically be added to the
“Zoom manager” text box.

You can create and save as many zooms as you wish. Use the "Select” and “Delete”
buttons to manage your working areas.

% Zoom Manage
Save current zoom

Mame far the zoam; MNarth |

Recover and delete other zoom

Walencia
Albufera

Select Delate

5.11 Configuring the locator map

The locator is a general map which is displayed in the bottom left hand corner of the view's
window. It is used to show the working area (main window zoom).

Click on “View” in the menu bar and select “Configure locator map”.
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“Wiews | Help
Export b
[mport b

Center view to paint
I Locate by attribute

e laner b
= Add layer Alt-0
Mawigation b
CILIE b
Set layers as b

Configure lacatar map

Selection b
Froperties

£% Ceoprocessing Wizard

A window appears in which we can add layers (we can add the same types of layers as in
the view) which will make up part of the locator map. This window can also be used to
remove layers or edit the layers’ legends.

Configure locator ...

Lacatar lawers:

Add laver. . || Femowve layver. .. || Edit styde. . || Close

When you click on the “Add layer” button, the following window appears
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] Ahadir capa =
Archiva | Georreferenciar | JDBC | WS | WMS | WCS | ArciMs |
Capas
muni1Q000. shp |W|
Proveccion actual; EPSC;22030 |_|
| Areptar || Cancelar |

This new function allows the layer loaded in the locator map to be reprojected. To do this,

click on the button next to “Current projection when you have selected the layer you wish to
load in the locator map.

In the following window, select the reference system you wish the layer to have in the
locator map and click on “Finish” for the changes to take effect.
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) Selectiona sistema de referendia =

Seleccione CRS de la capa

Tipo: Fecientes -

Otimos CRSs utilizados:

Coordinate Reference Systems

Fuenta Chadign Mombire

Seleccione Transformacion:

LCancelar

5.12 Request tools

5.12.1 Information tool

You can access the information tool via the following button in the tool bar

i ]

or by going to the “View” menu bar, to “Query” and then to “Information”.
The “Information Tool” is used to obtain information about the map elements.

When you click on an element using this tool, gvSIG shows the selected element’s
attributes in a dialogue window. However, the layer of the element you wish to identify must
previously be activated.
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gvSIG:Untitled

File Show Layer Window “iew Table Help

DoEztcagxiann@es ("Nl vOQ ¢
5 View : Untitled - 0
=[] M provin.shp
wo [ Default
" Identify results |
provin.shp =& provin.shp Aqtripute [ Walue I
w0 87 ND_14 46.0
ND_10
NOM _PROVIN alencia
ND_4 87.0
ND_11
ND_5 24.0
LINK,
[
i Application started 1[4554.338 > |Mmetros P =F05,193.52 ¥ = 4,541,795.52 [EPSC2I030

5.12.2 Measuring areas

You can access this tool via the following button

S

or by going to the “View” menu and then to “Query” and “Measure area”.

This tool works in much the same way as “Measure distances”. Click on the point that
represents the first polygon vertex that defines the area to be measured. Move the mouse
and click on each new vertex until you reach the last one, then double click so that the
application knows there are no more.

The calculation for the measured area appears at the bottom right of the view window.

L EEEEEEEEEREEEEEESSSSSs.
June 2007 Page 132 of 409



Sl §1§
gvSIG — User guide ) 4

Metras M o= B61,293.88 ¥ = 4,519,293.36 |P:302,982.37 |45, 698,409,532.97 |

5.12.3 Measuring distances

L)
=3

This tool provides information about the distance between two points.

You can also access the tool by going to the “View” menu, to “Query” and then to
“Measure distances”.

Firstly, make sure you have correctly defined the units of measurement (metres by default).
Remember that the units can be defined in the “Project manager” in the view properties or
from the “View” menu and the “Properties” when working in a view.

You can use the measure distance tool by clicking on the mouse at the source point and
dragging it to the destination point. You can take as many measurements as you like.
Double click on the last one to finish.

The calculation for the measured distance appears at the bottom of the view window. Both
the distance of the last measured segment and the total distance are shown.

|MEtr|:|5 i}( = F11.468,75 IY =4 377 668,72 Dist:14951

5.13 Selecting elements

You can select one or several elements or items by making either a graphic request or an
alphanumeric request.

The selected data are shown in the view in the colour you have configured (by default this
is yellow).
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% view : Untitled - 0

=% M provin.shp

B Defaulr

[

4

You can access the different ways of selecting elements by going to the tool bar or by
going to the “View” menu and then to “Selection” as long as the layer you wish to work with
has already been activated in the ToC.

- Table Help

Export r Nab| v O
lmpoart ]

Centrar_la_¥ista_sobre_un_punto
I Locate by attribute
ety layer ]

£ Add layer AR-0
Blavigation b
Query b
Ser lavers as ¥

Canfigure locator map

K Select by point

m Select by rectangle

(% =elect by polygon
Selection by Layver

Properties

ﬁ Ceoprocessing Wizard

l€§5 Imvert selection

I ————————————————————————————————————————————————————————————
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5.13.1 Selecting by point
k

This is the basic selection method and consists of clicking on the element you wish to
select.

5.13.2 Selecting by rectangle
(¥

This allows you to select the elements which are partly or wholly located inside a
rectangle.

To define the rectangle, place the cursor point over the position you wish to start to draw
the rectangle in, left click on the mouse and hold the button down until you have defined
the area you wish to select.

5.13.3 Selecting by polygon
[

This allows you to select elements which are partly or wholly located inside a polygon. To
define this polygon, place the cursor in the part of the view you wish to draw the selection
polygon in. Left click on the mouse in the view to add the polygon vertices. When you have
finished, double click on the mouse. All the elements which are located inside the polygon
or which intersect with any of its sides will be selected.

5.13.4 Selecting by layer

You can access this tool by going to the “View” menu then to “Selection” and “Selection by
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layer”. It allows you to select elements in the active layer based on the selection made in
another layer.

m Selection by Layer ﬁ
Select iterms from active layers that are;. .. | Mew set
|same as v‘ | Add 1o set
Selected items of a laver | Select from set
|r:|rwin.shp v‘ | Cancel

The options available using this tool are:
2. New set: This creates a new selection set.

3. Add to set: This creates a selection set based on the previous request and the
current request.

4. Select from set: This creates a selection set from what has already been selected,
the current selection request is extracted from the previous one.

An example of how to use this tool consists of selecting the cities and towns of the
Valencian Region whose municipal boundaries are affected by flood risks.

We start with a shape file with the areas of the provinces in the Valencian Region which
are subject to flood risks.

Then the layer corresponding to all the cities and towns in the Valencian Region is added.
Pre-select the full flood risk layer.

We go to the “Selection by layer” tool. Use the “Intersect with” option in the first pull-down
menu, “Select items from active layers that are:...”. Use the
“riesgo_inundacién_25000_completo” option in the second pull-down menu “Selected
items of a layer”.
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(0 View : Untitled - 0
=¥ M riesgo_inundaci

[ pefaun
/A muniloooo.st

I Default

o“of [

Selection by Layer

e

Select items from active |ayers that are:...
Isame as VI [ Add to set
Selected iterns of a layver [ Select from set
ImunilOOOO shp v] [ Cancel
i Application started 1:[1.942.067 v |Metros p=480,9782  |r = 4,384,412 23 [EPSC:23030

We can now click on “New set” and the layer with the new selection will appear.
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5.13.5 Selecting by attributes

You can access this tool using the following button:

gvSIG allows selections to be made using requests (filters).

Selecting elements by attributes allows you to define exactly what you want to select,
including several attributes, operators and calculations.

Requests can be made using logical operators, such as “equals” “more than” “different
from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to define your
request.

G Filter Untitled - 0 :

Fields: L=l | u=ddl | Yalues:

E_MUMICIP [ < ][ <= ][ »=| Alacant

CoDlIGo Castelld de la Plana
COMARCA LAnd || or || Not | lvalencia
PROWINCIAS |T| |E|

PROVINCIAS = "Valencia' |NEW 5E1| |,mjd 10 5E1|

|SEIEn:t frarm set|
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3. Fields: Double click on the field you wish to add to your request from the “Fields” list
in the layer.

4. Logical operators: These allow you to insert a logical expression into your request
by clicking on them.

5. Values: This shows a list with the different values the selected field has. If you wish
to add a value to the request, double click on it.

6. Request: This is the window which represents the request to be made. You can
write here directly.

7. Selection buttons: These buttons make the request using:
- “New set” (deletes any previous selections).

- “Add to set” (adds the elements selected by the request to the existing
elements).

- “Select from set” (makes the request from the selected elements).

5.13.6 Inverting the selection
When you have made your selection, you can click on the following button in the tool bar

&9

or you can go to the “View” menu then to “Select” and “Invert selection”

c C e g =

MHawigation

Cuery
Set |ayers as

- v v

Configure locator map

Selection h Select by paint
Properties m Select b rectangle
£% Ceoprocessing Wizard [ select by pokagon

Selection by Lawer
&% Inwert selection
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and invert the previous selection as shown below.

5.13.7 Clearing selection

If you click on this button, the selected element set will once again become empty.

You can also access this option by going to the “Layer” menu then to “Clear selection”.

Laver Window Yiew Tahble Help

Start editian
Export to ... b

Al Clear selection

BB See table of attributes

5.14 Locate by attribute

This tool allows you to zoom in on areas of a layer by specifying the value of a particular
attribute.

You can access this tool by clicking on the button
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oy

or by going to the “View” menu then to “Locate by attribute”.

“Wiews | Table Help

Expart k
[tmpart b

Centrar_la_Wista_sobre_un_punto

.. Locate by attribute

Mew |a ]
J'g Add laver Alt-0
Mlawigation b
Query b
Set layers as b

Caonfigure locator map
Selection b

Properties

£5 Ceoprocessing Wizard

When the tool is selected, the following window appears

'l Locate by attribute

Lawer: |prmr1n.5hp

Field: |NOM_F‘ROVIN

Yalue: |,f-‘-.sturias

Qpan with the wiew

| Zoom | | Exit |

You will find all the layers loaded in the ToC in the “Layer” pull down menu. The fields
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associated with the chosen layer are included in the “Field” pull down menu.
The data included in the selected field appears in the "Value" pull down menu.

If you mark the “Open with the view” check box and decide to close the view, the “Locate
by attribute” window will appear the next time you open the view.

When you have made the selection, click on the "Zoom" button and the chosen area will
be shown in the view.

4 Locate by attribute

Lawer: ’prum’n.zhp

Field: ’NOM _PEONIM

ER|SRIEEN

Walle: ’MturiES

Open with the wiew

’ 00t ] ’ Exit J
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‘ Locate by attribute

Laver: ’prom‘n.shp

Field: ’NOM_F‘RO‘\-’IN

Yalue: ’Asturias

[w] Open with the wiew

[ Zoam AH Exit J

5.15 Centring the view on a point

This tool allows you to locate a point in the view by its coordinates and to centre the view
on this point.

You can also access the tool by going to the “View” menu then to “Centre view on a point”.
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- Table Help

Expart 3

Import b

Center wiew ta paint

{7 Locate by attribute
[ Center view to point|
Ld

Mew layer

J'g Add layer Alt-0
Mavigation 3
CILERy »
Set layers as ]

Configure locator magp
Selection J
Froperties

£ Ceoprocessing Wizard

When you have accessed the tool, a dialogue box will appear in which you can input the
required coordinates and select the point colour.

& Identificar resultados

country.shp = eq| Aributo | walor ||
o] INAME Switzerland

4[] r

When you click on the "Ok" button, the view centres on this point and the information
window that corresponds to this point appears.

5.16 Catalogue. Searching for geodata

The catalogue service allows you to search for geographic information on the Internet.

I ————————————————————————————————————————————————————————————
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gvSIG offers a user-friendly interface which allows you to find geodata and load it in the
view, as long as the nature of the data allows this.

5.16.1 Connecting to a server

Before you can carry out a search, you will need to connect to a catalogue server. To
access the wizard, you will first need to open a view and then click on the following button:

s

The first window of the catalogue opens. Input the required parameters to connect to a
server. These include:

- The server address.

- The server protocol, which in the case of the catalogue can be:
- Z39.50: General information retrieval protocol.
- SRU/SRW: Variant of Z39.50.

- CSW: Catalogue protocol defined by the OGC in the “Catalogue Interface 2.0”
specification.

- Data base name: You only need to indicate the data base you wish to connect to in the
case of z39.50. If no value is input you will connect to the default data base.

m Geodata Search - Connection ﬁ
Fill the catalog server address
193.43.36.137:2100) | | Protecols
Datab (2] Z39.50

atabase name ) SRUJSR

| () Cs-w
Servier Answer
Warsion: Cannect Close

Then click on the “Connect” button. If the connection is made and the server supports the
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specified protocol, a new window will appear to start the search.

5.16.2 Searching

To carry out a search, you need to fill in the fields that appear in the following form.

Geodata search [193.43.36.137:2100]

Title
|| | [ ] Restrict search area |E1

| Search || Cancel | | Last || Close |

Click on the ™ button and the window will drop down to show more fields which will allow
you to carry out an advanced search. The fields you can search in are set by the server.
This means that some of the search fields in this form may have no effect in some servers.
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Geodata search [193.43.36.137: 21001

Title
| [ ] Restrict search area El
Agreement Coordinates
(%) Exact sentence Upper
@ Ay UL [42.16803 | ULY: [31.92489]
() Bwery ward
Alstract Lower
| || BRX 58.16803 | BRY: |2.07510]
MBS \cantain -
| |
Cathegary Last update
From | |
Srale To | |
any ~|
Provider
| |
| Search || Cancel | | Last | | Close |

If you change the view zoom, the new coordinates will be reflected in this form. If you wish
to restrict the search area enable the corresponding check box.

Then click on “Search” and wait for the search to be carried out.

5.16.3 Viewing the results

If the search has been successful, a new window containing the search results will open.
Use the “Previous” and “Next” buttons to see each of the results obtained.

© 2007 Conselleria de Infraestructuras y Transporte Page 147 of 409



gvSIG - User guide

Search results

Fesults: 1 of & et

Ease Cartografica Mumérica 1:200.000 ol

Ahstract: Ease Cartografica MNumérica que Contien
informacion que figura en el Mapa Topografico MNa
1:200.000 del IGN. Esta informacién esta estructu
los siguientes temas geograficos: Tema 01 division
administrativaTema 02: relieveTema 03: hidrograf
costasTerna 05 edificaciones v construccionesTern
vias de comunicaciénTerna 07 conducciones v B
transmisionesTema 10: vértices geodésicosEn gene
normbres de 105 objetos estan introducidos como te

Purpose: Todo tipo de usuarios (ermpresas, Adrmini
para todo tipo de aplicaciones ¥ sobre todo tipo de
plataformas (sistermnas vectoriales, raster, orientado
objetos, etc JPrincipales aplicaciones: redes de
infraestructura (agua, electricidad, gas, teléfono); s

| Description | | Close |

The left-hand side of the window shows information about the metadata obtained. If you
wish to see all the information, click on the "Description" button. You will also be able to
see a miniature image at all times, metadata permitting.

If the metadata has any geodata associated to it, the “Add layer” button will be enabled.
gvSIG can currently recognise different types of associated resources, such as WMS,
WCS, Postgis tables and web pages. If you click on this button, a new window will be
opened and will show all the resources the application has been able to find.
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G HECHTSOS I SpOTIDIES) X
Tipo | Enlace | Ver |

WA LI R http: f franger.icc.esfsidficcpiu... | Pagina ek |
WA LI R http: ffgalilen.icc. esfwebsite i | Pagina ek |
| Cerrar |

If you click on a WMS, WCS or Postgis type resource, the new layer will automatically be
loaded in gvSIG. If the resource is a web page, for example, the operating system’s default
browser.

5.17 Gazetteer

A gazetteer is a data set in which a link is established between a toponym and its
geographic coordinates.

gvSIG has a catalogue client which allows you to search by toponyms and centre the view
on a specific point.

5.171 Connecting to a server

Create a view first and open it. The following button will appear automatically in the gvSIG
tool bar.

B

Click on the button. A wizard opens to help you to carry out a search. The parameters to
be input are:

The server address.
The server protocol, which in the case of the gazetteer can be:
e WFS-G: Toponym search protocol defined by the OGC.

e WFS: Although this protocol was created with a different purpose in mind, it
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can be used for a toponym search, as long as it has a text attribute in one of
the tables. This protocol also allows you to carry out a “Feature” search in
any other field, but not necessarily a text attribute.

e ADL: Protocol specified by the Alexandria Digital Library.

e IDEC/SOAP: Protocol that uses the Catalonian Cartographic Institute (ICC)
gazetteer web service.

m Finding by Gazetteer ﬁ
Protocols
() WFS-G
Cill the gazetteer server address ) WES
http:;;middleware.alexandria.un:sb.Edu:BOBOIQaZIadIgaZIdispatthl v| -:'i-,&DL
() IDEC/S0AR

hiE el ARSwer

ADL CGazetteer Collection-lewvel Metadata: http: ffcollections. alexandria.ucsh. edufadl_gazetteerfmeta
data. html.

| Connect | | Close

When you have input all the parameters, click on the "Connect" button and wait until the
server is found and accepts the specified protocol. If it is accepted, a new window will
appear to start the search. If not, an error message will appear.

5.17.2 Searching

To carry out a search, you will need to fill in the criteria that appear in the following form.
You can see the simplified form or carry out an advanced search by clicking on the I:

button in the top right hand corner. This drops down the window.
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m Finding by Gazetteer [http://middleware.alexandria.ucsbh.edu: 8080/gaz/adlgaz/dispatchl

Mame
| =
Agreement Coordinates
(=) Exart sentence Upper
() Ay wrord UL LLY:
() BEvery word
Lower
BRX: BRY:
Tuwpe
Root |+
EH-administrative areas B
---hydrngraphic features
~land parcels Aspect setup
EH-manmade features Goto the place
---phvsingraphiu: features = Remove old searches
Hhernninnc Draw result
Results per page
Intelligent search
|10 -
[v] Al word farms
| Search | | Cancel | | Last | | Close |

If you change the view zoom, the new coordinates will be reflected in this form. If you wish
to restrict the search area activate the corresponding check box.

There are also three options in the “Aspect set up” box which you can use to set up the
search view:

- Zoom to search: This puts the toponym found in the centre of the gvSIG view.

- Delete old searches: This deletes all the texts found in the previous searches from
the view.

- Draw result: This draws a point and a text label in the place the resulting toponym
has been found.

When you have filled in all the fields in the form, click on “Search” and wait for the search
to be carried out.
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5.17.3 Viewing the results

A new window containing the search results will open. Use the “Previous” and “Next”
buttons to move through the different pages of results.

& Finding by Gazetteer 2]

Fesults: 25 Page 1 of 10 | eyt |

Cibraltar-5pain neutral zone - Spain
Cibraltar Mountain - Ferry County - WWashington - United Statg:=
Cibraltar Mountain - Lane County - Oregon - United 3tates 3
Cibraltar - Meta, Departamento del - Colombia

Cibraltar FEange - Mew South Wales, 3tate of - Australia
East Gibraltar Peak - Eoutt County - Colorado - United States B
Cibraltar - South Africa

Gitlzuraltar Lake - Boulder County — Colorado - United States |
) 53

| Localize || Close |

Finally, select the toponym required and click on “Localise”. The gvSIG view will centre on
the point the toponym is located in.

5.18 Deleting layers

To permanently remove the active layers from the view, right click on the layer in the ToC
and select the “Delete layer” option.
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=-[v] M country.shp
b M C: Change color
Rename

Properties

Zoom to layer

Delete layer

Bring to front

Copy
Cut

A confirmation dialogue appears.

W Seleaamopion 0 (ma
?

Do wiou really want to delete the active layers?

| es || Mo || Cancel |

5.19 Exporting layers

5.19.1 Introduction

The “Export to...” tool allows you to save the elements selected in a layer in a different
format. If no elements have been selected the whole layer will be exported.

At the time of going to press the export formats supported by gvSIG were shape, dxf, and
postgis and gml.

5.19.2 Exporting a shape

Select the “Layer” option from the menu bar then go to “Export to.../shp”.
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- Window  View Table  Help
Start edition

dxf
Fostols
ML

B Ciear selection
BE see tahle of attributes

Transform to annotation layer

If you have selected elements in the layer to be exported, gvSIG will tell you how many
elements are going to be exported and will ask for confirmation before carrying out the
operation.

(4 View : Untitled - 0 °
=] A provin.shp
- [ Default
? will be saved, &features, do you want 1o continue?
1o
-
¥ - =
(-]
- (8] -l

i Application started 110434843 > |Metros [ = -BO7,204.78 ¥ = 5,102,174.18 [EPSC:23030

If you continue with the operation, a dialogue box will appear in which you will be asked to
select the file the new shape is to be saved in.

When you have accepted, a new message will appear asking whether you wish to insert

L EEEEEEEEEREEEEEESSSSSs.
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the new layer into the view.

Insert layer

If you click on “Yes”, the layer will be added to the active view.

5.19.3 Exporting to dxf

Select the “Layer” option from the menu bar then go to “Export to.../dxf”.

Lawer  Wincdow  View Table  Help

2 S X »
SHP

Start edition

Clear selection
BE see tahle of attributes PostGls

GL

Follow the same process used for exporting to shape.

5.19.4 Exporting to postgis and Oracle Spatial

Select the “Layer” option from the menu bar then go to “Export to.../postgis”.

Laver | Window  Wiew Tahble Help

Start editian

Clear selection
B2 See tahle of attributes
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If you have selected any elements, a window will appear telling you how many elements
are going to be exported (as in exporting to shp and dxf).

If you click on the “Yes” option to continue the gvSIG exports, gvSIG will ask you to input
the name of the table you wish to save the exports in. Remember that if the table already
exists in the data base, the information it contains will be deleted.

Input E E

Twie in the name of the table to create. WARRIMG: If tatle exists, it will be deleted.

| O ” Cancel |

?

Write the name of the table and click on “Ok”.

A new window appears in which you will have to input the parameters of the data base
connection.

Database Connection (S [T=P =T
Connection name: cnnnectinnl E|
Computer: 1192.168.0.218 |
Fort:
User: ||:|:|5taS |
Password: | |
dk: ||:|:|5taS |
Diriver: \PostGlS |DBC Driver -
| ks, | | Cancel |
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The parameters are:
Name of the connection.
Computer: IP address of the computer the data base is hosted in.
Port: Port on which the computer is listening to the postgreSQL service.
User: User name recognised by the administrator to make the connection.
Password: User password required to validate the connection.
db: The data base the new table is to be created in.

Driver: Driver required for the data base. (At the time of going to press, drivers for
postGIS and mySQL were available).

When you have input the connection parameters, click on “Ok”.

5.19.5 Exporting to gml

Select the “Layer” option from the menu bar then go to “Export to.../gml".

Laver  ‘Window “iew Tahkle Help

Start edition S K
SHF
Clear selection dxf
BE See table of attributes Fostols

Follow the same process used for exporting to shp or dxf.

5.19.6 Exporting to Oracle Spatial
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Capa  wWentana ista Tabla Asuda  Red

Comenzar edicidn | | k(W Ok oo | N
Exportar a ... SHF
e
B2 ver Tahla de atributos Fostols
oML

Anotacion Alt-D

The procedure for exporting to Oracle Spatial is similar to the procedure described above
with one difference: for the connection to an Oracle Spatial data base option to be
available in the previous connection parameter window, the drivers to enable this process
must first be downloaded by following the instructions on the project’'s web site. These
instructions are summarised below:

The Oracle drivers must be installed to access Oracle Spatial data bases. Follow the steps
below:

e Go to Oracle Database 10g Release 2  (10.2.0.3)  drivers.
(http://www.oracle.com/technology/software/htdocs/distlic.html?url=http://www.oracl
e.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_10201.html)

e Accept the licence terms.

e Download the file ojdbc14.jar (1,545,954 bytes) - classes for use with JDK 1.4
and 1.5 on the following page.

NB. You must register to use the downloaded file
e Move the file to the following folder:
In Windows:
e Move the file to the bin\gvSIG\extensiones\com.iver.cit.gvsig\lib
folder. This is in the directory gvSIG is installed in.

In Linux:

e Move the file to the bin/gvSIG/extensiones/com.iver.cit.gvsig/lib
folder. This is in the directory gvSIG is installed in.
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5.19.7 Exporting to a raster layer

This tool allows you to extract portions of a raster layer using a selection in the view or by
inputting the coordinates that define the portion to be extracted. It allows the user to
change the spatial resolution of the clipping or of the whole image, choose the bands to be
extracted or generate a new raster layer for each of the original bands.

To access this option, go to the ToC and select the raster layer you wish to select a portion
of.

Then go to the Layer/Export to menu and select the “Raster” option.

Capa  wentana Yista  Asuda

Exportar a ...

& [

Faster

The following window appears:

n} Exportar a raster
Coordenadas Fixel
|_ ¥ [0.0 [v: [0.0 |
| % [45899.0 |r: [37169.0 |
Coordenadas Reales
r X: [720135.51510 |v. [4376935.97194 |
N ¥: [722899.68272 |v. [4265789.80009 |
=g
Aplicar || Cerrar |

5.19.7.1 Image clipping
There are two ways of selecting an area to be clipped from the original raster layer:
You can use the text boxes in the window to input the data which correspond to:
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/s

Real coordinates: If the source image is georeferenced.

Pixel coordinates: If the source image is not georeferenced.

- You can also make your selection directly from the view by clipping the whole image or

selecting a part of it.

- |E| This button allows you to obtain a clipping from the whole image.

- |E| This button allows you to obtain a clipping from a selected area in the view. Place

the cursor over the image, then click and drag. Check that the text boxes are

automatically completed.

If you wish to save the raster layer clipping you have created, click on “Save” and select

the location you wish to save this file in. The image will be saved in TIF format.

o gwslGoSin titulo 27

i Vista: Sin witalo - 0

Archive Yer Vemana Vista Capa  Avuda

PRy 1 PRl X PG ITEICI )

[l D3AUG23153:

4 Recone

Sup. g, x:[336.44 ¥. (67140
. Der ¥: [498 85 v [B3z 13
i .
Sup. 1z0, X: (645658 5892 . (4826052 63925
I, Deer ¥: [646048 45722 w: [4925706.86929
[N 2
Aglicar Cemar |
i &plicacian iniciada 10 1534k

L B

a 1 I
AL T Ih
~ )

l.l ‘_l‘j'.

LS

*| Meiros

b - 6as 588,18 h - 492767950 EPSC23030

5.19.7.2 Changing spatial resolution

The controls that allow you to specify the clipping’s (or whole image) spatial resolution are
located in the Clip table, with the additional options panel pulled down (to pull this panel
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down click on the |:| button). You can define the resolution by specifying the Cell size or
the Width and Height of the raster layer to be generated in pixels as well as choosing the
interpolation method using the resolution change. At the moment, only the “Nearest
neighbour” option is operational.

"4 Recorte

Coordenadas Pixel

Coordenadas Reales

=l
Resolucion espacial
(5) Tamafio de celda Yecing méas praximo ~|
Ancha: Alto:
Seleccidn de Bandas
Bandas | Normbre

Bl - 02AUC23153350-M2A5-00000012242.
B2 - 03AUCZE153250-M2A5-00000012242.. |
B3 - 02AUCZE153350-M2A5-00000012242..

[]Crear una capa por banda

Aplicar || Cerrar

5.20 Band selection

The original raster layer’s band list appears at the bottom of the Clip table. You can use
this list to choose the bands the output raster layer will have if you enable or disable the
check boxes in the Bands column. If you check the Create one layer per band option, a
new layer will be generated for each of the bands checked in the list. The new layers will
be added to the ToC.
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5.21 Saving and Adding a raster layer clipping to the current
view

When you have established all the parameters which define the raster layer clipping you
have made, click on “Save”. This opens a dialogue box which allows you to search for a

directory to save the clipping in. If you wish to add the layer to the view, go to the “Add
layer” button in the tool bar once you have saved the clipping.

5.22 Example of a raster layer clipping

gvSiG:borramel.gvp

Archwn  Yer Yentana Vista  Awuda

DG E #*
4 Gestor de proyecos =) % Vistx Valencia
Tipos e doumentos | Il cuLaer 2
B P T | [l cunLaver.1
— i e )\{"’{‘ﬁ M cwLaver
. 1 Ml vatenciaz002.
Vistas Tabias Mapas
Vistas
Waleneia
| Nunvo
G Recore
reanagas Pueel
Sup. lzg A (836555 . [29505.05
Inf. Der. %:[10811.05 ¥.[32414.00
Propiedades de I sesiin
Bt 3 Pl
Nombre ge la sesidne barramel g — = =
Guardada en; Jhame nathojboramel e Sup. 26 %: (72264417177 | s
Facha de creacion.  11-aga-2006 Inf. Der. X [723377.52868 | . (436721569994
3 I
DN
Resolecidn epacial
" Tamafio ge celda |¥ecine més proximo Ll
(& Ancho v Al Celda [
Anchor (1500 1 Mip: (1734
Saleciion de Bandus
| Bangas | Hormbre
Bl - valencia2 002 eow
E2 - valencia2 002 eow
2 B3 - walencia2002.ecw
[¥Crear yna capa por banda
swar | pcepar || cancelr
T Stst Aplkacion_iniciada perras b=72194437 [re 436873034 EsG23030

This example shows how a clipping is taken from an orthophoto.

First, select the area by defining a rectangle in the gvSIG view. When you have finished,
the coordinates will automatically be input into the text boxes based on the selection. You
can fine tune these selected values from the view by inputting the new value directly into
the text boxes containing the data.
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Then pull down the box. As the resulting image is to be resampled, not as much resolution
is required. Therefore, go to the “Spatial resolution” section and select “Width x Height”.
This enables the text boxes so that you can input the output raster layer resolution.

When one value is input the other one is automatically completed when you press Enter or
when you exit the field, as the proportions between the width and height must be
maintained. The cell size for the chosen output resolution is also calculated. If “Cell size”
had been chosen, you would have had to specify the size in metres for each pixel and thus
the width and height for the chosen cell size would have been calculated.

You now need to select the bands you want the output layer to have. In this case, select
them all as this is a three-band orthophoto and we want to include them all.

Finally, for our example, the “Create a layer per band” option needs to be enabled to do
just this.

Each new layer will have the same data type as the original image. If you click on “Save” a
dialogue box opens to indicate the directory and image name.

To retrieve the layers you have created, go to the Add layer” button and then to the
directory they were saved in.

5.23 Exporting to image and WMC

5.23.1 Exporting to image
This option allows you to convert the active view into an image or raster file.

Select the “View” menu then go to “Export/Image”.

© 2007 Conselleria de Infraestructuras y Transporte Page 163 of 409



S|

<

gvSIG - User guide

& e
) NN

Import ]

Centrar_la_Wista_sobre_un_punto
I Locate by attribute

Mesw |ayer r

= Add laver A-0 b
Mavigation ] -
Qe » .
Set layers as k

Configure locatar map
Selection *

Properties

£% Ceoprocessing Wizard

When you have selected the tool, a new window appears which you can use to edit the
name of the image to be saved and the type of file (jpg, png...) you wish to save it in.

& i =E

Save |n; [EI falario ,,J @ @

3 datos [E) principalfin. pdf
£3 Desktop

3 docu

C3 Examples

1 gualG

3 gvsIG_1.0rcl

3 workspaces

[E] menu-en.png

[E] menu_24-en.png

File Mame:

Files of Type: |All Files -
PMGC files
|PEG files
EMP files
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When you have saved the image, you can recover it from gvSIG by going to the “Add layer”
tool and searching for a “gvSIG Image Driver” file type.

& oG Dnitiled — i

File Show Layer Window Wiew Help

D544 moods N RomxX60q

% View : Untitled - 0
B A provin [
i [] Dd
L] [l cov_
Information \ Eands \Transparency\ Enhance \ Pansharp \
rBrightness and contrast rEnhance
[w]Erightness and cantrast [“IDirect linear
Brightness
Contrast D
"
e PPrevew
‘ Arcept | | Cancel | | Applv‘
7 ]
v
- e} ﬂ
1 Application stared 1 10434843 [~ ‘Metros F( = -1,849,763.7 |Y= 4,726,096.79 |EPSG:23030

Use the ToC to check that the exported image is a raster layer by accessing its properties
(right click on the layer in the ToC and then go to “Raster properties”).

5.23.2 Web Map Context

5.23.2.1 Introduction

Web Map Context (WMC) is another OGC standard (http://www.opengeospatial.org) which
can be added to the list of standards of this type supported by gvSIG.

It can reproduce a view made up of Web Map Services (WMS) layers on any GIS platform
which supports WMC. If your project has a view which contains WMS layers, you can
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export these layers. The result is an XML file with a specific format and .cml extension
which can be imported by another platform on which the view it describes can be
reproduced.

5.23.2.2 Exporting a view to WMC

Exports to WMC are currently limited to WMS type layers, although it is hoped that its
functions will extend to all layers that comply with OGC standards in the future.

To obtain a WMC file, open a view in gvSIG and add the WMS layers you require.

Wiewy Help

Import ' Mag e nor 1o Map Context |

Centrar_la_Vista_sobre_un_punto

Mew [ayer » i
J'gm:id laner Alt-0 A
MHavigation k -y v

Lt P
QIUEry ’
Set lavers as b

Configure locatar map

Properties

Then go to the “View” menu and select “Export” and then “Web Map Context”. The
following dialogue will be shown.
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&5 Web Map Context properties
Options

Wiews |Untitled - 0 ~|

Title: |Catastro Spain |

IC: |idCatastrn |
File: |jhnme;falarin;catastrn.cml || Browse |
wersion: |1, 1.0 -|
Extent: (=) Defined by the viewOs extent e
() Use full extent |M|
| Ol || Cancel |

N.B.: If you cannot find the "Web Map Context" option in the "Export" option, your project
does not contain any WMS layers.

Basic mode only shows the compulsory properties which cannot be taken for granted by
the application.

- View: This defines which view is going to be exported to the WMC. The view which is
currently active is selected by default.

- Title: This is the title of the view which will be shown when your .cml file is loaded at a
later date. The current title of the view is used by default but this can be changed.

- ID: This field is also compulsory and represents a file ID which must be unique.

- File: You can search for the place you wish to save the .cml file in from the "Browse"
button.

- Version: Use this tool to specify the WMC version you wish to use. The version 1.1.0 is
selected by default as it is the most highly developed and the most recommended.
However, several applications and geoportals are often limited to a specific version.

gvSIG currently supports Web Map Context in its versions 0.1.4, 1.0.0 and 1.1.0.
- Extent: This defines the extension of the map to be exported.

- Defined by the view’s extent. This option only exports what we can currently
see in the view.

- Use full extent. This extension is better to use the full WMS layers depending
on how their respective servers define them.
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If you click on the “Advanced” button, the advanced configuration dialogue will drop down.
This allows you to define more properties to obtain a complete WMC.

:.§|- Web Map Context properties
Options

Wi |Untitled - O \

Title: |Catastrn Shain |

ID: |idCatastro |

File: |,fhame,ffalarin;catastm.cml || Brawse |

wersion: | 1,1.0 -

Extent: (=) Defined by the wiewds extent
() Use full extent | Advanced << |

Advanced options

Ahstract: E?\?i;i::izﬁéix'!ls)
() Custom size
Feywords: | |
Description UEL: | |
Logo LRL: | |
Contact info
Marme: | |
Organization: | |
Positian | |
Address | |
Cityyr | | State fProvince: | |
Postcade: | | Country |Afghanistan -
Telephone: | | Fax: | |
E-mail: | |
| Ok || Cancel |

- Abstract: This contains a summary of the view defined by WMC.
- Keywords: This list of words allows you to classify and “metadata” the WMC.

- URL description: If you have a web site which refers to this WMC, write its link
here.

- URL logo: If you have an image associated with this WMC, write its link here.
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Map size (pixels): This defines the pixel size that the WMC-defined view will have.
The current gvSIG view size is used by default but you can customise the size if you
wish.

Contact info: Information that allows third parties to contact the WMC author.

5.23.2.3 Importing an WMC

Importing Web Map Context allows you to use gvSIG to open views with WMS layers
which have been created with other platforms or with another gvSIG.

Use the "View” menu and select “Import” and then “Web Map Context”.

Wiewy Help

Export

The WMC file selection dialogue opens.

[_: Open E E

Look In: |C3 falario -| |§| |§| |§| |ﬁ|g_:
3 datos ] catastro.cml Open layers as

™3 Deskiop [Layers in the current view: Untitled - O ~|
el e wiew

3 Examples

Lavers in the current wiew: Untitled - O
Layers in other wiew

£ qusIG

£ gwsIG_1.0_8&8
C3 gwslc_1.0rcl
£3 temp

£ warkspaces

File Mame: ||:atastrcu.|:m| |

Files of Type: |OGC ek Map Context (*.cml) v|

| Qpen || Cancel |

Choose the WMC file you wish to import. On the right, you can specify how you wish to
view the layers.
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New view: This adds a new view to the current project and loads the WMC as
specified in the file.

Layers in the active (current) view: This option only appears if the active gvSIG
window is a view. It allows you to quickly add the layers to the current view.

Layers in other view: This adds the layers defined by the WMC in the chosen view.
In this option, a list of views appears to select the view that will contain the new
layers.

Click on the “Open” button to import the file based on your preferences.

5.24 Annotation layer

This gvSIG tool makes advanced labelling easy.

The process creates a new layer which represents annotations. The main features of this
new layer can be summarised as follows:

The new layer is only composed of the annotations created.

The table associated with this new layer only contains the fields which refer to the
text of the annotations (Text, Font, Colour, Height and Rotation).

- The layer created is always in .shp format, irrespective of the format of the original
layer.

5.24.1 Creating an annotation layer

To create an annotation layer, first select the layer from the ToC (Table of Contents).

e
Archivo  Wer Wentana Yista Tabla Ayuda Red
Comenzar edicidn |-" &F Bl S™ 6

: LE
i A g Exporkar a ... SHP
BB wer Tabla de atributos PiostGIS
= A cons_punt! GML

E COracle Spatial
Anotacian
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In the menu bar, select the “Layer” option, then select “Export t0” and finally select the
“Annotation” option.

This option opens the wizard which will guide you through the steps required to create the
annotation layer.

In the wizard’s first window, select the data which gvSIG requires to carry out the
operation from the pull-down tab:

Duplicate control: Select either “None” or “Centred” to choose the position in which
you wish the annotations to be inserted.

- Centred: A label is created for each value and this will be inserted in the centre of all
the labels which are the same.

- None: A label is inserted for each value, even if these are repeated.

Select the field to be labelled: Choose the field which contains the text you wish the
labels to show.

If you do not wish to modify the format of the annotations created by gvSIG and prefer a
standard format, click on “Finish”. If you wish to customise the format, click on “Next”.

The wizard’s second window allows you to select the fields of attributes of a a table (if
there are any) which contain the values which allow you to customise the labelling.
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i JranSTonmar S iCa pa s e o LAl O es) (a][x]

5i desea utilizar valores comunes a todos [os atributos de la
capa deje los walores por defecto. 5i desea personalizar
COomo se muestran la etiguetas seleccione los campos gue
almacenan los walores.

=

gue se mostrara el texto de la etigueta
[- Default - -|

“ 1. Seleccione el campo donde se almacenard el angulo con el

2. Selecione el campo donde se almacenara el color con el gue
se mostrara la etigueta

[- Default - -|

2. Selecione el campo donde se almacenara el alto con el gque
SE mostrara la etigqueta

[- Default - w | en unidades [pixeles |

4. Selecione el campo donde se altnacenard la fuente con el
fue se mostrara de la etigueta

|- Default - -|

| < Anterior | Fin || Cancelar

The following parameters can be customised.

B 0 b =

5.

Slope — the slope the annotation will have in the view.
Colour — annotation text colour.
Height — annotation text height.

Units — units in which the value assigned to the “Height” field are to be measured.
The options currently available are map units or pixels.

Font — annotation text font.

Set the values to be used for customising the required parameter (by pulling down the list).
Leave the default value in the fields you do not wish to customise.

Click on “Finish” when you have input these changes.

June 2007 Page 172 of 409



gvSIG - User guide

5.24.2 Editing an annotation layer

An annotation layer can be edited like any other layer. To start an editing session in gvSIG,
select the layer in the Table of Contents and then select the option “Start edition”.

i pwSIG:Sin titulo

Archivo  MWer Capa WYentana VWista Tabla Ayuda Red
DOpE s QxS @D 2

F:Wista: CapafAnotaciones_1000

A comarcae =hn
= Comenzar edicidn
= ,. muni1 000

Cambio de nombre

Fropiedades

Zoom ala capa

Eliminar capa
Fecarngar

“Wer errores

Colocar delante

Copiar
Cortar

Fegar

When you start an editing session, an option appears in the menu bar called “Modify
annotation”. This will allow you to individually customise the annotation you wish to
change.

®

When you click on this button, the appearance of the cursor will change. You may
graphically select the annotation by clicking on the point associated with the text and then
access a set of properties shown in the following image.

© 2007 Conselleria de Infraestructuras y Transporte Page 173 of 409



gvSIG - User guide

o Modificar anotacién =
Opciones

Texto |,&LF,&RD |
Tipo de fuente |ﬂ~rial v|
Estilo del texta  |Plain ~|

Altura del texto |1O |
Color del texto | —

Rotacion del te...|Cl |

| Areptar || Cancelar |

5.24.3 Annotation layer properties
If we select the “Properties” option from the annotation layer contextual menu, the following
box appears:

.(n_ub Propiedades de la capa

General " Anataciones |

() En metras

(=) En pixels

Dibujar silo el texto
[7] Evitar solapes

[ Barrar anotationes solapadas

Cerrar

Aceptar || Aplicar H Guardar leyenda.. H Recuperar leyenda...

The “Layer properties” box has two tabs. The “General” tab allows you to access the
general properties of the layer and the “Annotations” tab allows you to select:

1. whether you wish the annotation text to be shown in pixels or metres in the view.
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2. whether you want only the text to appear (select the “Draw text only” option) or if
you prefer the text to be accompanied by a location point (deselect the “Draw text
only” option). However, remember that this point is useful, for example, to move the
annotation or to access the “Modify annotation” window.

3. If you wish to avoid overlays, activate the “Avoid overlays” option.

4. If you wish to eliminate overlaying annotations, activate the “Clear overlaying
annotations” option.

5.24.4 Adding an annotation layer to the view
To add an annotation layer, click on the “Add layer” button in the tool bar

=

and select the “Annotation” tab.

) ahadir capa v
Archivo ', GeoBD ', Georreferenciar | WFs | Anotacion ' whs | wes | ArciMs |

Cargar

| | | Cargar |

Unidades de las anotationes |pixelas |

Froyeccion actual EPSG:23030 ‘ |

| Cancelar |

In the box you can select the annotation layer you wish to load, in addition to the units in
which the annotations are displayed (pixels or metres) and the projection of the layer.

5.24.5 Example of how to create an annotation layer

The following image shows how an annotation layer is created out of a polygon layer called
“muni10000.shp” which contains all the towns in the Valencian Region. In the first window
of the wizard, insert the type of duplicate control you wish to use and select the field which
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contains the text to be shown. This is the field in a layer’s table of attributes which contains
the name of the town.

If you do not wish to customise the presentation, click on “Finish” and indicate where you
wish the new annotation layer to be saved.

- gwSIG:Sin titulo

lrchivo  Ver ©apa Yentana Mista Tabla Awuda Red
Dol 5 ddaS8Xya O eE8 r yNoaEe voOo @ 8 F
*Vista : Capahnotaciones

,. AUnic pios zh

A muni10000

The following image shows the result (the rest of the fields in the wizard are left with their
default values and this one is zoomed in) of creating the “annotation layer”.

The annotation layer which has been created is the one in red called “Towns” in the Table
of Contents.

5.25 Working with raster images

5.25.1 Saving as raster

First of all, load the cartography you need to make a clipping onto a gvSIG view.
Select the “Save as raster” tool which appears in the tool bar.
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Now select two points in the view to define the rectangle that will contain the area to be
saved. The following dialogue box then appears. If the rectangle you have marked is too
small, this box will not appear and you will have to select a larger rectangle.

e e SIGe niticke —
File Show Lawer Window Wiew Help

OpEscaasxanmods )

BEE

b=

@ View: Untitled - 0
—..[v] Bl cov_nosvgrc

Save as raster

Coordenadas
Upper left 3 3 (4209183 | r: [4581239.9
loweer right X X: [432530.6 |r: [4580146.2

Seleccion

(3 Scale

O Mis/pixel Resolution |75 -
() Siza

Mtz pixel

Wichth Height

Fichero
Fila
Select

Cancelar |

i Application staried 110,850 [=]metros I+ = 432,530.67 ¥ = 4,580,146.29 EFSCIZI030

The coordinates of the points which delimit the selected area in the view appear at the top
of the “Save as raster” dialogue. These coordinates can be changed manually.
The “Selection” area appears in the centre of the dialogue. This includes three selection
methods:
- Scale. If you select “Scale”, the “Scale” text box and the “Resolution” pull-down
menu are enabled. The pull-down menu values correspond to the points per inch in

the exported image.
Input a value for the scale and press “Enter”. The Mts/pixel values and the “Width”

and “Height” size of the output image are recalculated.
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<

:_: Save as raster m
rCoardenadas
Upper left X X: (4309183 | v. [4581239.9 |
loweer right X X |432530.6 | v. [4580145.2 |
raeleccion
Scale | 200|
(2] Scale

() Mtsfpixel Resolution

(1 5ize
Wicth[2 402 1 | Heigh 16294 ||Pixels =
rFichera
File:
Select || Propiedades GTiff |

|;-\J:Eptar| [Cancelar]

- Mts/pixel: If you select “Mts/pixel” from the three radio-buttons column, the text box
to input this value will be enabled. Input a Mts/pixel value and press “Enter”. The
“Scale” value and the size (“Width” and “Height”) of the output image will
automatically be recalculated.
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5]
& Sawve as raster

¥

Coordenadas

Upper left X X 4309183 | . |4581239.9 |
lower right X X |422530.6 | |4580146.2 |

Seleccion

Scale
[ 5rale

(3] Misfpixel Resolution |75 -|

() Size
Mis/pixel (020001

ificith Height

Fichera

File:

Select

| Cancelar|

- Size: If you select “Size”, the text box to input the “Width” and “Height” values will
be enabled. When you input one of these values, the other will be recalculated
automatically to maintain the height/width proportions. The remaining data
(“Mts/pixel” and “Scale”) will also be recalculated automatically. You can also select
the unit of measurement you wish to see the values in via the “Pixels” pull down
menu.
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m Save as raster

¥

Coordenadas

Upper left X 3 [420918.2 |r:|4581239.3 |
lower right X ¥ (4325306 | Y: [4580145.2 |

Leleccion

Scale
[_J)5cale

() Mtsfpixel Resolution |75 -
() 5ize

Mts fpixel

Wicith 8061 | Height| 5468 ||Pixels |

Fichero
File:
| Select

| Cancelar|

Click on the “Select” button to choose where you wish to save the image. The most
suitable driver will be loaded according to the type of file you choose (N.B. watch how the
button to the right of “Select” changes), i.e. when a .jp2 output file is selected for example,
you can open the properties box which corresponds to a Jpeg2000 format. The formats
available to save a file are geoTiff, jpg (georreferenced with a worldFile) and jpeg2000. An
ecw extension can be selected exceptionally and only with Linux kernel 2.4.
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E Select file E E
Lok n: | C3 bin ~| (5] [t ¥ |E|E

s
3 lib

File Name: | |

Files of Type: | tif -

When you select the output file the properties button is enabled.

For geoTiff files, a box similar to the one below appears:

Propiedades de tif

Tamafio de blogue: |256 v|

Fotormétrica: |RGE v| Entrelazado: |E=,&ND v|

Cormpresion: |NDNE v| Cenerar Tfw: [ |

| Areptar | | Cancelar |

Block size: The block size defines the amount of data read each time so it can be
compressed. The greater the block size the faster the compression speed but more
memory is used.

Photometric: [MINISBLACK | MINISWHITE | RGB | CMYK | YCBCR | CIELAB |
ICCLAB | ITULAB]. This assigns the photometric interpretation. This is RGB by
default, because the input image has 3 byte-type bands.

Interleaving: [BAND | PIXEL]. The tiff files have band interleaving. Some
applications only support pixel level interleaving. In these cases, this option can be
modified.
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Compression: [LZW | PACKBITS | DEFLATE | NONE] This assigns the
compression to be used. The default option is none.

A table like this will be obtained for jpg.

Propiedades de jpg E

¥

Block Size: 256 |

COmpression
-1

I 1) 1

10 400 i 100
Frogressive:

| ArCeptar | | Cancelar |

Block size: The block size defines the amount of data read each time so it can be
compressed. The greater the block size the faster the compression speed but more
memory is used.

Compression: This allows the image’s compression level to be adjusted.
Progressive: This allows you to make progressive jpgs.

When the image has been selected and the properties have been adjusted, click on “Ok”.
A progress bar appears. This process may take an extremely long time depending on the
size of the output image. It can take from a few seconds to several days. Thus, it is
advisable to control the size of the output image via the number of pixels so we are not
taken by surprise.
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s View: Untitled - 0
- vl Bl cov_opsvgpre

Coordenadas

Upper [eft X X: [420580.0 | v: [4581698.4
lower right X X: [422647.1 | v: [4579608.8

Please wait,

| »
Cancelar
Fichero
File: valen tif
| Telect I Froperties GTiff |
Aceplar| ‘ Cancelar’| )
i Application started 110,850 [~metros D= 432,647.18 ¥ = 4,579,608.84 [EPSC:23030

When the process finishes, a statistics table indicates the saved image path, the disk size
of the output image, the length of the process and whether the image has been
compressed or not.

Finaliz ation Statistics

Estadisticas

File: fhomeffalariofaus|C_L1.0_8&8 [ hinfw.tif

Time: 2 5ec Size: &MEB 578KE ¢0B
Campression: o

|,&J:Eptar |

To check that the georeferencing has been correctly carried out, you can load the image
you have saved as another layer and apply a transparency.
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| % View : Untitled - 0 i &=
. e ir
[ cov_onsvarc
aEEe]
i Application started 1[10,950 > |Metros P=430,79431 [V = 4,581,679.7 |EPSG:23030

5.25.2 Georeferencing with base mapping and control points

The gvSIG programme allows an image to be georeferenced (.jpg, .tif, .gif, .png) using
control points on a georeferenced base map.

Firstly, the georeferenced base map needs to be loaded (in raster or vector format or both)
to a gvSIG view.

e —————————————————————————————
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| % view : Untitled - 0

-[v] Il valencia2002.

i Application started 154,303 > |Metros D= 72564763 [¥ = 4,375,575 32 |EPSG:23030

Secondly, the image to be georeferenced must be added. You can load this image by
going to the “Add layer” tool and selecting the “Georeference” tab.

Use the “Load” button to access the image you wish to georeference.
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E Open layer ﬁ

File * Georeference | JDBC ' WFS ', WS | WCS | ArcIMS |

Load

| (===

[] Usar geareferenciacidn de la imagen

Current projection: EPSG:22030

Cancel

If you enable the “Use image georeferencing” check box and the image is georeferenced, it
will be added to the view with its current georeference. If it is not, the image will be loaded
in the centre of the view.

You will then find a browser button which can be used to select the map projection.

Current projection:  EPSG23030 | |

When you have finished the process, click on “Ok”. The image to be georeferenced will
appear in the view and will have an asterisk “*” in the ToC to indicate that this is the layer
the process is being carried out on. A new window will also appear to carry out the
georeference process but first, the image to be georeferenced will have to be moved closer
to the base map’s reference zone so that you can select the control points more quickly.
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5.25.2.1 Moving the image to be georeferenced closer

gvSIG:Untitled

File Show Layer Window View Help
OpEzcaeaFfinjexs x/mxo
& view : Untitled - 0
[ Ml ~paipontajpg
[ [l valencia2002.

OEEEEEEE™

E Georeference image

Paint \'Tab\e \ Options \

Point Error
activo

Res x:

o]
] Res ¥:
v EMS:
W

L Total: [ |
[ poims [4]4]___<[p]Wi]ppro (@] Ellv] |

.Il.lcg" Process || Accept || Cancel :

i Application started 154303 ~||metros b= 72482751 [v = 4,376,917.33 |EPsGi230300

If the layer to be georeferenced is selected in the ToC, four new buttons will appear in the
tool bar.

. % This button resizes the image to be georeferenced. The image size can be
modified and brought closer to the base map scale.

Select this tool and go to the image to be georeferenced. A frame will be created
around the image. If you place the cursor on one of the image sides, it will turn into
a double arrow. This will then allow you to modify the frame size by moving the
cursor. The newly created frame boundaries will become the new reference size for
the image being georeferenced.
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. This tool allows you to move the image to be georeferenced around the view
and thus bring it closer to the reference base map.

. This tool takes you back to the previous position of the image to be
georeferenced in the view.

.Y This tool is activated when the previous tool has been used and allows you to
redo what you have previously undone.

5.25.2.2 Selecting control points

L EEEEEEEEEREEEEEESSSSSs.
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quSIG:Untitled
File Show Layer Window Yiew Help
DeEztaasxt</an
% View : Untitled - 0 :

; *paiporta.jpg

M alenriaz ooz e

Paint \Table \ Optmns\

Point Error
artivo

o
— fes ¥
¥4 RMS:
I
L] Toal ||

poims M4 <] P[Wpelero [@]X<]Elv] |
..cﬁv Frocess || Accept | Cancel

iy

i Application started 1[21426 > |metros B =F23,437.94 ¥ = 4,368,967.44 [EPI0 23030

Click on the “New point” button in the “Georeference” dialogue and go to the view.

Place the mouse pointer over the image to be georeferenced and look for a control point.
This point is defined as a red circle with a cross in the middle. If you move outside the
boundaries of this image, gvSIG shows an error message and you will have to select a
point once again.

If you click on the following button

(]

two small windows will drop down. In the left-hand window, the location of the created
control point appears over an image zoom, as the following image shows.
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guSIG: Untitled

File Show Lawer Window View Help
DpEzcagxaloness x|

@ view : Untitled - 0 7

-1 Il =paiportaipg

v [l valenciazooz.e

Point————— | -Emror
i
e Res: [0 0
w5512
o000 Res Y:|0.0
& o KA RMS:[0 0
X
{2 B— 7

|P0|ms [Hl{[l vI)IHMOf 1 .lX m |

2 (4 [+
=18

Stale: 140332 Stale: 1

I O o ) acceon [ cance]
W L =T
- o S|

*a_»

i Application started 1[21426 > |[Metros M= 723,820.36 ¥ = 4,370,019.13 |EPS5:23030

If you wish to specify the point further, you can zoom into the image using the zoom tools
in the centre of the dialogue box.

=l =

If you then click on the point in the mini view and drag it you can move its location. These
changes will automatically be reflected in the gvSIG view.

When you have marked the control point on the image to be georeferenced, this will
disappear from the view (this option is marked by default in the "Options" tab in the
"Georeference" window and can be modified at any time) and will only leave the base map
with the destination point marked on the view.

In this case, the point is defined by a blue square with a cross in the centre.

e —————————————————————————————
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@ view : Untitled - 0 i

*paiportajpg

.\m\enma2002.e

Point——— -Error
[w] artivi
¥ 551.2
Ees 0.0
W FOE 06
REMS: 0.0

M| T22239 1636

Y :[4368077.5518 Total
Cpaints (4 [4[L <] b b peler 1 (O] A

Feas X |00

Scale: 140322

[I ]cév]c;,][ ‘Process “ Arcept J[ Cancel }

T

i Application staned 121428 > |Metros [ =725,033.86 [¥ = 4,366,569.88 [EPSC23030

You can do the same with the mini view on the right as you did with the left, i.e. if you wish
to move closer to the point location, you can zoom into the right-hand image and drag the
point over the view to place it more precisely.

You can also specify the points in the text boxes in the georeference dialogue window.
When the points have been input, press “Enter” and the point will be located in the view.
Remember that the “X” and “Y” text boxes belong to the image to be georeferenced and
that “Longitude” and “Latitude” correspond to the georeferenced image.

If you have made a mistake with the point and wish to delete it, click on “Remove selected
point”.

a

If you click on this button, a confirmation message will appear.

Selact an Option

? Femowve point

(o J( s ][ cone |
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If you click on "Yes", the point will be deleted.
If you wish to remove all the points, click on the “Remove all the points” button.

I

The control point selection must be repeated as a minimum of three points are required for
georeferencing, although at least nine are advisable.

There is another series of tools in the “Georeference” window:

previous point, search for control points using a pull-down menu, go to the following
control point and go to the last pull-down point respectively.

6] This button allows you to select control points from the view. Firstly, select the
control point of the image to be georeferenced and finally, the control point of the
destination coordinate.

You can disable an input control point via the "Active” check box in the “Point” tab. This
means that the point will not be used in the error and georeference calculations and the
symbols will not appear in the view. If you need the point again, you can enable the check
box.

Point

activo
¥ 54957
w710 39

¥'o|722165 6189 |
Y |4368070.1974 |

If you click on the “Table” tab, a table will appear with all the points and their errors. This
table can be enlarged to show more information.
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| @ view: Untitled - 0

g [l *paiportaing

Ml valenciaz ooz e . < LA ok . Georeference imag

Poimt TablE\OpliUI’]S"\

1 54857 71035, 722165.6... 4368070....
2 9347511291 7227088, 4367474
3 422752 1096.1.. 7213345 4367393

[¥]4 756.25..408.30..722503.9... 4368452....

|P0ims [T =] i[p#oi 2 [E]?].

Scale; 1140332

i Application started L[21436 = ||metros M =723,482.07 [V = 4,385,944.75 |[EPSG:23030

5.25.2.3 Saving and adding control points

When you have finished the georeference process, you can save your control points by
using the following tools:

. in a metadata file associated with the image with the .rmf extension (if data
already exists in this file, gvSIG will warn you that it is going to overwrite it).

J
. in a .csv file: In this case, a dialogue window opens to select a file to save the
data (X, Y coordinates and the errors in X, Y and RMS).

However, if you wish to add points from a file, use the following tools
. to retrieve .rmf control points associated with the image.

T
. to load control points from a .csv file.

N.B.: You can also save the georeference points in the table panel.
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5.25.2.4 Options

You can use the “Options” tab in the georeference window to enable and disable some of
the options according to your preferences.

|

Georeference image

Point |, Takle  Options |

[w] Show numbers

[ ] Create warldfile

Include the errars in the C3% file.

Hide the layer after the first paint.

Center wiew in the selected point

Disahle the point layer after the first point.

Scale: 1:40332

EEEE

Process || Arcept || Cancel |

5.25.2.5 Restrictions

- Itis currently only possible to georeference bmp, gif, jpg, png and tif formats.

5.25.3 Brightness and contrast and Enhance
Applying “Brightness and Contrast” and “Enhance” filters to raster images.

Firstly, load the cartography in raster format in a view and right click on the name of the
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S|

raster layer selected in the ToC. When the menu appears select the “Raster properties”

option.

- M valencianroo=
Fename

Zoom to layer

Znam ta raster resalytion

Delete laver

Feload

Bring to front

Copy
Cut

Paste

Raster properties

Then go the “Enhance” tab.

Raster properties

Infarmation \". Bands ‘\Transparenw‘ Enhance "'. Pansharg "'.

~Brightness and contrast

[ |Brightness and cantrast

~Enhance

[ |Direct linear

Brightness

I~ |
L LA

o]

Caontrast
=k [0 |

[w]Prewiew

[] Remowe edges

[] Tail trimming ¢ 5% 3

V. |

[m:cept ] [ Cancel ] [,&pplv]

© 2007 Conselleria de Infraestructuras y Transporte

Page 195 of 409



S|
gvSIG - User guide 4

You will see that the “Brightness and contrast” and “Enhance” adjustment panels are
disabled by default. These panels can be enabled by checking the boxes at the top of each
panel. If these check boxes are disabled no filters will be applied to the image even though
the values have been input into the panel. If, at any time, any of these filters have been
applied to the image, the values will appear in the panel.

(# View: Untitled - 0 Fd ®
...... Ml valenciazo02. & Raster properties !

Information \ Bands \Transparencv‘ Enhance \'. Fansharp \

rErightness and contrast rEnhance
[v]Erightness and contrast [vIDirect linear

Erightness [] Remowve edges

D
[ Tail trimming ¢ %3
Contrast O

[v]Preview

| Accept | | Cancel| | Apply|

You will find two slider controls in the “Brightness and contrast” panel. Values can be
modified by using the slider or by directly inputting the values in the numerical field on the
right and pressing “Enter”. The brightness and contrast increase range goes from -255 to
255. To fine tune these values without having to input them in the numerical field, click one
end of the slider control to either increase or decrease the value, unit by unit.

You will find a “Preview” check box in the panel. This is useful for obtaining a preview of
the image without having to “Accept” or “Apply” changes every time they are made. If this
check box is enabled, the image is refreshed with the new filters when the mouse button is
released after modifying the brightness or contrast values using the slider control or when
“Enter” is pressed if the numerical field has been used to modify the value.
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{54 View : Untitled - 0
4

Raster properties

Infarmation \ Bands \Transparency‘ Enhance \'. Fansharp \

rErightness and contrast rEnhance

[v|Brightness and contrast [ |Direct linear
Brightness [ Remove edges
[ Tail trimming (% )
B g

[P review

i e 55 v =
i Application started 170,864 [+]Metros b =719,220.99 | = 4,373,721.77 [EPSG:23030

When brightness and contrast filters are applied the previous image takes on the above
appearance. When “Cancel” is pressed, no changes are applied and the input values are
lost. If you press “Accept” and you return to “Raster properties” you will see that the
previously input values have been saved.

5.25.4 Transparency per pixel

This assigns transparency to a raster based on the colour of its pixels. To assign this
transparency, first load the cartography, then place the mouse pointer in the ToC over the
raster layer you wish to modify. Right click and the contextual menu will appear. Select the
"Raster properties" option. When the dialogue box opens, select the "Transparency"” tab.
Only the top part of the panel corresponds to this tool. Enable the “Activate” check box and
the controls that correspond to this function will be activated.
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e SIG: Dnikitled

8
1

DeEzdxaxsx«fm

% View : Untitled - 0

v] Bl cov_nosvgPGw «

Raster properties

Transparency per pixel

[v] Activate
S
o] W
Bl | @
O or
Opacity
[] Activate

Information |, Bands * Transparency | Enhance ' Pansharp |,

)

i Application started

| Accept || Cancel| | Apply

110850 [=|Metros b= 431,102 49
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You can write the required combination of red, green and blue values in the “R”, “G” and
“B” text boxes. When you have input these values, you can add them to the list with the
right-facing arrow. These values will be added with an AND (&) if the “And” check box is

enabled and with an OR (|) if the “Or” check box is selected.
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@ eIl o el e
File Show Layer Window Yiew Help
DeEzdxasxaf[m
% View : Untitled - 0 7
Ml cov_oosvgrow «

s xmxo

Information ' Bands * Transparency | Enhance ' Pansharp ',
Transparency per pixel
Activate
19 | 70 | 110
S
o] 9
Q) or
Opacity
Activate T 1) I
‘Accept | | Cancel | | Applv| ]
i Application started 1:/10.950 [+]Metros B =430,612.91 |f = 4,581,182.6 |EPSG:22020

Adding the values with an AND means that all the pixels that have the red, green and blue
values we have input will become transparent. Adding the values with an OR means that
all the pixels that have the red or green or blue values we have input will become
transparent.

If you select an entry from the list and click on the left-facing arrow, the values will appear
in the text boxes and can be modified.

You can input multiple values in the list. This means that when you accept the operation all
the pixels whose colour coincides with the values input in the list will be transformed.

5.25.5 Selecting a raster layer

This tool allows you to select raster layers from the view and for them to be selected in the
ToC.

This is useful if you are using an orthophoto mosaic and you need to find out exactly which
orthophoto you are working with.

You can access this tool from the tool bar by clicking on the following button
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or by going to the “View” menu then to “Selection”.

lrpart

Centrar_la_‘ista_sobre_un_punto
e [aner
J'g Add laver Alt-0
Mawigation
Query
SEet |ayers as

Configure locator map

Selection

Properties

We are now going to show an example of the use of the tool.

Remember that there are a large number of orthophotos in the ToC with similar names
which as a whole make up the province of Valencia in the “View”.

I ————————————————————————————————————————————————————————————
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' Vista:Sin titulo - 0 377
M 05-72264.e0w
M o5-72263 ecw
M 0572257 ecw
Ml o5-72256 00w
M o5-72255 ecw
M o5-72254.ecm
M 05-72253 ecw
M o5-72252 ecw
M o5-72251ecw
M o5-72247 ecw
M o5-72246 ecw
M 05-72245 ecw
M o5-72244 60w
M o5-72243 ecw
M o5-72242 ecw
M o5-72241 ecw
M o5-72237 ecw
M o5-72236 20w
M 572235 ecw
M o5-72234.00m
W o5-72233.e0m
W o5-72232 00w
M o5-72231 0w

I
q 1[2.059.893 [=]Metros jC=799.119,28 [y = 4.471.889,33 [P:520.204,31

Go to the view. Make sure the selection tool for the raster layer is active and click on the
orthophoto you wish to work with.

0 Vista: Sin titulo - 0
v Ml 05-72264. 20w
05-72263. 20w
(] [l 05-72257.ecw
[v] [l 05-72256.ecw
[ Ml 05-72255. ecwr
[v] Ml 05-72254.ecwr
[v] [l 05-72253 ecw
[v] [l 05-72252 ecw
[ Ml 05-72251 ecw
(7] [l 05-72247.ecw
7] [l 05-72246.ecw
05-72245.ecw
] [l 05-72244.ecw.
[] Wl 05-72243.ecw
M 05-72242.00w
[v] Ml 05-72241 ecwr
[v] Il 05-72237 ecw
[v] Il 05-72236 ecw
05-72235 ecw
7] [l 05-72234.ecw
[ [l 05-72233 ecw
] [l 05-72232.ecw.
[v] [l 05-7223 1 ecw

i 1:[457402 [=lfetros fc=7797492 [ =4314178,98 ;52020431

You will see that the chosen orthophoto has automatically been selected in the ToC.

6 Tables

Tables are documents which contain alphanumeric information. Tables are made up of
rows or records (which represent each of the elements in the data base) and columns or
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fields (which define the different attributes of each element).

Column

|

i3 Tabla: Tabla de atributos: riesgo_inundacion_25000_completo.shp - ol |
CoDIco | | PROT_IM i ZOMA_INU | MOM_ZOMA| CUEMCA [CODCUEM...| CODPCIWIL | AREA
7080 5.0 5.0 W15 Rio Cabriel Rio Cakbriel RXUQUER 3100 1218186,
G280 &.0 6.0 WIC20 Fambla d... Ramhblad... APCYD 24,00 2172317 |2
£30.0 &.0 6.0 WiZ20 Fambla d... Eamblad... AFOYD 29,00 2748306,
56290 &0 .0 FXUQUER.  21.00 239528 4.
53210 2.0 LG W20 ... Famblad... APOY(O 249,00 2063587
£32.0 2.0 1.Q WiZ20 . Eamblad... AFOY0D 29,00 2B4967.6.
637.0 &0 .0 WiZd5 FXUQUER.  31.00 1258252..
G440 £.0 6.0 FXUQUER  Z1.00 21584.3244
6500 &.0 6.0 BCAMADAD 20,11 1615071,
684.0 2.0 2.0 W13 | Barranco .. RXUQUER  21.00 1353638,
Row 6510 &0 &0 WiZ2l Barranca ... Barranco ... EXUQUER  31.00 496861.5.
6530 4.0 4.0 WiZ21 Barranco ... Barranco ... RXUQUEE  21.00 1581353,
BES.0 2.0 2.0 W13 Barranco ... Barranco ... EXUQUER =100 19122204
6860 2.0 2.0 FXUQUER  21.00 611705 3.
G870 2.0 2.0 W11l Fio Magro  Rio Magro  RxUQUER  21.00 226054 .4,
&880 2.0 2.0 W11 Rio Magro  Rio Magro RXUQUER  21.00 GEES 243,
6630 &0 .0 BRICASSE 2010 BE2553 .6,
G540 3.0 2.0 W23 Barranco ... Barranco ... RXUQUER  21.00 GLESET 2.
6850 &.0 6.0 BHOMDOL 20,20 2563348,
564.0 &0 .0 WiZZ 4 Barranca ... Barranco ... BHONDO1 3020 1042255 .
5550 1.0 1.0 W24 Barranco ... Barranco ... BHOMNDOL1 2020 516350.5.
SEBE.0 6.0 &0 W24 Barranco ... Barranco ... BHONDO1 20,20 1054292,
507.0 &0 .0 BHOMDO1 2020 186824 8.
5670 4.0 4.0 WiC24 Barranco ... Barranco ... BHOWDO1 32020 146542 2.
5680 4.0 4.0 WiZZ4g Barranco ... Barranco ... BHONDO1 20,20 124214.8.
5470 .0 &0 WiC2 Barranca ... Barranco ... EXUQUER  21.00 2228326 |
4.0 WiiZ24d Barranco Barranco R)(UOI|_IER 1.00 502429.|5.|_
................ : S 4
| 0 916 Tatal registros seleccionadas. | { | InTformation

- Row or record: Used to represent the different elements in the table.

- Column or field: The types of attributes which define each element.

- Cell: A cell is the intersection of a record and a field. A cell is the minimum working

element and may contain information.

- Record information: This provides information about the total number of elements
(records) contained in the table.
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All the vector information layers have their own “Table of attributes”. Each graphic element
in a particular layer has its corresponding record in the “Table of attributes”.

To select elements in the table, left click on them. Use the “Control” and “Shift” (CAPS)
keys to select more than one record.

6.1 Adding a Table

You can load a table in gvSIG in two ways:
From the “Project manager”

From the “View”

6.1.1 Adding a table from the “Project manager”

@& Project manager ?

Document types

SEESIEECEEE -Aafw"} j/i@

Wiews i Tables i Maps

Tables

Session properties

Session name:  Untitled
Sawed in:

Creation date: Oct 4, 2006

Properties

Select “Tables” as the document type from the “Project manager” and click on “New”.

A dialogue box will open in which you can add the table.
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L HEWITEDIE [x]
File \'. Data base |,

Tables

PUNT OS5, dibf T|

ok || cancel

When you click on the “Add” button, a browser window will open.

L OPEN! [a]x]

Look In: |C3 Tahlas EIRE]:

5] PUNTOS. dbf
Bl Thearrilbici. dibf

File Mame: FUNT OS5 dbf

Files of Type: | gdiams dbf diiver

5y string
gdbms dif driver

Specify the type of file you wish to load in gvSIG in “Files of Type”.

When you have located the file that contains the table, select it so that it is added to the
“File name” text box and click on “Open”.

You will automatically be returned to the "Add table" dialogue. If you wish to add more than
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one table, click on "Add" again and repeat the process.
When you have finished, click on “Ok”.
The table will then be displayed. It will also appear in the “Project manager” text box.

Tahbles
IPUNT 0. dbf

&# Table : PUNTOS.dbf

M1 | omz |
2.0 1oz277Ed. . 1.003511.. 1004544
2.0 1016522, 1001574, 1002545
4.0 1.ole3ee. . 1.002234. . 1003854
5.0 1010860, 1001667, 1002485
&0 1011073, 1000575, . 1001483
7.0 1001687 L.o000z22 . 993869,
8.0 1001792 0 1000735 100062y | —
9.0 1.00% 164, 9960722 0 1003378
10.0 1024310, 9965569 0 1007040 |
11.0 1018229, 9952562 0 1006064™ |
F |:;:;:;: :;:;l | pl
0 f 470 Total of selected recaords.

6.1.2 Adding a table from a view

Click on the “See table of attributes” button from the display window of a view with at least
one active layer, i.e. a layer that is selected in the ToC,

B2

or go to the "Layer" menu and then select the "See table of attributes" option.
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- Window  View Tahle Help

Start edition

Export to ... b
Bl Clear selection

takble of attributes

Transfarim to annatation layer

The table will automatically be added to the project.

G Yiew : Untitled - 0 G Project manager

=-{+*] M muniloo00.shp || Document types

- B Default

EEEEEEEEEEEEEEE 4

H L.,
Nk 2N s ol
Tahles M ap
~Yiews
Untitled - 0 [
G Table : Table of attributes: mu... @ [ |—
B_MUNICIP | CODIGO | COMARCA |PROVINC |
RELLEU 0221112  LlaMarina ... Alacant |- S
OFXET A 0221098  LaMarina ... Alacant [55 |_
SELLA, 0221124  La Marina ... Alacant B
FINESTEAT 0221065  La Marina ... Alacant |_
COMFRIDES 0221057  La Marina ... Alacant
BEMIFATO 0221022  LaMarina ... Alacant L
BEMIARDA 0221027 La Marina .. Alacant i
BEMIMAN... 0331037 LaMarina .. Alacant | |ted
EL CASTEL... 0221075 La Marina ... Alacant | |
POLOP 0221107  La Marina .. Alacant |[=) 4, 2006
1 | g :tf:f:}l_l 3 | [
0 f 544 Total of selected records.

If you minimise the view, go back to the “Project manager” and select “Tables” as the
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document type, you will see that the table displayed in the view appears in the text box.

6.2 Table properties

You can access “Table properties” from the “Project manager” window.

\--3 Table properties

Name: Creation date: |muni 10000 shp
Owmer: [10/4/06 5:01 PM

1=
|
|
|

Comments:

k. || Cancel

You can use this window to:
Rename the table.
Edit the creation date.
Add an owner to the table.
Add comments.

When you have input the changes, click on “Ok” and they will be saved.

6.2.1 Statistics

You can access this option by clicking on the following button
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2.

or by going to the “Table” menu and then to “Statistics”.
The “Statistics” tool allows you to obtain the most common statistical values.
N.B.: Remember that the tool will not be activated until you select a numerical field.
If you wish to obtain field statistics:
- Select the field (left click on the field heading).
- Then click on the “Statistics” tool.
You can only obtain statistics from a series of records:
6. Firstly, select the field the values are located in.
7. Select the desired records.
8. Click on the “Statistics” tool.

(4 Table: Table of attributes: ries... ' [

|| .’I:"«REP‘I:"«. I n.l_l'.ill..l | " LI T A "n‘-ll'l':"‘\l'.\ -
1218186, (M Jezilgiles x
21723217 ||5urm: 1.408295%7453E7

274830 6 ||Recount: &

2395384 ([Mean: 2816591 4906

206398 7 |[Maximum: 1.2 181868094E7
284957 6, |[Minimum: 161507 188

1258252, ||°tope: 1.2020360306000001E7
161507.1 Standard deviation: 4700205, 117836481

1353638....
‘|

5 f9le Tota
Close

6.2.2 Filters

You can access this tool by clicking on the “Filter” button in the tool bar
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or by going to the “Table” menu and then to “Filter”.
The “Filter” tool works in much the same way as in the “Views” section.

gvSIG allows selections to be made using filters. Selection using filters allows you to
define exactly what you want to select, including several attributes, operators and
calculations.

Requests can be made using logical operators, such as “equals” “more than” “different
from”, etc.

If you press the “Filter” button in the tool bar, a dialogue window will appear to define your
request.

;.} Filter (riesgo_inundacion_25000_completo.dbf

Fields: L=l i=d ol Yalues:
copieo = e Jl<=J[>=]
F_IM i
PROT_IN | Land ][ or || Mot
ZONA_INU el [ o |[Date]
MNOM _Z0MA -
CUENCA | |
CODCUENCA b

|New set||Add 10 set|

|Se|ect fram set|

Fields: Double click on the field you wish to add to your request from the “Fields” list
in the layer.

Logical operators: These allow you to insert a logical expression into your query
by clicking on them.

- Values: This shows a list with the different values the selected field has. If you wish
to add a value to the request, double click on it.

Request: This is the window which represents the request to be made. You can
write here directly.
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Selection buttons: These buttons make the request using:

- “New set” (deletes any previous selections).

- “Add to set” (adds the elements selected by the query to the existing elements).
- “Select from set” (makes the request from the selected elements).

N.B.: In a gvSIG view, when you activate a layer by selecting it in the ToC, the filter tool will
also be activated in the tool bar, even though no table has been loaded. This allows you to
work with the table associated with the selected layer. The "Table" menu will also be added
in the menu bar. This provides another way to access the filter tool when it drops down.

6.2.3 Ascending order

You can access this tool by clicking on the following tool bar button

or by going to the “Table” menu and then to “Ascending order”.
The “Ascending order” tool allows you to order the table records.
It orders the values from the lowest to the highest in a numerical field.

It orders the records in alphabetical order, starting from “A” in a text field.

6.2.4 Descending order

You can access this tool by clicking on the following tool bar button

or by going to the “Table” menu and then to “Descending order”.

The “Descending order” tool allows you to order the table records.
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It orders the values from the highest to the lowest in a numerical field.
It orders the records in alphabetical order, starting from “Z” in a text field.

6.2.5 Join
The “Join” tool allows two tables to be joined via a common field.

You can also access this tool by clicking on the following button

By

or by going to the “Table” menu and then to “Join”.
To join the two tables, carry out the following steps:
- Firstly, specify the source table the join is to be made from.

@

Select arigin takle of the join

Tahle of attributes: riesgo_inundacion_25000_completo.shp |:|

|Next| |Cance||

- Then specify the field to be used for the join.
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Select field 1o use for link CODICO -
B_MUMICIP

COMARCA

PROVIMC]AS

[F‘rem’uus] INE}{I] |Fini5h| [Cantell

9. Then indicate the table you wish to join to the first one.

Select table to link
Tahble of attributes: riesgo_inundacion_25000_completo.shp E]

[F‘rem’uus] INE}{I] |Fini5h| [Cantell

5. Finally, indicate the field in the second table which is common to the first one.

L EEEEEEEEEREEEEEESSSSSs.
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I

select field to use for link CODIGO |-

|F'rem'|:|u5| |Fini5h||Can|:eI|

If you open the data source table, you will see that the fields of the destination table have
been joined. The name of the field added to the table is identified by the word “Join_(Field
name)”

6.2.6 Link

You can access this tool by clicking on the following button in the tool bar

5

or by going to the “Table” menu and then to “Link”.

The “Link” tool allows two tables to be linked via a common field, so that any changes
that take place in one table will also be shown in the other one.

Firstly, specify the source table the link is to be made from.
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Select arigin takle of the join

Table of attributes: riesgo_inundacion_25000_completo.shp B

|F‘rem’uu5| INE}{I] |Fini5h | [Cantell

- Then specify the field to be used for the link.

Select field to use for link CODICO -
B_mUMICIP

COMARCA
PROV IMC|AS

[F‘rem’nus] [Next] |Fini5h| [Cancell

10. Then indicate the table you wish to link to the first one.

L EEEEEEEEEREEEEEESSSSSs.
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@

Select table to link

Tahle of attributes: riesgo_inundacion_25000_completo.shp |:|

|F'rem'|:|u5| |NE}{I| |Cante||

6. Finally, indicate the field in the second table which is common to the first one.

Select field to use for link CODIGO Rd

|F‘re*u-1|:|u5| |Fini5h||Can|:EI|

6.2.7 Moving the selection to the top
This tool allows the records selected in the table to be moved to the top of the table.

You can access this tool by clicking on the following button in the tool bar

or by going to the “Table” menu and then to “Move selection to top”.

The following table shows an example in which two records have been selected to move to
the top of the table.
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{4 Table : Thearrilbici.dbf ol |
CODICO | CALLE | EC_2000 |
1.0 AwfWavarr... 260.0
2.0 Awf Arago £330
2.0 AyfBlasco . 7100
4.0 Aaef Blasco... 720.0
E.0 CfOr Gorm... 243.0
£.0 Placa Patri.. 117.0 —
7.0 Awf La Plata 125.0
8.0 C/Duc de ... 1030
Q.0 CfComte ... 13l.0
10.0 Falitecnic 283.0 | |
11.0 Bizkhe lay... 570 i
2 J 21 Total of selected records.

If you click on the button, the table will change the position of the selected records.

.4 Table ; Thearrilbici.dbf ‘E =
CODICO | CALLE | EC_2000 |
3.0 AarfBlasco . F10.0 -
4.0 At Blasco... F20.0 poe
1.0 A fMavarr... 260.0
2.0 At Arago £93.0
5.0 C/Dr.Gom... 343.0 i
&.0 Placa Patri.. 117.0 —
7.0 Aorf La Plata 125.0
8.0 JjDuc de ... 109.0
9.0 CjComte .. 191.0
10.0 Folitecnic  283.0 | |
11.0 Bishe lau... 57.0 b

2 f 21 Total of selected records.

6.3 Table-associated tools

When a table has been loaded, either from the “Project manager” or from the view, the
tools associated with the table will appear in the tool bar.
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& B8 21 &V

A new menu, called “Table”, will also be activated in the tool bar. This can also be used to
access the different tools.

Table  Help
% Jaoin
BB Link

= Fedo

[nsert row
Femowe row
Manage fields

Copy
ooCut

= Ascending order

= Descending order

1 Mowve selection to top
%“Lﬁ-‘ Imyert selection

= Filter

% Prirt

6.4 Adding a table from a CSV file

From version 0.5 onwards, gvSIG can read information contained in a plain text file, whose
fields are separated by a semi-colon.
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¥ PUNTOSCoVEKaTE]
File Edit Project Document WView Bookmarks
Help

_1@ GQ = | =) Q 2 TR Q= ‘uv _L‘: L, b

=R

Tools Settings Window

1:MZ; M3 M4, B2
;10277886;10035119;1004544;ACE
;10165221;10015745;1002541;ACE
;10163661;10022346;1003854;M
;10108604;10016677,;1002485;M

Documents

10110732;10009782;1001483;ACE
10016874;10000229;999869:ACE
10017934,10007356;1000637;M
9:10051644;9960722:1003378:ALC-30
10:10249102:9965569,;1007040;M
11:10182296;9952562;1006062;M
12;10130579;9938422,;1005885;M
13;10080054;9916658,;1005464;M
1410024815 9887210081231

\
2
3
4
5
5
7
8

&1
[ Filesystem Browser

Projects

g

Line: 1 Col: 1 INS || NORM | PUNTOS.csv

&l

-4, Find in Files & Terminal

To carry out this operation, go firstly to the “Project manager”. Select “Tables” and then
click on “New”. A search dialogue box will open. Click on “Add” and the file browser will
appear in a new window (select “csv string” in “Type of file” to show the csv files).

s WpET

=153

Loak In: |D Tablas

~| (&) (ta) () (R 3=

£ PUNTOS. cov

File Mame: |

Files of Type: | csw string

gdbms dif driver
csv string

When the .csv file has been selected, click on “Open”

If you click on “Ok”, the data of the table you have added will be shown.
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4 Table : PUNTOS.csv :
M1 w2z [ w2z | m4 | B2 |
z 10277886 100351149 1004544  ACE -
E: 10165221 10015745 1002541  ACE 3
4 10163661 10022246 1003854 M
5 10108604 10016677 1002485 M
& 10110722 10009782 1001482  ACE
7 10016874 10000229 999869  ACE
g 10017934 10007356 1000637 M
9 10051644 9960722 1003378  ALC-30
10 10249102 9965569 1007040 M
11 10182296 9952562 1006082 M
12 101305759 9938422 1005885 M
13 10080054 9916658 1006454 M
14 10024815 9886672 1008123 M
15 99929321 9870545 1008785 M ||
=
0 f 470 Total of selected records.

6.5 Adding a table from a JDBC data origin

The contents of a data base table can be imported to gvSIG using data base managers
(PostgreSQL, MySQL, GBMS-HSQLDB, ODBC). gvSIG processes the information
obtained just like any other table.

Note: Oracle drivers installation is required for access to Oracle Spatial databases of the
geoBD extension. Please follow the steps bellow:

Go to Oracle Database 10g Release 2 (10.2.0.3) drivers.
Accept the license terms.
In the next page, download the file ojdbc14.jar (1,545,954 bytes) - classes for use
with JDK 1.4 and 1.5. (Registration required)
Move this file to the next folder:
Windows:
Move the file to the bin\gvSIG\extensiones\com.iver.cit.gvsig\lib
folder, that is in the directory where gvSIG is installed.
Linux:
Move the file to the bin/gvSIG/extensiones/com.iver.cit.gvsig/lib
folder, that is in the directory where gvSIG is installed.

To load a table with the information obtained from a JDBC data origin you must:
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Firstly, go to the "Project manager" and select "Tables". Then click on "New".

Select the “Data base” tab in the window that opens (“New table”) and configure the data
base server connection parameters:

s NEWEBTE) X
File ' Data base |

wr | |
Port: [ ]

Data base: | |
Table: | |
| |

e | |

Driver: |odbc -

o]’ || Cancel

If the information entered is correct, a new table will be created in gvSIG with the
information contained in the original JDBC table.

7 Field Calculator

gvSIG’s field calculator allows you to perform different types of calculations on the fields of
a table (for example calculate areas, perimeters, convert the data in a field from degrees to
radians, etc).

June 2007 Page 220 of 409



gvSIG - User guide

7.1 Accessing gvSIG’s field calculator

To access the field calculator, you must first start an editing session in gvSIG.

- If you wish to activate the edition of a layer loaded in a view, go to the layer’s contextual
menu and select “Start edition”.

=-[¥] A municipios.sl

i Comenzar edicidn

Cambio color

Cambio de nombre

Propiedades

Zoom ala capa

Eliminar capa

Caolocar delante

Copiar
Cartar

- If you wish to edit a recently-loaded table, go to the “Table” menu and select “Start
edition”.

Archivo  Ver Wemana Vista Capa | Tabla  Awuda
DDQ|D‘§‘-&4—|% = By Unign

{# Gestor de proyectos

(4 Tabla : com_aut.dbf

MOMERE || nom_

Camenzar edicidn

CIUDAD AUTOMOMA DE MELILLA

REGION DE MURCIA

CASTILLA-LA MANCHA

COMUNIDAD DE MADRID

COMUNIDAD FORAL DE MAVAR... NAFAR]
0 f 13 Total registros seleccionados

EXTREMADURA, )
ARAGOM |
CATALIOA CATALLE
COMUNIDAD WALEMCIANA COMUN —
15L4S BALEARES ILLES B4
z
1

P

& Irmprimir

o

Propiedades de la sesidn

Nombre de la sesian: Sin titulo
Guardado en
Fecha de creacidn: 11-ago-2006

Propiedades

- If you decide to use the field calculator on a “New layer” (for example New shp) which
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you are going to create (remember that to access this option you must go to the “View”
menu and select the “New layer” option), the layer will automatically appear in editing
mode when inserted in the view.

Wista  Asda

Exportar ]

Importar

Fluewo SHP
Muewa DxF

Muewn postgis

J'g Afiadir capa Al-0

Propiedades

Once you have started an editing session, activate the table of attributes on which the
operations are going to be performed and select one of the fields (by clicking on the field
heading).

The following button will then be activated in the tool bar:
This will allow you to access the field calculator.

NB. The first time you open the field calculator in a new gvSIG session, a warning window
appears to inform you that the calculator is “Loading operators”. Once this process has
finished, the window which allows you to perform operations with the various fields
appears.

7.2 Description of the “Field Calculator”
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Sl

Informacidn

Calcular expresion

El calculo de la expresion se realizara en este momento
sohre los registros existentes en la tabla.

General \A\aanzada\

Campo Tipo
[Area] (3) Numérico
() Cadena
() Fecha
Expresion

Columna : Area

Comandos

abs
acos
area
asin
atan

ceil

[] v

1]

Borrar expresion

Cancelar

The field calculator window has three different sections.

7.2.1 Information

The Information section provides information about the type of field and the commands

selected in the “General” tab.

The following information can be found in this section:

11. “Operator” = This indicates the command selected and the expression which

allows it to be executed.

s
Informacion

Calcular expresitn

operator; isMumber{Parametro)
Parametro: Yalor cadena
Cevuehve: Yalar baoleana

Descripcidn: Returns true if the string parameter is a number.

Example: In this case the command we wish to use is “log”, which allows us to

calculate the logarithm of a field with a numerical value.
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* Caleular expresitn
Informacion

operator: logiParametra)

Parametro; Yalor numeérico

Dewuelve: Yalor numerica

Descripcidn: Returns the natural logarithm (base &) of a double walue, Special cases:
* If the argument is Bahl or less than zero, then the result is klakl.

[z »

4]

The “log (Parameter)” operator indicates that, for example, in order to obtain the
logarithm of a field which contains the area data of a plot shp, the word “Parameter”
must be replaced by the field we wish to obtain the logarithm of. As a result, the
expression will be as follows: log([AREA])

Expresion

Columna : logaritmao

log{[AREA])

“Parameter”’= This can be one of three different field types which must be entered
in the expression box in order to perform the calculation.

Numerical value: a String, Double or integer type field must be entered.
String value: A String type field must be entered.
Date value: A date type field must be entered.

NB. If a table field is selected in the “Field” section of the field calculator, the
information window indicates what type of data it is.

NB. In order to input parameters into the “Expression” text box, either double click
on the name of the field from the list of fields in the General tab or type in the name
of the field, in which case the String expressions input must be placed in inverted
commas.
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] Caloular expresitn ———
Informacidn

Campo. AREA
Tipo: ¥alor numeérico

General\Ananzada\

Campo Tipo Comandos
T — | | |(3) Mumérica tan -1
[CODCUENCA] 1 ||O cadena i ]
[igII;P‘CIVIL] L O Fecha toDegrees
[ 1 taMumbier
[PERIMETER] L toRadians B
[HECTARES] = tostring B

7. “Return”= This indicates the type of data obtained as a result of the calculations.

Numerical Value = The result must be String, Double or integer type field
data.

NB. If a String field type has been selected, it should be noted that this field
type uses string values. If we add two String fields to another String field, the
final result is a string and not the result of the operation (for example: 2+2 =
22, not 4).

Boolean Value = A Boolean value returns a true/false answer to a question.
If the result of the question is in a numerical field, it would therefore be either
“1/0” depending on whether the reply was true or false.

Let us look at an example:

We wish to know if there are records in a field which are the same as those in
another field. The command which allows us to find this out “=="

Informacidn

operator; ==
Cevuehve: Walar boleano
Descripcidn: Returns true if the first object value is equals than the second value.

If we type the following sentence: [integer] == [double] (double and integer
being the names of two fields, each with numerical values), the response
according to the type of target field (Boolean or String) can be seen in the
image below:
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Sl

integuer || couble || hoolean || string
4 5.0 false 0]
5 5.0 true 1
7 4.0 false 0]
4 &0 falze 0]

Date Value: The result must be in a Date type field.

NB. If a new layer is created in a gvSIG view (View menu / New layer), the wizard for this
action allows you to specify the “Type of field” on which calculations are going to be

performed.

B Nueva capa
Define los campos

E Campo | Tipo

Tamafio

Area Double |20
Boolean
Date
Integer

Double
String

Borrar campo |

Afiadir campo |

e el

< Anterior

Siguiente >

Cancelar

If you are working with a layer and wish to know the field type, simply start a layer editing

session, go to the “Table” menu and select “Manage fields”.
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Tabla Awda Campo

% Unir

E Enlace

4= Deshacer
Insertar fila

Modificar estructura de tabla

i ™l

S Filtro

@ Imprirmir

This opens a window called the “Field manager”, which allows the fields of a table to be
created, renamed or deleted. It can also be used to confirm the field type.

] Editor de campos W feevs
Puede afiadir, borrar o renombrar los campos:

Mombre del c.. Tipo | Tamafia |Preusm‘n deu...| walor por def. \ |W‘
B_MLUMICIP string 100 [} —
CODIGO String 25 0 | Renombrar camps |
COMARCA string 30 o | Borrarcampo |
PROYIMCLAS String 20 ] -
integuer Integer 0 o

double Integer 0 8]

hoolean Boolean 1 o

s1ring string 0 o

fecha Date 50 o]

fecha rexision  Date 50 o

Fecha fin Date S0 o]

Aceprar

7.2.2 General / Advanced Tabs:

8. General: This provides information about:
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9. Fields: The text box shows all the fields of the table being worked on.

10. Type: Access to commands depends on which check box is activated.

11. Commands: These are the operators which allow expressions to be
constructed to perform the calculations required.

12. Advanced: A search box may be opened to look for an expression saved in a file.

General " Avanzada |
Expresiones de fichero

|| Explorar || Evaluar

Once the file has been selected, click on the “Evaluate” button to find out whether
the expression is correct or not.

NB. The expressions must be written in Python programming language.

7.2.3 “Expression” Section

The name of the field the results of the calculations of the expressions entered in the text
box appear in is next to the “Column” text.

NB. The expressions are only calculated on the records selected in the table (if no records
have been selected, the calculation is performed on all the records in the selected field).

7.3 Introduction example: “Field calculator”
Let us look at a simple example to explain how the field calculator works.
In order to work out the area of a series of plots in a layer we have created:

First, open a gvSIG view and load an orthophoto which will be used as a base to
determine the location of the plots.

Next, select the tool in order to create a new shp file (View/New layer/SHP).

Select a “Polygon” type layer, click on the “Next” option and then create a “Double”
type field called “Area”, leaving the default value at 20.
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o Nueva capa =
—————=Define los campos

I Area Double ~20

Boolean Borrar campo

Date
Integer

< gnterior | sigueme > | fn || cancelar |

Draw four plots on the orthophoto using the “Insert polyline” tool selected from the tool bar.
The image below shows that a record for each of the plots has been created in the table.

@ Vista: Sin titulo - 0 2000 i R R R

Jmetros f=727.201,84 fr=4371880,04 [EPSC:22020

Select the field from the table and activate the field calculator.
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= Calcular expresion =73
Informacidn

El clculo de la expresidn se realizara en este momento
sobre los registros existentes en la tabla

General \A\/anzada\

Campo Tipo Comandos
[Areal a Mumérico ahs [a]
() Cadena aros =
() Fecha area
asin
atan L
el b
Expresion

Columna : Area

Borrar expresion

Cancelar

The following information appears in the “General” tab:

Ceneral \Anranzada\
Campo Tipo Comandos
[Areal () Numérico BT B
() Cadena aros ]
() Fecha area
asin
atan |
el ~

“Field”. This contains the various different fields which comprise the table being
worked on.

“Type” of field selected. Access to different commands depends on the type of
field.

“Commands” which can be used in the calculations.

The “Information” section shows that:

- If the “area” command has been selected in the “General” tab, a brief description
will be displayed in the information window.
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Informacion

operator: areaf
Devuelve: Yalor numérico
Descripridn: Returns the area of polygon geometry of this row.

- If the “area” command has been selected in the “General” tab, the information
window returns a message with information on the field type (remember that when
designing the “area” shape, a Double type numeric field was created in which the
area will be calculated).

+ Caleular expresién =]
Informacion

Campo: Area
Tipo: Yalor numérico

The “Expression’ area displays the name of the column on which the calculation is being
performed and a text box for the calculation sentence to be used.

Ceneral \Avanzada\

Campo Tipo Comandos
[Area] ':fﬁ:' Mumérica ahs ]
() Cadena arcos [
() Facha area
asin
atan L |
el =
Expresidon

Columna : Area

areaf

Borrar expresion

In this case, the sentence included in the expression section is simple (no parameters are
required as they are in other expressions which shall be explained later on).

To sum up and conclude this example, once the “area” command has been selected, click
on “Ok” and the field created in the table will automatically be filled with the area values of

© 2007 Conselleria de Infraestructuras y Transporte Page 231 of 409



gvSIG - User guide

each of the polygons drawn.

T @ =

1746 563
1726109,
5106 418,
2252420

0 f 4 Total regist...
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8 Editing tools

8.1 Introduction

There are two types of edition. Firstly, there is the graphic edition of elements which
creates, modifies and deletes graphic elements and secondly, the alphanumeric edition
of elements which creates, modifies and deletes data associated with the elements.

8.2 Graphic editing

8.2.1 Introduction

gvSIG's CAD extension can make complex drawings from basic elements, such as lines,
circles or polygons.

Features can be duplicated or modified as you wish by using actions such as copying or
rotating.

To carry out these tasks, we need to know what type of layer is being edited. Once we
know the type of layer, we can see which tasks can be carried out.

When the “Start edition” option is selected, the edition tool bar buttons appear. Only the
buttons which can be used in the layer being edited are active. Thus, for example, if a
points layer is being edited, the selection, move and point insertion tools are enabled

= = % T ods CrDGE}E

« K/ 0% 00 o|H

whilst if, for example, the layer is a line layer, all the tools are enabled except the point
insertion tool.

e TacaOBlr - &-/FEGD@B|E|
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Another tool which appears when an editing session is started is the command console or
message and command area, located at the bottom of the graphic area. This tool allows

you to input commands via the computer keyboard. These are then carried out in the
graphic area.

8.2.2 The graphic area

@ WoSIGUniitled
File Show Laver Window Wiew Geometry Table Help
DelEztaasxiaomaoeas ( xNanvom a [BE
= Y Y Y D EEEERER

(% view : Untitled - 0 ; g B
= A carrilbici.s
© e 7 Defaun
=[] M cons_punt.shp
: = [Default
e []
[EE 2%
SELECTION. =
#Insert selection point = .
SELECTION.
#Insert selection point = .

; 1 —T
i Application started ‘ 1. |215360 - ‘lMetros P = 738,726 I‘-( = 4,377,698 15

If you select the “Layer” menu option then go to “Start edition”, the application window

June 2007 Page 234 of 409



S| §3
gvSIG - User guide ) d

shows the following areas.

Menu bar: Menus with which you can access the application’s functions. The
contents will change according to the situation, thus, for example, the "Geometry"
menu will only appear when a layer is being edited.

Tool bar: Bar which shows the drawing command icons.

Graphic area: This takes up the majority of the display and is where the layer which
is being edited is shown.

Command console: This is where the editor's PROMPT is located (active line of
the console). This means that the programme is ready to receive commands. When
a command is input, the corresponding process is run and the messages,
information or parameter requests are shown.

Status bar: This shows the scale, the measuring units, the absolute coordinates of
the cursor position (X and Y) in these units and the projection.

8.2.3 Starting and finishing an editing session in gvSIG
Firstly, enable the layer you wish to edit by selecting it in the ToC.

Place the cursor over it and right click on the mouse. The contextual menu appears. Select
the “Start edition” option.

=-[+] M municipios.sl
1 Defaul Comenzar edicidn

Cambio calar

Cambio de nombre

Propiedades

Zoom a la capa

Eliminar capa

Colocar delante

Copiar

Cottar

4

N.B.: More than one layer can be edited and you can alternate what you do with them.
However, whatever you do will only take effect on the active layer. To change the layer you
are working on, select it in the ToC.
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When you finish your editing session, go to the “Finish edition” option in the contextual
menu.

g-[# M municipios.sl |
. B Derault Terminar edicidn

Cambio color

Cambin de nombre

Propiedades

foom a lacapa

Eliminar capa

Colocar delante

[

Propiedades de Edician

N.B.: The application will create a projection of the object you are working on to help you
with the graphic editing. This will allow you to get a visual idea of the obtained result. The
object projection will be shown in red.

The figure shows how a projection of the figure copied in a different colour is created
during the copying process. This projection allows you to specify exactly where you want to
place the new object in the graphic area.
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8.2.4 Procedures to input commands

There are three general mechanisms for the application to run user commands. The first
mechanism is to select the command by clicking on the corresponding button in the tool
bar. The second option is to activate the tool by selecting it in the menu bar (normally in
the “Geometry” tab) and the third and last mechanism is by inputting commands in the
command console using the keyboard.

8.2.41 Tool bar

The edition tool bar appears when a layer is being edited. The tool bar icons will be
activated according to the type of layer being edited.

esTacaORMR| b0y OO @0E

8.2.4.2 Menu bar

When an editing session starts, a new menu called “Geometry” appears in the bar from
which we can access the different tools.
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File  Show Lawer Window iew | Geometry Table  Help

RE=1FP=ilolegew=2 gl Moty R Copy

s /OO C?|4- Insert b db Syrmmetry
.::s.l_? View: Untitled - 1 k seleccion_compleja (> Rotate
=8 A municipios. shp - Gl E‘ orale

- = D.EfEEUIT :2 !;:E\fertex
=[] M provincias.shg .

b B Defaurt /3

o [¥] M pais.shp

B B Cefault

8.2.4.3 Command console

[»}

SELECTION.
#Insert selection point = .
SELECTION.
#Insert selection point = .
SELECTION.
#Insert selection point > .
SELECTION.
#Insert selection point > .
SELECTION. -
#Insert selection point > .

N = »

M

The commands, options, messages or parameter requests the programme runs are shown
in the area called "Command console". The bottom line of the command console is called
the "line command" and shows the action the application is running.

The command console area size can be increased or decreased. To modify its size, place
the mouse pointer on the separation bar between the command console and the graphic
area, left click on the mouse and move the bar up or down until it is situated in the required
position. When you have finished, let go of the mouse button.

You can also hide the command console by clicking on the down-facing triangle situated at
the top right of the console. To show the command console, click on the upward-facing
triangle.

To input commands into the command console using the keyboard, write the name of the
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command or order and press “Enter”. Commands can be input in capital or small letters.

When a command is input, a window or a set of options associated with this command
appears. For example, if the “rectangle” command is input, a window will appear in which
the definition of a corner point is requested. When the point has been inserted, a second
point or “C” is requested to indicate that the object will be a square.

Insert selection point > rectangle.

FECTAMNGLE.
Insert first corner point = .

Il

8.2.5 Edition properties

When a layer editing session has been started, if you right click on its name in the ToC, a
contextual menu appears in which, among other things, you can access the “Edition
properties” to configure them.

- Edhion Propunies ==
F-Ceneral Edition
H-Metwark
&5-Edition Snap Tolerance: [ 4] npixels
Mark the layers to be used for shapping
Selected | Layer name MaxFeaturesEdition. .
muni L0000, shp 1000
Festore defaults | |A|:cept | | Cancel |

8.2.51 Snapping

You can configure the “Snap tolerance” in the first editing page. “Snap” or “Snapping” is
the process of moving an element until it coincides exactly with the coordinates of another
element. If the “Snap tolerance” is 4 pixels, two elements which are the same distance or
closer than 4 pixels will be joined in a common coordinate.
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You can do element snapping between layers by enabling the corresponding check boxes
in the “Selected” column.

You can modify the values of the "Maximum features edition cache" column to accelerate
the snappings and handlers being edited. This is the maximum number of geometries you
wish to work with in the cache.

8.2.5.2 Configuring the grid

If you select “Grid” in the tree on the left, this will allow you to configure the grid’'s
properties.

The grid is a point pattern which extends over the whole of the graphic area. It is useful in
that it allows you to line up objects and calculate the distance between them.

You can enable the “Show grid” and “Adjust to grid” check boxes and edit the distance
between the grid points.

i Edition Properties E ﬁ
#-General i
G- Metwork

; Grid
[=-Edition
- Grid
“Flatness [ Show grict
[ ] Adjust grid
Units Meters

¥ distnance: |1000.0 |
T distance: |1000.0 |

Festore defaults | |A£cept | | Cancel |

When the grid is shown, the graphic area will look like this.
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8.2.5.3 Flatness

You can configure “Flatness” by selecting the corresponding option in the tree on the left.

Edition Properties

E-General
---Network W Flatness
[=1-Edition

- Grid

“Flatness Specifies the minimum size of the lines that will
form the curves.

Flathess, |01

Restore defaults | | Accept | | Cancel |

In gvSIG, a circle or any curved geometry is made up of straight sections. The flatness
number you specify will define the maximum size of these sections.

8.2.6 Undo/Redo

gvSIG has several mechanisms to undo steps you have already taken in the layer you are
editing or redo some you have undone.
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8.2.6.1 Command stack

The command stack is a tool which allows you to undo/redo several commands at once. It
also provides information about the commands carried out, such as the name and time
they were carried out.

The command stack can be activated in different ways.

- By clicking on the tool bar icon shown below.

B8

2. By selecting the menu bar option "File" then going to "Command stack".

The command stack saves all the commands given on the layer being edited since the last
time it was saved.

4 commands stack :

Add POIMT 20/8f2006 18:8:58 o
Add POINT 20/Bf2006 18:8:58
Add POINT 20/Bf2006 18:8:58
Add POINT 20/Bf2006 18:8:58
Add POINT 20/8f2006 18:8:59
Add POINT 20/8f2006 18:8:59
Add POINT 20/8f2006 18:8:59 B
Add POINT 20/8,2006 18:9:1 ]
Add POINT 20/8f2006 18:9:2
Add POINT 20/8f2006 158:9:2
Add POINT 20/8f2006 158:9:2
Add POINT 20/872006 158:9:2 b’

L JlC G I I G I I E I O )

You can select the commands you wish to undo in the slider control. You can move the
slider control up or down until you have positioned it in the order in which you wish to
continue working.
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% commands stack

Add POINT 20/8f2006 18:8:58
Add POINT 20/8f2006 18:8:58
Add POINT 20/8f2006 18:8:58
Add POINT 20/8f2006 18:8:58
Add POINT 20/8f2006 18:8:59
Add POINT 20/8f2006 18:8:59
Add POINT 20/8f2006 18:8:59 P
Add POINT 20/8,2006 18:9:1 m
Add POINT 20/8f2006 18:9:2
Add POINT 20/8f2006 18:9:2
Add POINT 20/8f2006 18:9:2
Add POINT 20/8f2006 18:9:2 o’

L JIE AE I I G I I UG E I i )

You must remember that you cannot undo one specific command, you have to undo all the
commands given up to that point, i.e. we have to go to the last step we wish to keep and
continue editing from this point. For example, let us suppose that we take eleven steps and
when we reach the eleventh step, we realise that step number six is incorrect. We cannot
simply go to step 6 and cancel it, we have to undo the eleventh, tenth, ninth steps, etc. until
we get to the fifth one.

The advantage of using the command stack is that we can undo all the changes at once
without having to undo them one by one. In addition, we know which steps we are undoing.

You can access Undo/Redo from the edition tool bar by clicking on the corresponding icon.

The button with the left facing arrow allows you to undo the last step.

The button with the right facing arrow allows you to redo the last step you have undone.

8.2.7 Coordinates
A point can be referenced in two ways:
Console mode. The point coordinates are input numerically.

Graphic mode. The point is indicated by using any of the pointer devices (normally a
mouse).
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8.2.71 Console mode
Two reference systems can be used in the console.
Cartesian coordinates: These define points X and Y based on the reference point.

Polar coordinates: These define a point according to the distance based on the
reference point and an angle in respect to the horizontal axis.

The coordinates can also be:
Absolute: They define a point based on the coordinate source (0,0).
Relative: They define a point based on the last defined point.
Inputting Cartesian coordinates.

Input the X and Y values separated by a comma (X,Y). The X value is the positive or
negative distance, in units along the horizontal axis, the Y value is the distance in units
along the vertical axis.

The values used to designate the points can be whole, decimal, positive or negative.

The absolute coordinate values are based on the source (0,0), which is the place the X
and Y axes intersect. For example, the point 25,7 designates a point located 25 units away
from the source on the X axis and 7 units away on the Y axis.

The relative values of the coordinates are based on the last input point. Use the relative
coordinates when you know the coordinates of a point based on the previous point. To
designate a relative point, place the (@) symbol in front of the coordinates.

For example, the @1,2 coordinates determines a point 1 unit away on the X axis and 2
units away on the Y axis from the previously designated point.

Inserting polar coordinates

To input polar coordinates, indicate a distance and an angle separated by the < symbol.
For example, to designate a point 5 units away from the previous one with a 45 degree
angle, write @5<45.

The angles increase anti-clockwise and decrease clockwise. To move anti-clockwise,
indicate a negative angle. For example, the 1<315 position is the same as the 1<-45
position.

8.2.7.2 Graphic mode

Designating a point in graphic mode is simply to indicate it using a pointer device. If you
have a mouse as a device, the mouse's movement is linked to the cross hairs (crossed
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axis pointer) on the display.

+

Place the cross hairs on the desired point and left click on the mouse to define the point.

8.2.8 Editing commands

Editing commands are the set of orders used to edit or modify a drawing. More specifically,
they cover all the processes and mechanisms required to modify and work with what has
already been drawn.

gvSIG uses three different ways to run these commands.
By clicking on the corresponding button from the tool bar.
From the menu bar.

By writing the command in the command console.
8.2.8.1 Selecting

8.2.8.1.1 Simple selection

To select one of the drawn objects in the layer we are editing, click on the "Select" button
in the tool bar,

or go to the “Geometry” menu bar and then to “Select”.

Ceametry | Table Help

Insert ]

k. Complex selection
h select
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Then click on the object you wish to select.

8.2.8.1.2 Complex selection

You can access this button in the tool bar,

or by going to the “Geometry” menu bar then to “Complex selection”.

When the “Complex selection” tool has been selected, right click on the mouse in the
graphic area. The following contextual menu will appear.

Qi of rectangle

Inside polsgon
IntersectsfCaontains polygon
Cut of pokagon

Inside circle

Intersectsfcontains circle
Qut of circle

Select all

Cancel

Click on the option you wish to use to select the elements.

If you use the “Inside circle” option you can delimit a circle so that the elements you wish to
select remain inside this area.
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The selection result corresponds to the following image.

You can also write the “select” and “complex selection” commands in the command
console.

Command: “select”
Write the command “select” in the command console.

When a message appears in the command console requesting you to add the selection
point, input the coordinates of the object you wish to select. If there is an object in the
defined coordinates, it will be selected.
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SELECTION.
Insert selection point = .

Command: “complex selection”

Write the command “complex selection” in the command console and when the selection
options appear, write the desired option. The options are shown with their names, and in
square brackets ([]) the text you need to input in the command console to use the option.

COMFLEX SELECTION.
Insert point or Circle [IC], Out rect.[OR], Polyqg.[IP]. Intern. pol.[CF].

Il

If, for example, you wish to select the features that are in a polygon area, you need to write
“‘complex selection” in the command console, press “Enter” and then select the “IP” option.
This allows us to indicate the coordinates of the vertices which will make up the polygon
(when the coordinates of each of the vertices are indicated a polygon is drawn in the
drawing window) and when it is finished, the elements which are inside it are selected so
you can work on them.

The following image shows how a selection option is input.

Intern. pol.[CP], Out pol.[0P], Intern. circle [CC], Out circle [0C] = IPL

The following figure shows the definition of the selection polygon in the graphic area.
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File Show Layer wincow  Yiew Geometry Table  Help
Delstaasxiam osa s
s /02 0000ess2oocmORENEDHS |
% view : Untitled - 0

=-[+] & puntos
: = Default

NE [»] .

[»]

#Insert selection point > conplex selection.

COMPLEX SELECTION.
#Insert point or Circle [IC], Out rect.[OR], Polyg.[IP], Intern. pol.[CP],

#Insert point or Circle [IC], Out rect.[OR], Polyg.[IP], Intern. pol.[CP],
#Insert next point or finish selection polygon [E] = .
#Insert next point or finish selection polygon [E] = .
#Insert next point or finish selection polygon [E] = .
WInsert next point or finish selection polygon [E] = | .

2] T[]

i Application started 1. /1836124 [~] [Metros = 608, 773.7 = 4,525,502.17

[ ]

When the polygon is finished, the elements contained inside it will be selected so you can
work on them.

Selection options

- Inside circle [IC]: This allows you to delimit a circle and select all the elements
located inside this area.

- Outside rectangle [OR]: This allows you to delimit a rectangular area and select the
elements which lie outside this area.

- Inside polygon [IP]: This allows you to draw a polygon area and select the elements
located inside this area.

- Intersects with/Contains polygon [CP]: This allows you to draw a polygon area and
select all the elements located inside it or which intersect with its perimeter.

- Outside polygon [OP]: This allows you to delimit a polygon area and select the
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elements which lie outside it.

Intersects with/Contains circle [CC]: This allows you to delimit a circle and select all
the elements located inside it or which intersect with its perimeter.

Outside circle [OC]: This allows you to delimit a circle and select the elements
which lie outside it.

Select all: This selects all the elements contained in the layer regardless of where
they lie in it.

8.2.8.2 Copying

This makes a copy of the objects you have selected. The elements copied will keep the
same size and orientation as the originals.

To access this tool, click on the “Copy” button in the tool bar

= 3
th

or go to the “Geometry” menu bar, then to "Modify" and "Copy".

Ceametry  Tahle Help

Insert P Al Sammetry
k Complex selection ¥ Rotate
k Select L] Scale
_EF_ S Mowe
£ Edit vertex
@

The copying process is basically the same as the move process but the source objects do
not move from their initial positions. New objects are created in the new location which are
identical to the originals in size, shape and in the distance between them.

To make a copy, when the objects to be copied have been designated, two points need to
indicated, the base point and the move point.

As with the rest of the tools, a projection of these objects will be shown in the view to
specify the view location the copied objects are to be inserted in.
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IS

When the copied objects are situated in their
position.

To copy objects from the command console,

location, click on the view again to set their

write the command "copy" when you have

selected the objects you wish to copy, input the first move point and then the second point.

For example, when the command and the first move point have been input (30,40), the

projection of the figure being copied appears.

Input the second move point, (60, 40 in the example), and the new identical element will

appear in the defined location.

+ e EIG: Unrihed et =C =T
File show Layer  Window  Wiew Geometry  Tahble  Help
DerEztaasxiapmess s yEanvyom o [8F #|

. ;.../;“Q_OD@C)‘« =% T CHOR

DINEEEER

0 View: Untitled - 0

=-[v] & poligonos
B pefaurt

A=

[»]

COPY .
#Insert point for move > 30,40,

#Insert second point for move : G0,40.

ME

] »
i Application started ‘ 1. (837 [~] ‘Metros F =8l77 ; = 1143
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8.2.8.3 Symmetry

This tool allows you to make a drawing which is symmetrical to the selected one. You can
access this tool by clicking on the “Symmetry” button in the tool bar

or by going to the “Geometry” menu bar, then to “Modify” and “Symmetry”.

Al

GLeometry Takle Help

M oddifsy

Insert ]

k Complex selection
k. Select

STITIRT Y
[ Rotate
Bl Scale

S Mowe
‘Ef} Edit wertex

@

To obtain a symmetrical drawing in gvSIG, firstly select the element and then select the
“Symmetry” option. Then, click on the display graphic area to insert the first symmetry axis
point. gvSIG will then create a red projection of a figure which is symmetrical to the
selected figure. You can then input the second point the symmetry axis will pass through
by clicking on the graphic area again.
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If you wish to run the tool from the command line, firstly write the command “symmetry”.
Input the first point the symmetry axis will pass through and press “Enter”. The console will
then ask you to input a second point this axis has to pass through. Input the point and

press “Enter” again.
The console will ask you if you wish to keep the source object, write “Y” if you wish to keep
it and “N” if you do not.

gvSIG - User guide

|

& view : Untitled - 0

=-[# M poligonos
b B Default

I

=

SYMMETRY .
#Insert Tirst point = 40,90,

#Insert second point > 40,40.

#Remove objects from source? Yes[Y] or No[N] = .
AE 4]

i Application started 1: [837 [~

‘Metros i)( = 6952 ’Y: 15.17

8

8.2.8.4 Rotating
You can use this tool to rotate the selected objects by taking a base point as the centre.
You can activate this tool by clicking on the “Rotate” button in the edition tool bar
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or by going to the "Geometry" menu bar, then to “Modify” and “Rotate”.

Ceametry | Table Help

b odify X Copy

Insert P | Al Symmetry
k. Complex selection Rotate
k. Select k] scale
S Move
£ Edit vertex
L3

To rotate an element, first place the base point by clicking on the graphic area. Move the
mouse, with the help of the projection that gvSIG uses to the effect, until the new position
has been established.

Left click on the mouse in the view to define this point.

If you wish to rotate an element from the command console, select the object to be rotated,
write the command “rotate” and input the first move point. Then input how much you wish
to rotate it in sexagesimal degrees. The object will be rotated clockwise if you write a
negative angle and anti-clockwise if you write a positive angle.
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& view : Untitled - 0 |
g M poligonos
: B Default
(=]
#Insert selection point > .
#Select handlers = rotate.
ROTATE.
#Insert base point > 40,40,
#Insert rotation angle > 270.

i ]
i Application started 1. 837 - ‘lMetrus ID_( = 39494 I‘-r = 1976

8.2.8.5 Scaling

This command can be used to modify the size of the selected objects.
Select this tool by clicking on the “Scale” button in the tool bar

&

or by going to the "Geometry" menu bar then to "Modify" and “Scale”.
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Ceometry | Tahle Help

M odlifyy ”3; Copy
Insert B | Al Symimetny
k Complex selection (¥ Rotate
k. Select
S Mowe
£ Edit vertex
@

There are two ways of scaling, either by indicating a scale factor or by reference.

Scaling by “Scale factor”

To graphically scale elements using a scale factor, select the objects whose size you wish
to modify, activate the scale tool and set the base point. The application will create an
image which will give you a reference point about the size of the objects you are modifying.
As you get closer to the point you have set as the base point, the elements you are
working with will get smaller, whilst the farther away you move, the bigger they will get.
When the objects are the desired size, click on the drawing window again.

The same scale factor is applied for both the X and Y coordinates.

Feference

Cancel

To graphically scale using the "Reference" option, select the objects and activate the
“scale” command, then right click on the mouse inside the graphic area to show the tool’s
contextual menu.

Select the “Reference” option. Indicate the points on the reference line and on the scale
line as the messages in the command console are shown.
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SCALE.

#Insert bhase point > .

#Insert scale factor |2]| or Reference [R] = .

#Insert origin or Reference Line or Scale Factor [F] = .
#Insert end of reference Tine = .

#Insert origin of scale line = .

#Insert end of scale Tine = .

You can also use the “scale” command in the command console. When you have selected
the objects to be scaled, write the command “scale” and then input the base point as
shown in the following figure.

'@ view : Untitled -

g-[#] M poligonos
e [H Default

L E

#Select handlers = .
SCALE.
#Insert base point = 50,40,

#Insert scale factor |2]| or Reference [R] = .

[

] I Y
i Application started | 1: [837 IZI |Metros ; =51.432 \-” = 4532

To increase the size of the objects you must input a scale factor which is greater than 1. If
you wish to reduce the size of the objects, the scale factor must be between 0 and 1. If no
value is input, gvSIG will use the scale factor 2 by default.

Scaling by “Reference”

If you wish to scale using the "Reference" option, select the elements you wish to scale,
choose the base point, then input the letter "r" into the command console to indicate that
scaling by reference will be used. Specify the source point and the final point of the
reference straight line and then input the source point and final point of the scale line.
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@3 View: Untitled - 0

=-[¥] A poligonos

b [ Derault

b

==
SCALE. ]
#Insert base point = 230,30.
WInsert scale factor |Z2| or Reference [R] = r.
#Insert origin or Reference Line or Scale Factor [F] = 300,100.
#Insert end of reference line = 300,30
WInsert origin of scale Tline > 280,50.
WInsert end of scale Tine > 250,30. :
:1:| 3 I
i Application started | 1: ||Metros P = 257.62 F= 31.82

8.2.8.6 Moving Elements
This tool allows you to move the selected objects from one point to another in the view by
indicating a move vector.
You can use this tool by selecting it from the tool bar by clicking on the "Move" button
%

or by going to the “Geometry” menu bar, then to “Modify” and "Move".

L EEEEEEEEEREEEEEESSSSSs.
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Ceometry | Tahle Help

M odlifyy ”3; Copy
Insert B | Al Symimetny
k Complex selection (¥ Rotate
k. Select L] Scale
£ Edit vertex
@

If you wish to move an element, select the object you wish to move and then activate the
“Move” option. Click on the graphic area to define the move point.

gvSIG will create a red projection of the elements it is moving which can be used as a
guide to position them in their new location.

When the element is located in the desired position, left click on the mouse again to define
the new position.

To use the “move” command from the command console, write the command “move”. The
console will show a message requesting a move point. Input the point.
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@ View : Untitled - 0

=-»] M poligonos

[ Derault

e @

#WInsert selection point = .

(=]
=
WSelect handlers = move.
OVE.
E
[~

B

#Insert point for move > 140,50,

#Insert second point for move > 200,50.

7| 4
i Application started | 1: |837 - ‘lr\ﬂetros P = 21513 I\-“ = 6026

Then input the second move point. Press “Enter” and the object will move to its new
position.

8.2.8.7 Editing vertex

This tool allows you to go through the vertices of the selected objects easily and carry out
other actions, such as adding a new vertex or deleting the vertex which is being edited.
To access this tool, click on the “Edit vertex” button in the tool bar.

£

You can also access the tool by going to the “Geometry” menu bar then to “Modify” and
“Edit vertex”.
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Tahle Help

M odify = Copy

Insert bl Swmimetry
l: Complex selection [r Rotate
k. Select k] scale
% Move

Edit wertex

‘ Internal polkgon

To edit the vertices of a figure, select the figure and click on the “Edit vertex” button in the
tool bar. A red pointer appears in one of the vertices of the figure you are editing.

Previous
Add
Delete

Cancel

If you right click on the mouse, a menu will appear from which you can select the actions

you wish to carry out.
If you click on the “Next” option, the cursor will move to the next vertex of the selected

object.
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You can also access this tool from the command console. To do so, write the command:
EDIT VERTEX.

If, for example, you wish to go through the vertices of an element, write the command and
input the parameter “S” (next). To go to the previous vertex, write the parameter “A”. To
delete a vertex write the parameter “E” and press “Enter”. To add (insert) a vertex, write the
parameter “I” and press “Enter”. The X and Y coordinates of the new vertex will then be
requested (remember that these coordinates should belong to the polygon perimeter).
Input the data in the console and press “Enter”. A new vertex will be created in the figure.
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EDIT WERTEX.
#Point, Next vertex [S], Previous [A], Add [I] or Remove [E] = 7.

#Add vertex = 23.01,52.63.

#Point, Next vertex [S], Previous [A], Add [I] or Remove [E] = .

e B Y
837 - ‘lMetros Ii =251.02 I‘-( = 3498

i Application stared

8.2.8.8 Internal polygon
This tool allows you to create a polygonal feature inside an existing feature.

You can access this tool by going to the "Geometry" menu then to "Modify" and "Internal
polygon”

Takle Help

:'1'. Copy
Ab Smmetry
E Complex selection [r Rotate
k Sclect Bl Scale
S Mowe
£ Edit vertex

9. Internal palygon
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or from the following tool bar button:

Q

You can create an internal polygon, either graphically or from the gvSIG command
console. If you wish to create the polygon graphically, the polygon element layer must be in
editing mode and you must select the polygon on which you wish to use the selected tool.
Activate the "Internal polygon" tool and place the cursor where you wish to insert the first
vertex.

Then insert the vertices of the polygonal feature you wish to create.

When you do not wish to insert any more vertices, right click on the mouse and select
“End” from the contextual menu that appears.

I ————————————————————————————————————————————————————————————
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Cancel

The corresponding internal polygon is created.

You can also use this tool from the command console. To do so, write the command
“internal polygon” in the command line.

Then input the X and Y coordinates of the points which will correspond to the vertices of
the new polygonal feature. When you have finished, write “e” to close the new internal
polygon you have created.
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o [l Default

=]
Internal polygon. =
#Next point or end = 23,20
#Next point or end = 35,70,
#Next point or end > 20,62.
#Next point or end > e. =

Nz B »

i Application startec 1559 [+ ‘lMetros F = 9165 I'r = 86.18

8.2.9 Drawing commands

This section deals with gvSIG’s drawing commands. The rest of the commands can modify
the elements but with the exception of the “copy” command, they cannot create new
features and we thus require the actual drawing commands to do so.

gvSIG includes basic drawing elements, such as lines, circles or polygons, which can be
used to obtain any complex drawings.

All the elements you wish to insert need one or several points to be specified so that they
are correctly placed in the drawing.

Remember that the tools to insert new elements vary according to the type of layer being
edited. Thus, for example, a point can only be inserted in a point-type layer and is not
supported by any other type of layer.

8.2.9.1 Point

You can activate this tool by clicking on the “Point” button in the tool bar.
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You can also activate it by going to the “Geometry” menu bar then to “Insert” and “Point”.

Ceometry Tahkble Help

b oddify » [N Cn 1] 57 |
k. Complex selection o
k- Selact v
-
<,
O
(|
Gi'
i

To insert a point, place the graphic cursor (cross hairs) in the graphic area in the place you
wish to insert the point and left click on the mouse. The point will appear in the specified
position.

To insert a point from the command console, write the command “point”. Input its
coordinates and press “Enter”. The defined point will appear in the specified position.

FOINT.
#efine point = 10,20,

#Insert point = .

You can also define a point based on the previously inserted point. To indicate that you are
going to use relative coordinates, type in the “@” symbol before you input them, for
example, inputting “@0.30<30” means you wish to insert a point which is 0,30 units and at
a 302 angle from the previous point.
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#hefine point = 10,20,
#Insert point > @20<30.

#Insert point =

e

or by going to the “Geometry” menu bar then to “Insert” and “Multipoint”.

Tahle Help
M adify » |'t mEﬁ.|?|
Insert B * Foint
k Complex selection multipoint
k. Select / Line
™ Arc
< Pobdine
O Folyaon
I Rectangle
& Circle
3} Ellipse

8.2.9.2 Multipoint
You can activate this tool by clicking on the “Multipoint” button in the tool bar

I ————————————————————————————————————————————————————————————
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You can use the multipoint tool to create a drawing made up of a series of points which
function as a single feature (i.e. we only need to select one of the points for the rest to also
be selected). You need to bear in mind that this is not thus a points layer but a multipoint
layer.

To insert a multipoint in the graphic area, select the tool and place the cursor over the part
of the graphic area you wish to place the point. Left click on the mouse to insert the point.
Repeat this step as many times as you wish.

When you have finished adding points, right click on the mouse. A contextual menu will
appear. Click on “End” to finish the new multipoint feature.

o Cancel

o End

You can create a multipoint feature from the command console. To do so, write the
command “multipoint”. Input the coordinates of each point you wish to add in the console

and press “Enter”. To finish the insertion of the new multipoint feature, write the command
“E”.
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4 View : Untitled - 0

= M multipunto
: Default

D] H%

LR

ULTIPOINT.
#Insert point = 3,80.

(]

-)‘.#Insert point or End geometry [E] > 20,50.
;'.#Insert point or End geometry [E] > 40,30.
;'.#Insert point or End geometry [E] > 2,60.
;‘.#Insert point or End geometry [E] > 20,50.

#Insert point or End geometry [E] > e.
|
837 [=] ”MEIrDs }x - 99.69 |Y= 50.99

[o ]

= &

i Application started ‘ 1

8.2.9.3 Line

This command allows you to draw a line feature, which is actually a straight line segment.
This feature is limited by its initial and final points. The final point may be the start of the
next segment. When the first point has been inserted an elastic line appears on the
display. You can use the mouse to determine where you wish the final point to go.

As with the rest of the editing tools, there are three ways to access line creation. You can
go to the edition tool bar and click on the “Line” button

e

or go to the “Geometry” menu bar then to “Insert” and “Line”.
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Ceametry | Table Help
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Insert Ly *
k Complex selaction e
k Select
" Arc
2 Paokdine
O Folygon
1 Rectangle
I Circle
i % Ellipse

Place the cursor inside the graphic area and insert the line vertices in the desired points.
gvSIG will create a projection from the last inserted point to the mouse pointer which you
can use as a reference point to set the points in the drawing.

You can also draw a line from the command console. Write the command “line” and then
input the coordinates to define the points which delimit the segments which make up the
line.

You can also insert the second and/or successive points by defining a distance and an
angle. For example, to insert a point 1 unit away from the previous point at a 45° angle,
write 1<45.

The following image shows how a third point is inserted, after inserting the first and second
points, one unit away from the previous point at a 180° angle.
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40 View : Untitled -

- M lineas
v Default /

LB

0
|»E]

LIMNE.
#Insert first point = 14,55

#Insert second point or angle > 35,75,
#Insert second point or angle > 270.
#Insert length or point > 30.

#Insert second point or angle > 60,70.

nant o annaln
|

i Application started ‘ 1 ‘lMetros ID-( = 54.45 I; = 46.49

[ENE

8.2.9.4 Arc

You can draw an arc by clicking on the “Arc” button in the tool bar
"

or by going to the “Geometry” menu bar then to “Insert” and “Arc”.

I ————————————————————————————————————————————————————————————
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Seametry | Table Help
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k Complex selection o
k Select / Line

2 Pobdine
{7 Paolygon
"] Rectangle
&1 Circle
4 Ellipse

Three points are requested to draw an arc. The first and last points mark the initial and
final points of the arc and the second one marks an intermediate point through which the

hypothetic circle of which the arc is a part would pass.
To insert an arc from the command console, write the command “arc”. The three points

required to define the arc will be requested one after another.
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" View : Untitled -

-] M lineas
L™ Default

N
»
IvE

#Insert selection point > arc.

IBWRC.
#Insert first point = 20,50.

#Insert second point > 50,80,

E

#Insert last point > 55,55

SELECTION.
#Insert selection point > .
#Insert selection point = .
il 3
1: |370 - ‘lMetros ID:( = 548.78 |1-' =508

(|

i Application started
You can draw a

8.2.9.5 Polyline
This feature can be a set of arcs and/or segments combined by the user.
polyline by selecting the tool from the edition tool bar and clicking on the “Polyline” button

g,

or by going to the “Geometry” menu bar then to “Insert” and “Polyline”.
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Seametry | Table Help

Moty » N h [ 57 |

.

k Complex selection e

k Select Ve

Falkdine

{7 Paolygon
[l Rectangle
& Circle
4 Ellipse

-

The polyline allows you to insert straight lines in the graphic area, but these differ from
standard lines in that they allow you to insert an arc from the last vertex, to which it will
always be located at a tangent, and end the polyline thus creating a polygon.

Click on the graphic area in the place you wish the first point of the polyline to be located
and insert the following points by left clicking on the mouse in the places you wish to locate
them.

If you wish to draw an arc, right click on the mouse and select the “Internal arc” option in
the contextual menu.

[nternal arc

Close polkdine
Terminate
Cancel

When this option has been selected, gvSIG shows a projection of an arc from the last
inserted vertex to the mouse pointer.
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If you wish to insert more lines, go back to the contextual menu and select the “Internal
line” option.

If you wish to close the figure so that a straight line is drawn from the last inserted point to
the first point, select the “Close polyline” option.

To draw a polyline from the command console, write the command “polyline”. Input the
coordinates of the source point. Then you can insert the second point or input one of the
parameters to draw an arc “A”, or close the polyline “C”. When you have selected the arc
option, you can draw more straight lines using the parameter “N”.

The following image shows how the polyline draws a straight line from the arc's last vertex
to the source, thus creating a closed figure after inputting the parameter “C”.
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% View : Untitled - 0

e[+ M Poligono
S B Defaun

[»]

POLYLIME.
#Insert first point > 10,50,

#Insert next point, Arc [A] or Close [C] = 45,70.
#Insert next point, Arc [A] or Close [C] : a.

#Insert next point, Line [N] or Clese [C] > 55,55.

#Insert next point, Line [N] or Clese [C] = c.

[o =]

T | [»]

i Application started ‘ 1: 559 IEI ”Metrus }}( = 4904 IY = 4184

8.2.9.6 Polygon

This option allows you to draw regular polygons which will be handled as a closed polyline.
As usual, there are three ways of activating the polygon command.
You can select this tool by going to the tool bar and clicking on the "Polygon" button.

&

The second option way of activating the tool is by going to the “Geometry” menu bar then
to “Insert” and “Polygon”.
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To graphically insert a polygon in the drawing, select the tool and then click inside the
graphic area on the place you which to position the polygon’s central point.

The application will generate a projection of the object. Move the mouse using the polygon
projection as a reference point until it is the size you require, and click on the graphic area
once again.

You can tell gvSIG if you wish the polygon you are drawing to be defined as inscribed or
circumscribed in the circle. By default, the polygon will be inscribed in the circle. To modify
this setting, define the central point of the polygon, right click on the mouse to open the
contextual menu and select the desired option.

into_circle

circumscribed

ancel
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gvSIG also allows you to modify the number of sides you wish the polygon you are editing

to have. To do so, select the polygon object and input the number of sides in the command
console.

(% view : Untitled - 0
=[] M Poligono
B Default

g ¥ [E

LN

[»]

#Insert number of sides<5: > 10.

(]

;'.#Insert central point of the polygon = 30,70.
;'.#Inscr'ibed [I1 o Circumscribed [C] 1in circle |C] = c.
;‘.#Insert radius [R] = 20.

éELECTION.

#Insert selection point > .
#Insert selection point > .

[ ]

o€ [

o |
i Application started ‘ 1 [559 [~] HMEtros ’}( = 83.4 IY =71.98

[»]

The third way to select this tool is from the command console. To draw a polygon from the
command console, write the command “polygon”, specify the number of sides you wish the
polygon to have, whether it should be drawn as inscribed or circumscribed (“I” or “C”

respectively), and finally insert the radius, which must be delimited by indicating its length
in the units in which the view is defined.

8.2.9.7 Rectangle

This allows you to draw a rectangle by indicating its diagonally opposite vertices.
Click on the “Rectangle” button in the tool bar.
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You can also select the tool by going to the “Geometry” menu bar then to “Insert” and

“Rectangle”.

Seometry Tahkble Help

M adify

k. Complex selection
k. Select

l:_‘I
2 Pobdine
{f} Polygon

Fectangle
= Circle
i % Ellipse

To graphically draw a rectangle in the layer you are editing, select the tool and place the
first vertex in the required position in the graphic area. The application will show a
projection of the rectangle you are drawing. Move the mouse, choose the position for the
vertex diagonally opposite the one you have already inserted and left click on the mouse to

define it.

-

To work with the command console write the command “rectangle” and then input the

June 2007

Page 280 of 409



S|
. 9
gvSIG - User guide 4

coordinates for the first vertex and the diagonally opposite vertex.

4 view : Untitled -

-« M Poligono
e [ Default

[»]

L
(= =l
RECTANGLE . B
#Insert first corner point > 15,70.
#Insert point of opposite corner or square [C] = 55,55.
SELECTION.
#Insert selection point = . i
#Insert selection point > . =l
e B »
i Application started ‘ L ‘lMEIrDs P = 44.24 F= 25.89

8.2.9.8 Square

A square is simply a rectangle with equal sides. To prevent possible mistakes when
drawing the square, the application allows you to create a square based on a rectangle
and makes it have equal sides. To draw a square, first select “Rectangle” and insert the
first vertex, then right click on the mouse and click on the “Square” option (“Corner”) in the
contextual menu.
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Cancel

m

The following figure shows an example of the creation of a square from the command
console.

After the first point of the rectangle has been input, gvSIG is told to make the figure
become a square by inputting the letter “C”. You can then insert the opposite corner.

=

43 View : Untitled -

=-[+] A Poligono

B Default

[»]

o [

(=
#Insert first corner point > 20,40. =
#Insert point of opposite corner or square [C] = cC.
#Insert opposite corner = 50,60.
SELECTION.
#Insert selection point > . B
#Insert selection point > . -
e | )

i Application started 1. |559 - ‘lMetrus ID_( = 7632 I; =6l61
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If you make a mistake in inputting the coordinates the application will still draw a square by
calculating the size of the vertical line (Y axis), using the coordinate specified for the X
axis.

8.2.9.9 Circle

This command draws a circle inside the graphic area. You can select this tool by clicking
on the “Circle” button in the tool bar

@

or by going to the “Geometry” menu bar then to “Insert” and “Circle”, as shown in the figure
below.

Seometryy Table Help
M odifsy b (W x| 7 |

k Complex selection o
k Select J/

o~

= Pohdine

o Falyaon

] Rectangle

i+ Ellipse

There are two ways of defining a circle.

The first option is to define the central point and the radius. Select the “Circle” tool and
click on the graphic area in the place you wish to locate the centre of the circle you are
drawing. Then move the mouse to increase the radius of the circle until it reaches the
required size. gvSIG will, as always, create a projection of the circle as a reference point to
show the position of the circle in the drawing.

The second way of drawing a circle in gvSIG is to define it by using three points.
To access this option to define a circle, first select the tool and then go to the contextual
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menu by right clicking on the mouse in the graphic area.

Cancel

2R

There is only one circle that goes through three given points. When you use this option an
elastic circle appears. It is defined by these two points and the cursor until we define the
third point, as shown in the figure below.

4 View : Untitled -

g ¥ [E

=-[+] A Poligono
B Default

[»]

o [

#Insert
#Insert
CIRCLE.
#Insert
#Insert
#Insert
#Insert

selection point > .
selection point > .

central point or [3P] > .

first point > .
second point > .
third point > .

#Insert radius or second point = .
SELECTION.

[v]

Lo ]

NE

i Application started

1: [559 [~

-

|Metros ’)( =51.72 |Y= SE.16

You can also draw a circle from the command console using any of the methods described

above for graphic drawing.

Write the command “circle” in the command console and press “Enter”. Insert the
coordinates of the central point and then the coordinates of the point that will mark the
desired radius or length (use the status bar to check whether you are working in metres or

another measuring unit).
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4% View: Untitled -

e[+ M Poligonos
S B pefaun

4]

4

CIRCLE.
#Insert central point or [3P] > 35,30.

#Insert radius or second point > 10.
— |

i P —] T b = 5539 =929

To insert a circle from the command console by defining three points, write “3p” when the
“circle” command has been activated. When you use this option an elastic circle appears.
It is defined by these two points and the cursor until we define the third point, as with the
case of the graphic drawing of the circle.

The figure below shows how to create a three-point circle.
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4 View : Untitled - 0 |
g M Poligonos
: I Default
LR
EY6.2)
CIRCLE. |
#Insert central point or [3P] > 3p.
#Insert first point > 30,22.
#Insert second point > 20,45.
#Insert third point = 45,40. 'f
I 7] Y

i ‘ 1. |559 hd ‘lMetros P = 7651 I‘-r = 24.43

8.2.9.10 Ellipse

An ellipse is defined by an axis and the length of the second axis to the centre of the
ellipse.

There are, as always, three ways of selecting the ellipse drawing tool. To graphically draw
an ellipse you can click on the “Ellipse” button in the edition tool bar.

i

The second option is by going to the “Geometry” menu bar then to “Insert” and “Ellipse”.

I ————————————————————————————————————————————————————————————
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Ellipze

To graphically draw an ellipse, indicate the initial and final points of the ellipse’s axis by left
clicking on the mouse in the corresponding places. When the initial point has been input
an elastic line will be shown which can be used as a reference point to mark the final point
of the axis. When it has been set the ellipse projection will be shown until the third point
which marks the distance to the other axis is defined.
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#Insert selection point
#Insert selection point
#Insert selection point
#Insert selection point
#Insert selection point
ELLIPSE.

#Insert initial point of ellipse axis > .
#Insert final point of ellipse axis > .
#Insert distance to other axis > .

WO W W

ENE

4

| »
i ‘ 1: |559 - ‘lMetros P = 3831 Iv = 3961

To draw an ellipse from the command console, write the command "ellipse". When gvSIG
requests the initial point of the ellipse axis, indicate the point coordinates. It will then
request the final point of the axis and finally the distance to the other axis.
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#Insert selection point > . 1=
#Insert selection point = 2111ipse.
ELLIFSE.
#Insert dinitial point of ellipse axis > 15,30,
#Insert final point of ellipse axis > 50,30.
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Jz | Yo

i E Mewos - 7132 v = 37.89

8.3 Alphanumeric edition

A table is part of a data base. It is made up of rows or records and columns or fields which
contain the alphanumeric information needed to characterise the elements (polygons, lines
or points) which make up the theme maps, cartography in general and graphs. The rows
represent elements or objects and the columns represent the variables or attributes
associated with each element.
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{4 Table : Tbearrilbici.dbf - ol |
CODICO || CALLE | EC_2000 |

1.0 A Mavarr... 2e0.0 =
2.0 Al Arago 6990
2.0 arfBlasco ... 710.0
4.0 Aol Blasco... 720.0
&0 _fDr . Gam... 2430
&0 Flaca Patri... 117.0
7.0 Aarf La Plata 125.0
8.0 C/Duc de ... 109.0
4.0 C/Camte ... 191.0

| How> 10.0 Folitecnic  383.0 | i
11.0 Bishe Jau.. 57.0 i
12.0 o Taron... 1213.0 i
12.0 Cabanyal  123.0 B
14.0 Paszeig M... 267.0
15.0 Palau de .. 1056.0
1e.0 Pont 5ant ... 1212.0 -
17.0 Pont Cam... 10680 b
0 f 21 Total of selected records.

In general terms, there are two types of tables; “internal” tables which are typical of an
information layer and are found in the same file and “external” tables which can be added
to a gvSIG project.

Each element (point, line or polygon) of a layer only has one record in that layer’s table of
attributes.

8.3.1 Editing session for an “internal” table.
- Open a “View” and add the layer you wish to work with.

- Remember that to start an alphanumeric editing process in gvSIG, you must put the
layer you are working with in editing mode. In order to do this, select the layer in
the ToC, go to the “Layer” menu and select “Start edition”.

. Select the “See table of attributes” button
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or go to the “Layer” menu and select “See table of attributes”.
The table associated with the layer will be automatically added to the project.

If you go to the “Project Manager” and select the “Tables” type of document, you
can check that the table shown in the view is included as a separate document in
the project.

To finish the table editing session, go to the “Layer” menu and select “Finish
edition”. When the session finishes a message appears asking if you would like to
save the changes. Click on “Yes” to save all the changes made in the table.

8.3.2 Editing session for an “external” table.
Go to the gvSIG’s “Project Manager”, and select the “Tables” type of document.
Click on “New”.
Click on “Add” and open the table you wish to edit.
When you click on “Open” the table is displayed automatically on the screen.
Go to the “Table” menu and select “Start edition”.
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File Show Layer iwindow ‘iew | Table Help
DoRMm S EmE =5 Bon
\n} Project manager ]_
(;_@ Table : Thearrilbici.dbf
comico | calne | Ec_zooo |
1.0 AwfMavarr. .. 260.0 start editian
2.0 Awf Arago 6590
2.0 AwfBlasco .. 7100 -
4.0 Ayf Blasco... 720.0 )
c.0 C/Dr.com... 243.0 =
6.0 Plaga Patri... 117.0 =
7.0 Auwf La Plata 125.0 -
5.0 C/Duc de ... 1080 b3
4.0 CfComte ... 1810 1
10.0 Folitechic 2EZ.0 .
11.0 Bisbe Jau... 57.0 0 [z
12.0 AwfTaron... 1212.0
130 Cabarnsal 1230
14.0 PasseigM... 267.0 )
15.0 Palau de . 10560 | Print
16.0 Pont Sant ... 1212.0
17.0 Font Cam... 1068.0 b
0 J 21 Taotal of selected records.
Session properties
Session name:  Untitled
Sawved in:
Creation date: Sep 8, 2006
Properties

8.3.3 Editing a layer’s table of attributes

8.3.3.1 Adding a record

To add a new record to a table associated with a layer, a graphic element must be
inserted. When an element is added to the associated table a new blank record appears.
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Q Table: Table of attributes: prov.. & @ [

COD_PROY || MOMBRE || MOM_ALT || COM_AL

07 ISLAS BAL... ILLES BALE... ISL&S BAL|
25 LERIDA, LLEIDA, CATALUF
20 MURCIA, MURCIA,
31 MAYARRA  MWAFARROA COMUMID
43 TARRAGCD. . TARRAGCO... CATALUN
44 TERUEL ARAGON
46 WALEMCIA  WALENCIA  COMURNIO_
50 ZARAGOZA, ARACON|

A
156 Total of selected records.

7

Enter the data for the new entity and press “Enter”.

N.B.: Remember that if you wish to delete the selection, you can go to the tool bar and
click on “Clear selection” or you can use the menu bar by clicking on the “Layer” menu and
then on “Clear selection”.

N.B.: You can create a new layer with the elements selected in the table if you wish. To do
so, close the table, go to the menu bar and click on the “Layer” option and then on “Export
to ...”. Then select the format you wish to create the new layer with.

8.3.3.2 Modifying a record

To modify the data of a layer element saved in the table, select the element whose data
you wish to modify. The record that corresponds to the selected graphic element is
highlighted in yellow in the table of attributes.

© 2007 Conselleria de Infraestructuras y Transporte Page 293 of 409



S|
gvSIG - User guide 4

@ Table: Table of attributes: prov.. o @ [

COD_PROY | NOMBRE || MOM_ALT || COM_Al

MAYARRA  MNAFARROA COMUNID |
3 2 OREMNSE OUREMSE  GALICIA ||
24 PALEMC]A, CASTILLA
36 PONTEYE... GALICIA [
37 STALAM ANCA, CASTILLA
40 SEGOV|A, CASTILLA
4z SORIA, CASTILLA
47 W ALLADCLID CASTILLA
48 YIZCATA  BIZRALA PAJS W AST |
4 [ D

155 Total of selected records.

Left click on the cell in which the record to be modified is located.
The record changes and a cursor appears to indicate that the data can be input.

34 PALEMCIA  [Pallantia | CASTILLA ..

8.3.3.3 Removing a record

To remove a record from the table, you must first select the record.

i Table: Table of attributes: provincias... ¢ &' [

COD_PROY | MOMBRE MCM_ALT | COM_aT

il MAYW ARFEA  MAFARRDA COMUNlD |

32 OREMNSE OUREMSE CALIC LA

34 PALEMCLA  Pallantia CASTILLA. .. _

36 FOMTEWE. .. CALICLA, )

37 SALAMAMC A CASTILLA, ...

40 SECON A CASTILLA, ..
SORLA CARTILLA, .

47 WALLADOLID CARTILLA, .

45 WL CATA, BIZR.ALA, PAJS wASCO ||

49 ZAMOEA, CASTILLA, .. -

1,55 Total of selected records,

Go to the “Table” menu and select “Remove row”.

L EEEEEEEEEREEEEEESSSSSs.
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The selected record is deleted from the table and
disappears from the view.

S|

Ehjnm

BB Link
Fedo
o

Insert row

=
-

Femowve row

tManage fields
Copy

Cut

Faste

Ascending order
Descending order
Statistics

Mowe selectian to top

< 7 Mol T8

Filter
Femowe joins

Femaowe links

% Print

i5i# Table: Table of attributes: provincias... g“ @ [
COD_PEQCY | MNOMERE MOM_ALT | COM_AT

21 mlaw ARFA  MNAFARRCA COM UNID [ |
22 OREMSE CALIC A

24 PALEMCLA CARTILLA . _
it FOMTEVE. . CALIC A _
27 Sl AR AN C A CASTILLA .

40 SECOYW LA CASTILLA .

42 SORLA CASTILLA .

48 WS CAY A PAJS WASCO

44 ZAMORA CASTILLA . ||
04 ALMERIA, ANDALUCIA  |w
0 f 54 Total of selected records.

the associated graphic element
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8.3.4 Managing fields

This tool allows you to add, delete or rename fields.

To access this tool, go to the “Table” menu and select “Manage fields”.

(*An error occurs when you try to change the structure of a table hosted in a postgresq|
data base above version 7.4. To modify the structure, use a suitable data base manager).

Table  Help

% |oin
B8 Link

4= |ndo

[Nsert romy

Manage fields

& Print

When the menu option is selected, a window appears in which the fields of the selected
table and the buttons to create a new field or delete or rename an existing field are
included.
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Tk i Bl METEgEr, [B]x]
The fields can be added, deleted or renamed:

Field narne | Tyhe | Length | | e figld |
COD_PROY String 2 EEEE—
NOMERE String 150 | Rename field |
MO _ALT String 150 | Delete field |
COM_AUT String 150 E—

| Arcept |

If you click on “New field”, a new window appears in which some of the properties of the
new field to be added to the table can be configured.

T N EWSH EldipTOpETH ES) x]
Field name | |
Type |String "'|
Length |5'3' |
Frecizion

Default Walue | |

(] | | Cancel

- Field name: Enter the name of the new field.

- Type: If you click on the arrow on the right, a pull-down menu appears in which the
type of field data (string, double...) can be configured.

- Length: Indicate the required length of the field. Debe tener en cuenta que el
tamafio maximo para un campo de tipo string es 254.
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Precision: Indicates the number of decimals a numerical field must have (only for
numerical type fields).

Default value: Indicates the default value for the field when no specific value is
defined in the table.

If you wish to use the delete tool (“Delete field”) and the renaming tool (“Rename field”),
simply select the field to be modified and click on the corresponding button.

9 Geoprocesing tools

9.1 Introduction

The gvSIG geoprocessing extension allows you to apply a series of standard processes to
the vector information layers loaded in the layer tree in a gvSIG view (ToC), thus creating
new vector information layers which will provide new information for the source layers.

The following geoprocesses have been implemented in the first version of the
geoprocessing extension:

- Buffer.

- Clip.

- Dissolve (by adjacents and alphanumerical criteria).
- Merge.

- Intersection.

- Join.

- Spatial Join.

- Convex Hull (minimum convex polygon).

- Difference.

The output layer can take one of the output formats supported by gvSIG (it can only be
saved in shp format at the moment).

To start the geoprocess wizard, click on the "Geoprocesses" icon in the tool bar
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or go to the menu bar and select the “View” option, then “Geoprocess toolbox”.

Wiew Help
Export F
Import [

Center wiew to paint
I Locate by attribute

ety |ayer r
J'g Add laver Alt-0
MHavigation ]
Query »
Set lavers as r |

Canfigure locatar magp

Selection ]

Properties

B Ceoprocess toolbox |

| Geopracess toolbox |

The geoprocess toolbox window will appear.
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&4 Geoprocess toolbox

#-C1 Geoprocesses

| Qpen Ceoprocess |

If you click on each of the tree nodes, the different geoprocesses will drop down.

(=

=% Geoprocess toolbox

Bt Geoprocesses
= Analisis
- -3 Proximity
---D Crverlay
---D Computational Geometny
- B3 Aggregation
- Data conversion
, ..... D Merge
[ Xy shift
“-[ Reproject

Cpen GEDDI’DEESS]

June 2007 Page 300 of 409



Sl

gvSIG - User guide

When a geoprocess has been selected, a description of the process will be shown on the
right hand side and the "Open Geoprocess" button will be enabled.

{4 Geoprocess toolbox

=& Geoprocesses
B Analisis XY Shift

-3 Proximity

-0 Overlay This geoprocess applies a 20 translation transform to all points of the geometry of

: ---D Computational Geometry all the features of the input layer. To do that, user must enter x and vy offsets.

-3 Aggregation

=+ Data comersion

This is useful for conflation task, to integrate layers from different sources and
cartographic technical specs.

Open Geoprocess | [ Close |

When you find the geoprocess you wish to run, select it in the geoprocess tree and click on
the “Open geoprocess” button.

When some geoprocessing tools are applied (for example, Clip) a window appears in
which a spatial index can be created for the input layer. This is an internal process which is

only carried out once per layer and per new project and speeds up the spatial intersection
processes.

Crear indice espacial...

To create a spatial index for the input layer which can be used by the geoprocesses, click
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on “Yes”.

9.2 Accessing the geoprocesses

You can run the geoprocesses available in gvSIG with the geoprocessing wizard by
clicking on the following tool bar button:

e

The “Geoprocess toolbox” will appear and you can use it to select the geoprocess you
require.

To access the different geoprocesses, pull down the tree in the window shown below
(double click with the left button of the mouse on the "Geoprocesses" folder and the rest of
the folders will appear).

{4 Geoprocess toolbox

#-C1 Ceoprocesses

| Close |

When you have found the geoprocess you wish to use, click on the “Open geoprocess”
button.
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njp Geoprocess toolbox

= Geoprocesses

L‘—JB Analisis Buffer
B2 Proximity
© e[ Buffer This gecprocess creates a new polygon layer, with
- 1 spatial join polygon buffers of the geometries of the input layer.
BB%"E;?: Input layer geormnetries could have any geometry

type (point, line or polygon). For each input
geometry, you could create one or many equidistant
polygon buffer rings. Also, if input geometry type is

[ {3 union polygon, the buffer could be internal, external or
E}B Computational Geametry both.

- [ Convex Hul
-2 Aggregation

------ [ Dissohe

[ sr shift

------ [ Reproject

Cpen Geoprocess | | Close |

9.3 Buffer

9.3.1 Introduction

This geoprocess generates “areas of influence” around the vector element geometries
(points, lines and polygons) of an “input layer”, thus creating a new polygon vector layer.

Several equidistant concentric radial rings can be generated around the input geometries.
Moreover, in the case of polygon input geometries, the area of influence can be outside the
polygon, inside the polygon or both inside and outside it.

Some examples of the creation of areas of influence include:
«  Which urban areas lack schools in a 1000m radius.

- Which wells do not comply with regulations on observing the minimum distance
between two consecutive wells.

- River bed flood zones to monitor flood risks.
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9.3.2 Creating an area of influence or buffer

When you click on the “Geoprocessing wizard” button, the following dialogue appears:

G Geoprocess toolbox : =
== Geoprocesses =
& Analisis Buffer
B Proximity
.. Buffer This geoprocess creates a new polygon layer, with |/
D Spatial join polygon buffers of the geometries of the input layer. |
Hm%ﬂ%ﬁgfv Input layer geometries could have any geometry
i 'H type (point, line or polygon). For each input

D Difference geometry, you could create one or many equidistant |
[ Intersect polygon buffer rings. Also, if input geometry type is |

~+[1 Union polygon, the buffer could be internal, external or
= Computational Ceometry bioth,

“o[7) Comvex Hull

== Aggregation
{7 Dissolve

== Data conversion

[ xy shift
“[ Reproject

[0pen Genprucess]

-

If you select “Buffer” and click on the “Open geoprocess” button, the window associated
with this process is shown:
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) Analisys Tools —
Buffer. Data input:

Input cower: Cons_punt.shp v|

Mumbier of selected features: 249

() Buffer defined by distance:

() Buffer defined kby field:
[] Dissolwe entities [ ] Eectangle end cap

Create Buffer...

Mumber of radial buffers |1 |:—i

Qutput cover; | | Choaose |

Ok, || Cancel

The form is divided into the following parts:

H

Buffer. Data input:

[nput cover: ejes_lin.shp -

- Selecting the elements whose buffer is to be computed. This is a pull-down list
in which you can select the vector layer the calculation is to be applied to. If you
wish, you can enable the “Use selected features only” check box so that the
process only computes the buffer of the elements currently selected in the specified
layer.

© 2007 Conselleria de Infraestructuras y Transporte Page 305 of 409



Sl gI’
gvSIG - User guide ) g

(=) Buffer defined by distance:

() Buffer defined by field:

[ ] Dissolve entities [ | Rectangle end cap

Inputting the features of the buffer to be computed. You can choose to input the
buffer defined by distance (in the first text box) or to input a field in the input layer,
from which the buffer radius value to be applied will be taken. This second option
allows you to apply different buffer radii to different vector elements (whilst the first
option applies the same radius to all the elements in the input layer).

When the buffer of all the input layer elements has been generated, the “Dissolve
features” option allows you to merge the elements whose geometries touch each
other in a second iteration.

The “Rectangle end cap" option allows you to generate buffers with perpendicular
edges (not rounded).

Selecting the number of concentric buffers and their situation regarding the
original geometry. The gvSIG “Buffer” geoprocess allows you to generate several
equidistant areas of influence of the original geometry (for example, if the buffer
distance to be applied is 200m and you choose to generate two concentric radial
rings, the buffer distance of the second ring will be between 200-400m. Currently,
you can only generate a maximum of three concentric radial buffer rings for
efficiency reasons.

If the vector layer we are working on is a polygon layer, the “Create Buffer...” option
will be enabled, thus allowing the user to generate buffers outside, inside and both
inside and outside the original polygon.

Create Buffer...

Murmnber of radial buffers ‘1 ‘H

Introducing the result layer characteristics. Currently, the result of running a
geoprocess can only be saved as an shp file. Thus, gvSIG allows you to select an
existing shp file to overwrite it or to specify a new one. As new formats are
supported to save the result of the geoprocesses, wizards will be provided to
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indicate the characteristics of these formats.

Qutput cover: | || Choose |

When you have input all the necessary information to compute the buffer, and clicked on
the “Ok” button, a check routine is carried out to ensure that the information input is
correct: whether the radius distance is numerical, whether the attribute from which the
buffer radii are taken are numerical, whether a result file has been input, etc. If the check
routine is not correct, a dialogue box appears so that the input data can be corrected.

If the input information that you have entered is correct, a window with a progress bar
appears, in which the buffer processing rate is shown.

E PluginServices.Procesando e (sl

Computing buffers
Frocessing buffers: 1765 of 12901

[ |

| cancelar |

The process can be cancelled at any time by clicking on the “Cancel” button. As a
consequence, the result file and any other intermediate product generated as a result of
running the process are deleted.

Whilst the buffer computing process is underway, other tasks can be carried out, such as
changing the zoom or adding new layers to the layer tree in the gvSIG view. Other tasks
can be carried out because all the geoprocessing extension geoprocesses are run in
the background.

When the process has finished, the new result layer is added to the layer tree in the active
view. It is made up of buffer polygons with a specified radius based on the source layer.
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(% View : Untitled - 0
=} A buffer shp
o [l Defaunt

=-[v] M cons_puntshg

= Default

® L J
®
-
i L |Metrus |>< = 728,059.18 br: 4,346,051.81

Finally, the “Dissolve elements” option can be useful in specific situations (such as when
the aim of computing the buffer polygons is to determine the total surface area affected by
a phenomenon: quarantine areas, etc.), because when the generated polygons are
merged the surface area covered by the buffer will be a real surface area, i.e. the sum of
two buffers will not have any overlays.

The above image shows non-merged overlay polygons. The total area covered by the
phenomenon does not coincide with the sum of the individual areas.
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8
C

$
@

However, this second image shows merged overlay polygons. The total area covered by
the phenomenon is real.

When the buffer computing process includes the merger of overlay areas (dissolve) we
cannot predict its exact duration (we do not know how many polygons will touch each other
a priori). This is why the gvSIG geoprocessing extension does not show us a progress bar
as such, it shows us a bar which periodically reaches the end and then goes back to the
beginning. This type of process is called an “indeterminate” process.

m PluginServices.Procesando E ﬁ

Computing buffers

Cizsolving buffers...; 345 of 2449

| cancelar |

9.4 Clipping

9.4.1 Introduction

This geoprocess allows you to limit the working area of a vector layer (points, lines or
polygons), and to extract an area of interest from it.
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{©% Geoprocess toolbox

Lldl, TESUIL [dYEL WL e TOL TR 1 [ed Ul s Wil
Zeormetries are within bounding box of clipping m
layer.

=[5 Geoprocesses
B Analisis
- Proximity

[ Bufer Result layer will have the same alphanumeric

""" {1 Spatial join schema of the input layer.

+

| [ Comvesx Hull
-2 Aggregation

------ [ Dissohe

[ sr shift

------ [ Reproject

This could be useful to limit the working layer set to
a geographical region of interest (for example,
making a local gis with layers from a statal dataset). [+

Cpen Geoprocess | | Close |

To do so, you need an “input layer” (the layer you will use to extract an area) and a
“clipping layer” so that the union of the geometries included in the "clipping layer" defines
the working area.

The geoprocess checks all the vector elements in the “input layer” and will calculate the
intersections for the vector elements contained in the working area defined by the “clipping
layer”, so that in the "result layer" only the vector elements of our working area will appear.
The geometry portion that lies outside the working area will be clipped.

The alphanumeric schema of the input layer remains intact.
Examples of use:

- Setting up a local GIS would allow you to include national or regional maps and
then to delimit the city or town as the working area.

9.4.2 Clipping

When the "Clip" geoprocess has been selected, the following dialogue appears.
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S|

Clip. Data input:

& Analisys Tools

Input cover: layerl

[ Use selected features only:

Mumber of selected features: o]

Clipy covver: layer2

[ Use selected features anly

MNumber of selected features: 4]

Cutput cover: Jhome/camino/Carpeta nuewvafrecortar

Ok

|| cancel

This dialogue allows you to select which layer you wish to clip, and gives you the chance to
only clip the elements which are selected in the layer.

It allows you to select which layer will be used as the clipping layer and whether you wish
to use the union of all the polygons in the clipping layer as the clipping polygon or just the

selected elements.

Finally, as in the case of the other geoprocesses in gvSIG's geoprocessing extension, you
can define how the result layer will be saved (at present you can only save it as a shp file).

/vl A reconar.shp

“ [ Default
o v M iayer

o [ Deraunt
) A layerl

- [ Default

T T T 1~ )

i Aplicacion iniclacia FE—]

|><= 83,75

Iy: 84,32

EPSG23030
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As a result of running the geoprocess, you will have a new layer in which only the
geometries which came under the union of the clipping geometries have been kept.

9.5 Dissolve

9.5.1 Introduction

This geoprocess only acts on one “input layer” whose geometry must be a polygon type.
The process analyses each polygon in the "input layer" and merges the polygons that have
an identical value for a specific field into one polygon. Moreover, it allows you to involve
spatial criteria in the decision to merge several polygons. This allows you to establish that
for two polygons to be merged, they must be adjacent to each other in addition to having
the same value in the specified attribute.
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4 Geoprocess toolbox

EH- Ceoprocesses

B2 Analisis Dissolve
B2 Proximity
[ Buifer This geoprocess works with one only input layer,
[ spatial join whaose geometry type must be polvgon. It dissolves
5-G Overlay those polygons with the same value for a given

-0 Clip attribute. User could adds a spatial criteria, so

.1} Difference geoprocess wont dissolve not adjacent polygons.

= Inersect

D Union

M= Camputational Geametry
w7 Canvex Hull

- Aggregation

o[ [Dissalve

== Data conversion

----- 1 %Y shift
----- [ Reproject

Qpen Ceoprocess | | Close |

Example:

- We have a polygon layer which represents the municipalities of a particular
autonomous region and we need a polygon layer with the provinces which make up
this region. We can generate a province layer by launching the “Dissolve”
geoprocess and specifying that the polygons that have the same value for the
"PROV" field in which a unique code for the province is specified are merged.

9.5.2 Running the “Dissolve” geoprocess

Using the previous example, we start by taking a "local layer" which we wish to convert into
a "provincial layer".
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@ vista: Sintialo - 0 SEiEiEIEEEEEEGG e

=] A provindias.shp
I Deraunt
&.[#) A comvalenciana.

I Default

i Aplicacidn iniciada

|1 |Me[ms |><=770 000,68 h=4307 425,36 |[EPSG'23030

When the "Dissolve" geoprocess has been selected, the following window appears:

———— e
June 2007
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) Analisys Tools =

Dissolve. Data input:

Input cower: comwalenciana_muni.shp -

Mumber of selected features: =

Field to dissalve: PROY -

[] onby dissolve adjacents.

Mumerical attribiutes Group by functions
0 - OBJECTID 0 -
1 - AREA 1-
2 - PERIMETER S 2 -
3 - E20003_ | i | 3-
4 - E20003_ID 4 -
5 - PROY 5 - | |
& - MUMN & - b
QTR Cover: | Choose |

Ok, || Cancel

Firstly, select the layer you wish to dissolve (you can only work with a selection of elements
in this layer).

Dissolve. Data input:

Input cowver: comvalenciana_muni.shi -

Mumber of selected features; 657

You then need to specify the attribute of this layer which is going to be used as the criterion
to merge the adjacent polygons. In our example, we must choose the “PROV” attribute.
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=

Field to dissolhve:

[ ] only dissohve adjacents.

PROY

The polygons to be merged must have the same value for the dissolving attribute and in
addition, you can choose whether they are adjacent to each other (spatial criteria). If you

wish to choose this option, enable the "Only dissolve adjacents" check box.

The gvSIG geoprocessing module allows you to keep a summary of the input layer
polygon attributes once they have been merged. To do so, the “Summary function” concept
is introduced. As each polygon of the “Dissolve” geoprocess result layer is the product of
joining several input layer polygons, a summary function on the numerical attributes of the
merged polygons can be applied.

Mumerical attributes

0 - OBIECTID
1 - AREA

2 - PERIMETER
3 - E20003_
4 - E20002_ID
5 - PROYW

& - MLUM

If you click on the button with the

oroup by functions

O_
=
I 2 -
o = -
3 4 -
5 -
- 6_

4]

choose one of several summary functions for a selected attribute.

& Group by functions | =
Maxirmurm [ Awerage [
Minimurm [ Summatary [

| Arcept |

"<-" icon, a dialogue will be shown in which you can

The summary functions supported are maximum, minimum, average and summatory. A
field will be included in the result layer for each summary function selected for the
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numerical attributes you have selected a summary function for.

When you have specified the field you wish to merge and the numerical attributes you
wish to obtain a summary value for in the result layer, you are ready to run the geoprocess.

i Aplicacion inicia da | 1 ||Me(rus ix - 7$8.113,15 tr= 4.446.863,2  [EPSGI23030

9.6 Merge

9.6.1 Introduction

This geoprocess acts on one or several layers, generating a new layer which joins all the
geometries in the “input layer”. The "result layer" of this geoprocess will keep the attributes
of the "input layer" specified by the user. For the rest of the layers which have not been
selected, the attributes whose name and type of data coincide with any of the attributes in
the selected layer will be kept.
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% Geoprocess toolbox =l
E-& Geoprocesses This geoprocess can work with many input layers.
=& Analisis It merges all of these creating a new result layer
= Proximity which has a feature for each feature of all input | |
[ Burfer layers. Because each input layer could have its own |
[ spatial join alphanumeric scherma, user must selact which layer
- Overlay will preserve its schermna. The rest of input layers
-1 Clip will only preserve those attributes whose narme and
[ Difference type would be the same that an attribute of the
[ Intersect input layer whose scherma will be preserved.
[ union
= Computational Geornetry
[ Cormex Hull
E-L= Aggregation
[ Dissolve +
== Data conversion |
----- [1 merge
----- {1 =y shift
----- {1 Reproject '
Qpen Ceoprocess | | Close |

Example:

- When a cartographic series arrives which is separated into sheets and you wish to
join the content of the different sheets in one layer. This is the case of the Magna

series of sheets, published by the Spanish Technological and Geomining Institute
(ITGME).

9.6.2 Running the “Merge” geoprocess

If you select the “Merge” geoprocess, the following dialogue appears:
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) analisys Tools -
Merge. Data input:

Input cover:

cons_punt.shp

Lavers on directory,

Path with layers. .

Use fields from cover: | vl

Qutput Cover: | Choose |

Ok, || Cancel

The geoprocess allows any of the layers loaded in the layer tree in the gvSIG active view
as an input layer.

To run the process, first select the layers you wish to merge in the "Input layers" text box.
Then, click on the "Select” button. A new window will open in which you can give the new
layer file a name or choose a target file.
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- R (e
sawe [n; |3 Salida | ,] @
File Mame: |merge| |
Files of Type: |SHP Files |

Click on the "Save" button when you have finished and gvSIG will return you to the
geoprocess window.

Click on the "Ok" button. This will start the geoprocess.

PluginServices.Procesando

hMerge geoprocess...

Merging geametries... 1246 of 1460

| |

A new layer will be created at the end of the process which will be added to the view.
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@ Vista: Sin Ulo - L G i et M

=¥ M juntar.shp
: [ Default
= A riesgo_inundaci

© t- M Defaut
£ & muni10000.shk

“ [ pefaun I

i Aplicacion inicias da 1 IMelms |>< - 691 258,55 h: 4.463.941,71 [EPSG:23030

However, in the example of the sheets in a cartographic series, it would be awkward to
load all the pages in the series one by one. Thus, there is an extra option to select a
directory and to add all the layer files (with extensions supported by gvSIG) contained in
this directory to the geoprocess input layer list. The only layer files currently supported are
shp format files.

If you click on the “Folder with files...” button and select a directory, a list of the layer files
contained in it are shown and can be selected as part of the geoprocess input layers.

- Pathwith layers... |

722 11comunic.shp
722 12comunic.shp
722 12camunic.shp. dxf
F2213comunic.shp
722 14comunic.shp

Until you select at least one layer to merge with one of the two possible lists (the layer list
in the gvSIG layer tree and the layer list contained in the specified directory), no layer will
be shown in the pull-down list. This list allows you to select which layer is going to define
the attributes of the result layer’s attributes.

When you select the layers to merge in one of the two lists, the layer whose attributes we
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wish the result layer to have and when you have specified the file you wish to save the
result layer in, you can run the geoprocess. An initial requirement is that all the geoprocess
input layers have the same type of geometries.

i View : Untitled - 0 ot E=

g+ [¢] M mege.shp

/7 Default

3

i Application started 1[105.726 v |[Meters [ =715,172.2 [r=4,262,391.15 [EPSC.23020

The result will be a new layer with all the input layer geometries.

9.7 Convex hull

9.7.1 Introduction

This geoprocess calculates the “Convex hull”, or the smallest convex polygon which
surrounds all the vector elements in an “input layer”.

It only works with an “input layer” whose geometry type can be any type (point, line or
polygon).

There are different types of applications for this geoprocess:

- Determining the coverage area for a specific geographical phenomenon.

L EEEEEEEEEREEEEEESSSSSs.
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{4 Geoprocess toolbox :;

S|

Calculating the diameter of the area covered by a series of geometries, etc.

=l Geoprocesses
=& Analisis
=[5 Praximity
----- [ Buffer
----- [ spatial join

----- [ Difference
----- [ Intersect

----- [ Union

E-(= Aggregation

------ [ Dissalve

E-[= Camputational Geametry
------ [ Corvex Hull

Convex Hull

This geoprocess computes the convex hull of the
geometries of all input layer features

If works with one only input laver, whose
geometries could be of any geometry tvpe.

It could be useful for:

1

Open Genprocess]

Close

9.7.2 Creating a convex hull

If you select the “Convex hull” geoprocess, the following dialogue appears:
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Analisys Tools ==
Convex Hull. Data input
Input cover: cons_purnt. shp v]
[JUse selected features only
Mumber of selected featuras: 243
Qutput cover:
ok || cancel

After selecting the layer whose “Convex Hull” you wish to calculate and specifying an shp
result file, you can run the geoprocess and generate a new result layer.

1. (L]

The following image shows the convex hull created which surrounds all the points in the
input layer.
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9.8 Intersection

9.8.1 Introduction

This geoprocess operates on two layers, the “input layer” and the “overlay layer”, whose
geometries must be polygons.

{4 Geoprocess toolbox
T o P em e O T WG S A ST i T —
= ﬁ_lgc’ﬁ;‘g;;zses layer and the overlay layer. —
= Proximity For each gecrmetry in the input layer, it computes its
[ Butrer intersections with the geornetries of the overlay
[ Spatial join layer. For each intersection, it adds a new feature
- Overlay with the intersection as geometry and all attributes
[ clip of the features which originates it. It is called
D Difference "Spatial AND", because features of the result laver
[ Intersect models a space corrumion to both layvers.
[ Union
E-Z Computational Geornetry
[ Comex Hull
£l Aggregation
[ Dissahe
== Data conversion
-] Merga
= % Shift
-1 Reproject ’
Qpen Geoprocess | | Close |

It calculates the intersection with the different geometries in the “overlay layer” for each
geometry in the “input layer”, thus creating a new element for each intersection. This
element will take all the alphanumerical attributes in the geometries that created it (input
and overlay). This is why (it models space areas which comply with the condition of
belonging to the two polygons that created it) this geoprocess is known as “Spatial AND"
operator.

An example of how this geoprocess can be applied:
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- Given a land use layer (e.g. Corine2000), and a national geological map layer, you
can obtain a polygon layer with homogeneous information on land use and
geological material.

9.8.2 Running the “Intersection” geoprocess

After selecting the "Intersection" geoprocess, the following dialogue appears:

L Analisys Tools

Intersect. Data input

Input cover: layerl v]

[ Use selected features anly

Mumber of selected features: o]

Clip cower: layerz -

[ Use selected features anly

MNumber of selected features: o}

Qutput cover: Shomefcamino/Carpeta nueva/interseccion

Ok ” Cancel

Select the input layer and the overlay layer. You must also specify a file in which to save
the results. Finally, click on "Ok" and the geoprocess will be run.

In this case, we will use a very simple example to better understand the function of the
geoprocess. The previous figure shows two overlaying polygons. The result of launching

I ————————————————————————————————————————————————————————————
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the “Intersection” geoprocess with these layers as parameters is as follows:

i Aplicacidn inicia da. | 1 uMe(ros tx = 147.986,38 r(: 4.309.123,36 [EPSG:23030

9.9 Difference

9.9.1 Introduction

The “Difference” geoprocess works with two layers, the “input layer” and the “overlay
layer”. It is known as “Spatial NOT” and allows you to obtain the areas in a layer which are
not present in the other layer.

The geometries in both the “input layer” and the “overlay layer" must be polygons. The
alphanumerical schema of the “input layer” will remain intact in the "result layer", as in the
end it gives more information about it.
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\:E} Geoprocess toolbox §§

NE

E-= Geoprocesses

; This geoprocess is Al overla Soprocess. [t work
== Analisis £eop 7 ESCp

3 with two layers: the input layer and the overlay
-l Proximity layer. It is usually called "Spatial NOT", because it |
-+ Buffer stracts the geometry of a layer which is not in the |
“[ sparial join other layer.
L= Owverlay
- Clip By desing it only work with polygon layers (input
D Diffaratice and overlay). Result layer will have the
7 Intersect alphanumeric schemga of the input layer.
D Unian
EHEF Computational Ceometry
w7 Carvex Hull
= Aggregation

w7 Dissalve
=t Data comversion

-] Merge

=[] w0y shift

“.[ Repraject

Qpen Geoprocess | | Close |

This geoprocess is very useful in numerous situations. For example, it can be used to
complement the "Clip" geoprocess. If “Clip” allows you to exclude everything that does not
belong to a geographical area under study, "Difference" allows you to do exactly the
opposite; exclude a specific area from our working layer.

A useful example:

- Transferring territorial jurisdiction between different governing bodies. Thus, if the
national government transfers certain jurisdiction to a regional authority, it can
decide to exclude the geographical area of the transfer in question from its data
bases.

9.9.2 Running the “Difference” geoprocess

Click on the “Open Geoprocess” button to access the dialogue window which allows you to
run the "Difference" geoprocess.
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i Analisys Tools =]
Difference. Fill in data:

Input cower: COns_punt.shp v]
[JUse selected features anly

Mumber of selected features: 249

Clip cover: cons_punt. shp -

[]Use selected features anly

Mumber of selected features: 3249

CIUTRUL Covir:

[ Ok ” Cancel ]

You can enable the “selected features” check boxes at this point of the geoprocess for the
input layer and the overlay layer. If you click on the “Ok” button, the geoprocess will be run.

@ vista: Sin twilo - 0 7

A diferencia.shp
i I Cefautt
s A riesgo_inundaci

A munilo000.shy

i Aplicacion iniciada 1 Metros F< = 724.074,69 F= 4.335.129,48 [EFSC:22030

In the following image, the “Difference” geometry appears in black between a flood zone
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and one of the selected cities or towns.

In this case, the new layer resulting from the calculation of the difference will take the
schema (alphanumerical attributes) of the geoprocess input layer.

£ Vista: Sin tiwlo - 0 557

[] A muni1ooo0.st

i Aplicacion inicia da | 1: 39294 EIHMems }( = 723.988,44 ’v: 4.333.771,75 [EPSG:23030

9.10 Union

9.10.1 Introduction

This geoprocess is similar to the “Intersection” and "Difference" geoprocesses in that it
operates on two polygon layers to obtain their intersections (this is why these three
geoprocesses are known as “overlay geoprocesses”).
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i Geoprocess toolbox

== Ceoprocesses
=& Analisis

2 Provimity

=[] Buffer

------ [ spatial join

7 Corwvex Hull
== Aggregation

------ [ Dissalve

[—}---[_E' Computational Geometry

Union

overlay layer.

Like Intersect and Difference, this geoprocess is an
overlay geoprocess. It works with an input and an

It is alse called "Spatial OR" because features of the
result layer will have features whose geometry is in
any of the input or the overlay layer.

+

L 4

Qpen Ceoprocess |

| Close |

The "Union" geoprocess is known as "Spatial OR", because the result layer is made up of
the geometries which appear in the two layers (intersections between the polygons), plus
the geometries which only appear in one of the two associated layers. This means that the
geoprocess carries out three analyses: the first time it calculates the intersection of both
layers, the second time it calculates differences between the first layer and the second,
and the third time it calculates the differences between the second layer and the first.

This geoprocess may be of interest if you wish to generate new layers which show the
occurrence of two phenomena so that the occurrence of one of the two or of both is

highlighted.

9.10.2 Running the "Union" geoprocess

If you select the “Union” option, the following dialogue appears:
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& Analisys Tools

Clip. Data input:

Input cower: layerl v]

[JUse selected features anly

Mumber of selected features: 0

Clip cover: layers -

[1Use selected features only

Mumber of selected features: 0

CIUTRUL Covir: Jhome/camino/Carpeta nuewvafrecartar

[ Ok, ” Cancel ]

When you have selected the input layer, the clip layer and an output layer, click on "OK".

A Union

~- [ Default
A layerl

12 A rayer2

lgaaaz] o

i Aplicacidn iniciada | 1 ||Metros ix - 127.924,53% IY: 4.754.235,03 [EPSGI23030

The result layer will have all the intersections and differences between the two layers. If
you click on the “Information” button and then on the different polygons in the result layer,
you will see that the intersections have all the attributes, whilst the differences only have
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the attributes of the layer that created them.

9.11 Spatial Join

9.11.1 Introduction

This geoprocess allows you to transfer the attributes of one layer to another based on a
common element. In contrast to the join sqgl operator in the relational data bases, in this
case, the common element is not that a field of the two tables takes the same value, but
that the related elements in the two layers meet some spatial criteria.

{5 Geoprocess toolbox

(AN 1 L1 L) G B LA ) L B R R R NP ) S D R I A N B R L
=& Geoprocesses to transfer attribute vaﬁues is spatial: intersection or [—
E][B Analisis proXimity.
== Proximity
D Buffer If users select intersection like transfer criteria,
[ spatial join each feature of the target layer could intersect
B2 Overlay rmany features of the source layer {3 1-M spatial
- cClip relationship).
D Diffarence If users select proximity Mearest neighbour) we
[ Intersect have a 1-M spatial relationship.
w7 Union
B2 Computational Geometry
- [ Convex Hull o 2 0
= Aggregation o Te g
“[] Dissalve o : 2
E-(= Data conversion & +
- Merge :
[ %Y Shift
“[1 Reproject '
-
LI ®
®2a a
£ ° e
¢ .
Qpen Geoprocess | | Close |

The “Spatial join” geoprocess allows you to follow two types of spatial criteria to establish
the spatial link:

- Nearest neighbour (1->1 relationship). This assigns the attributes of the nearest
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element in the related layer to an element in the source layer. If the nearest element
intersects (or in the case of polygons is “Contained in”) with the source element, the
algorithm will take the first element analysed in the possible intersections.

Contained in (1->M relationship). This relates an element in the source layer with
several elements in the destination layer (in particular, with those that intersect). In
this case, the source layer will not inherit the related layer’s attributes, but the
operation will be very similar to the "Dissolve" geoprocess. The user can choose
one or several summary functions (average, minimum, maximum, summatory) to be
applied on the numerical attributes of the related layer for the M elements related to
an element in the source layer.

9.11.2 Running a “Spatial Join”’

When you have selected the "Spatial join" option, the following window appears:

¥ Analisys Tools m_—
Spatial join. Data input:

Input cover: 5 1%2<4puntos_cota.shp v|
Mumber of selected features: 18
Clip cover: S 1924cultivos. shp -

Mumber of selected features: 4

[ ] Use nearest geometry

Qutput cover: Choose

Ol || Cancel

This window is practically the same as the windows in the overlay geoprocesses (Union,
Difference, Intersection) with one difference. It allows you to choose whether you want to
run a 1-1 relationship (using the nearest neighbour spatial criterion) or run a 1-N
relationship (using the “Intersect” or “Contained in” spatial criterion). The choice can be
made by enabling or disabling the "Use nearest geometry" check box.
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If when you have selected the source layer and the layer to be related, the geoprocess is
launched and you have not enabled the "Use nearest geometry" check box, a window

appears in which you can select the summary functions you wish to apply for each
numerical attribute of the layer to be related:

s Group by functions bmd e
Mumerical at... Croup by functions

o -0 0 -

1 - MIVEL 1-

2 - COLOR 2 -

| Ok, | | Cancel

The summary functions are the same as in the “Dissolve” geoprocess:

4 Group by functions <> (___|[__]

b axirmurm [ Ayerage [
Minimurm [ summatory [

| ALCept |

Thus, the attributes transferred to the source layer will be the result of the summary

functions selected for each numerical field. If you run the geoprocess and the “Use nearest
geometry” option is enabled, this window does not appear.
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=} M 72222 puntos_cota shp
= Default
-7 M 72223 cultivs.shp
- [ Default

i Aplicacion iniciag da ‘ 1, ‘lMelrns Ix = 725.439,9 r(: 4.365.072,16 [EPSG:23030

9.12 2D Translation

9.12.1 Introduction

This geoprocess allows a translation transformation to be applied to all the points, lines
and polygons of the geometries in the input layer. The geoprocess can be applied to all
types of vector layers (shp, dgn, dxf...). To do so, the movement on X and Y must be
specified.

This geoprocess is extremely useful when combining cartographies which come from
different sources, a process which is referred to as conflation.

Bear in mind that although translations can be carried out on all types of vector layers
(shp, dgn, dxf, dwg...), the resulting output layer will always be a shape file. In other words,
the input layer can be a shp, dxf or dgn file, but when translation is applied to these layers,
the result will be one or various different output layers which are always shape files.

When a translation is carried out in which the input layer is a vector layer which is not a
shape file, the result of the translation will be three layers in SHP format (one line layer,
one point layer and one polygon layer).

If, for example, the input layer to which the translation is applied contains only points and
lines, the polygon .shp file will be created but it will be empty.

NB. At the end of this section there is a table giving details of the relationship between the
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type of input file and the resulting output layer.

9.12.2 Translating a vector layer

Firstly, load a vector layer in gvSIG and then click on the geoprocessing wizard in the tool
bar.

[«

Select the option “2D Translation” from the “Data Conversion” folder.

Click on the “Open Geoprocess” button and the geoprocess data input window opens.

For the input layer, select the vector layer (dgn, dxf, dwg, shp...) you wish to translate and
introduce the values corresponding to X and Y.

Select an output layer and click on “Ok”.

Herramientas de analisis

Traslacidn. Introduccion de datos:

Capa de entrada: cohs_punt.shp v|

MNumero de elementos seleccionados: 7

Yalores de desplazamiento.

Desplazamiento en X: |30 |
Desplazamiento en " |30 |
Capa de salida: |,fhome,fcamin0,fresuItadosg\rSIG,ftraslacion2D | |Se|ecci0nar|

| Areptar || Cancelar |

The following image shows the result of applying the translation process.
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=

5 Vista: Sin titulo - 1

= A traslacion2?D.shp
- Default
=[] M cons_punt.shp
= Default

i Aplicacion inicia i} 17886 [=lkilémetras = 0,09 fr = 0,07 [EPsCizz020

Relationship between the type of layer before and after translation.

Input layer

Output layer/s

Point Shp file Point Shp file
Multipoint Shp file Multipoint Shp file
Line Shp file Line Shp file
Polygon Shp file Polygon Shp file
Point Shp file
Dxf (points, lines, polygons) Line Shp file
Polygon Shp file
Point Shp file
Dgn (points, lines, polygons) Line Shp file
Polygon Shp file
Point Shp file
Dwg (points, lines, polygons) Line Shp file

Polygon Shp file
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9.13 Reprojection

9.13.1 Introduction

This geoprocess allows you to change the geodesic projection of the vector elements in
the input layer. In order to do so, the user must specify the new projection to be applied.

This process is extremely useful when standardising cartographies in the same project if
these are in different projections.

9.13.2 Reprojection of a layer

Click on the geoprocessing wizard in the tool bar and select the “Reproject” option from the
“Data conversion” folder.

'@ Gestor de geoprocesos

EM{E Ceoprocesos

--D Analisis Reproyecciom
=H5 Corversisn de datos ) )
D) Juntar Este geoproceso permite cambiar 1a proyeccidn geodésica de 1os elementos vectoriales de
) Trastacién 20 la capa de entrada. Para tal fin, el usuario debera especificar la nueva proyeccion a
aplicar

“[ Reproyectar

Este geoproceso puede ser de gran utilidad para hacer concordar cartografias en un
IS0 proyecto cartografias que se encuentran en proyecciones distintas.

Aprir Geoproceso | | cerrar |

Click on “Open geoprocess”. The wizard will open to guide you through the reprojection
process.

In “Input layer”, select the layer you wish to reproject from the layers loaded in the ToC.

To select the new projection for the layer, click on the button next to the destination
projection and select the new reference system.

© 2007 Conselleria de Infraestructuras y Transporte Page 339 of 409



gvSIG - User guide

s Herramientas de analisis =)

Reproveccidn. Introduccidn de datos

Capa de entrada: cans_punt.shp v|

Mimera de elementos seleccionados: 7
Proveccidn Actual: EPSC22020
Proveccion Destino EPSC:23031 | |

Capa de salida: |,fhome,fcamino,freproyeccion | |Se|ecci0nar|

| Areptar || Cancelar |

10 Maps

“Map” type documents allow you to design and combine all the elements you wish to have
on a printed map.

10.1 Accessing maps

You can access “Map” type documents via gvSIG's "Project manager".
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S|

ﬁ Project manager

rDocument types

Sy

W ies

Tables

rMaps

rSession properties

Sesgion name: Untitled
Saved in:

Creation date: ©Oct 5, 2006

Fropertias

Click on “New” to create a new map.

When you have created the document (it will appear by default as “Untitled— 0”), you will
be able to insert elements, rename the map, delete it or access its properties and modify
them. When the map is open, it will appear in gvSIG as shown below:
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File Show ‘Window ‘iew Map Help

OpEm= 2 X[Fd 00 /R EME-RBSCX@[e2E80 %%+ 150 BETHE & @ x|
#|

& Map: Untitled - 0 ¥ =

B0 T 775 F 7B F IO I I I T IS 16 1718, 1520 | 2T\ 22 2774|7526 | 27| 78] _

- D20 I I8 17 e I T I I T I s B 7 6 5 % 3 21 -

i Application started ICem\meters

10.2 Map properties

You can access the map properties window from the “Project manager” by clicking on the
“Properties” button or from the view by going to the “Map” menu and then to “Properties”.

L EEEEEEEEEREEEEEESSSSSs.
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& MEPIPTOPETTIES] b
Marre: Untitled - 0 |
Creation date: (10/5/06 3:13 PM |
Owyner: | |
Comments:

Haorizontal grid spacing: 0.25%
Vertical grid spacing: 0.25
[] Active gric Artivate ruler
Wisualize grid Editahle
Unidades: Cemtimeters

ok || cancel

You can use the properties window to rename the map, change its creation date, add an
owner and comments.

You can select some default characteristics by activating the corresponding check boxes:

Active grid: Activating the grid means that any element inserted in the map will be
adjusted to the grid. Remember the following two points if you enable “Active grid”:

1. The horizontal and vertical grid spacing defines the distance between the
different points which make up the grid. This can be modified by inserting
new values in the text boxes.

2. Output size of the chosen document (A2, A3, A4,...). The zoom tools may
need to be used to be able to view the grid when you open the document.

Visualise grid: If this box is disabled, the grid will not be viewed when you open the
newly created document.

Enable ruler: By enabling this check box a ruler appears which can be used as a
drawing aid.
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Editable: If you do not enable this option, the objects that make up the map will be
blocked, thus preventing modifications.

10.3 Preparing a page
You can use this tool to define the working area, i.e. the size and properties of the page to
be used for the map layout.

You can access this tool by clicking on the “Configure page” button in the tool bar or from
the menu bar by selecting the “Map” option and then “Prepare page”.

O

When you have selected the tool a new window will appear:

EIEpETEIpEgE

Page Size: |Same as printer

Measuring units |Centimeter5

Wit Height

Origrntation: Horizantal [ ]vertical

Margins: [ ] Custamize margins

Upper Left

Lower Fight

Eesolution of the result: |N|:|rrna| v|
ACCept | | Cancel |
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Page size: The pull-down menu allows you to define the source and size of the
paper to be used to print the map. You can select a standard size or define your
own.

Measuring units: You can select the units of measurement for the page Height and
Width.

Orientation: This defines whether the paper will be printed horizontally or vertically.

Margins: This allows you to define the page’s four margins. The ruler is adjusted to
fit in with the page margins.

Resolution of the result: You can choose between high, low and normal
resolution.

When you have finished configuring the page, click on the “Ok” button.

10.4

Inserting elements in a map

gvSIG can be used to add the following cartographic elements to a map:

Many
when

- Views

- Images

- Scale bars

- Legends

- Graphic objects
- North

- Texts

- Boxes

of these cartographic elements are closely linked to the “View” document, so that
changes are made in the view, they are shown in the map (changes in zooms,

panning, legend modifications, layer organisation, etc.).

You can access the different options from the tool bar or by going to the “Map” menu and
then to “Insert”.
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Map Help
Mawigation r s E S
Properties E
Edition b
Selection b
Y -
Mawegation in a wiew k| #® Paoint
Craphics b | ] Rectangle
=) 0 Circle
L /" Line
B commands stack Alt-K, 2\ palkdine
& Print [£ Palagon
Prepare page 5" mage
]ﬂ[ =0
= Legend
“ Scale
R Maorth
B2 Box

10.4.1 View

You can insert a view in the map by clicking on the “Insert View” button in the tool bar.
Place the mouse pointer on one of the vertexes of the rectangle which define the view
area, left click and drag the pointer to the opposite vertex and drop.

A dialogue box appears in which you can define the view-type element properties you
have just inserted.
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Wiy Untitled - 0
Artive link
srale Altarmatic v| Degrees:
1:
Extension -
W iewing — —
Quality \Presentation v |£| ° |£|

| ALcept | | Cancel |

View: You can use the text box to select the view you wish to insert, if there is more
than one.

Active link: If this check box is enabled, any changes made in the view (changing
colour, adding a layer...) will be shown in the map. Remember that scale changes
will not be affected by this check box, because these modifications are regulated by
the scale pull-down menu which appears below.

Scale: Select one of the following three scale types:

Automatic: If this option is chosen, any scale change made in the view will
automatically be shown on the map.

Keep visualisation scale: In this case, although you change the view frame in the
map, the layer associated with the view will not resize itself and will keep the
same size it has in the view.

User-defined: This option allows you to define a specific scale.
Quality: This defines the visualisation, as either presentation or draft quality.

Degrees: This allows you to specify a degree of rotation when the view is
inserted in the map. This option also appears in the rest of the elements that can
be inserted: images, scales, legends and texts.
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o
10.4.2 Legend

The legend represents the visible layers of the ToC in the selected view. If a legend is
inserted, it is added in the same order as it appears in the ToC.

ok Dropertieeo il By end framework x|

FFramewiew 0 Untitled - 0 riesgo_inundacion_2 Degrees:

Framewark of the. .. muni L0000, shp -

Wiewing
Cuality \Presentation -| |¥| 0 |?|

| Ok || Cancel | | Font | 4 |:;:;:;:;:;:;:;:;:;:;:;:; ¥

In the view frame, select the view the legend is associated with. The order in which the
legends in the ToC will be added appears in the panel on the right.

10.4.3 Scale

This tool allows you to insert a scale (associated with the view) in the map.

The scale bar dialogue box is shown below:
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Properties of the scale bar

~Framework of the view ~Scale rDegrees:

FFrame'iew 0: Untitled - 0 11:4062449 |
[ ] Showy numeric scale,

“Rar: []On the scale bar @ D @

(] Keep interval -Units:

( 1:100000 - [Merers -
numero_decimales_mostrar El Showe Lnits

Interval 108,654 [ on the scale bar

Mummber of Intervals Lables:

on the scale bar
Divizions to the left
- o]
Colar: .| | E]

- View frame: Select the view, if there is more than one, the inserted scale is related
fo.

- Bar: Select the type of scale you wish to insert (numeric or graphic). By clicking on
the pull-down menu, you can see the different options with which the scale to be
inserted in the map can be shown.

1:100000

- Intervals: Select the number of intervals, what each one represents and the
number of divisions to the left of the 0 that you require in the interval.

- Scale: You can use this section to make the numeric scale appear above the bar.

- Units: This defines the graphic scale units of measurement (metres, Km., etc.).
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Labels: You can use this box to select the label colour, font and location (numeric
scale, units...).

10.4.4 North symbol

If you click on the “Insert “North” button in the tool bar, you can insert a “North” symbol in
the map. Place the mouse pointer on one of the vertexes of the rectangle which define the
space to be occupied by the symbol, left click, then drag the pointer to the opposite
vertexes and drop. A dialogue box appears in which you can choose between several
default North symbols.

(u Propdrilag of luies frmaiiris %

I T I

]

q

Frarework of. FFrameyiew O Untitled - O

ACcept | | Cancel

You can add new symbols by copying them in the folder:
bin/gvSIG/extensiones/com.iver.cit.gvsig/northimages

of the folder you have installed gvSIG in.
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The acceptable format for North symbols is SVG (Scalable Vector Graphics).

To add a new North symbol you will need to use an external application (such as Inkscape
http://www.inkscape.org). Moreover, in order to ensure that the new North symbol will be
correctly processed by gvSIG, it is better to base it on one of the default symbols
suggested by gvSIG.

10.4.5 Box

gvSIG has a tool which allows you to insert a box in the map.

If you wish to insert a box, select the following button from the tool bar:

=

Left click on the map area you wish to insert the object in and drag it to create a frame
which will define the future box size.

When you drop it, a window will automatically appear for you to define some of the box
properties.

o BOXIPTOPETHES x|
Mumber of colum... Degrees:
Mumber of rows -
pr—— —_ e S
Arcept | Cancel |

10.4.6 Image
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You can use this tool to insert an image in the map. You can access this tool by clicking on

the “Insert image” button or by going to the “Map” menu bar, then to “Insert” and then to
“Image”.

If you activate this tool and create the frame to insert the image on the map (similar to
“Insert view”), the following dialogue box will appear:

Properties of Image framework

File | | | Browse | Degrees:
Cuality \Presentation ~|
Wiewing
| Accept | | Cancel | |¥| o |?|

If you click on the “Browse” button, you can select the file path of the image to be inserted.
You can insert an image in any of the following formats: jpeg, jpg, gif, png and bmp.

From gvSIG version 0.4 onwards, you can add vector files in SVG format to the map.

10.4.7 Texts
F

Texts, which can also be inserted by clicking on the corresponding button in the tool bar or
by selecting “Maps” then “Insert” and then “Text”, are defined in the following dialogue box.
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Align | I= || = || ol " Farit |-

[ | Resize the text 10 the wiew scale

[ ]Fant size
Frame
[]Use frame .
Border size Milimet...

Margins: Milimet...

Texx field title
[]Use title

pixels .

| Arcept | | Cancel |

Degrees:

You can write the text you wish to appear in the map in the text box.

Align: This can be used to select the alignment type (left, centred or right

respectively).

Font: This can be used to select the font type. You can also set the font size by
activating the corresponding check box and specifying the required size in the text

box.

Degrees: This defines the text slope, from the horizontal axis.

Frame: This allows you to define a border around the text you are using.

Text field title: You can also define a title for the corresponding border.

10.4.8 Graphics

You can insert the following types of graphic elements:
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« Points

- Rectangles

- Circles

- Lines

- Polylines
- Polygons

All these elements can be inserted by going to “Insert” in the “Map” menu or by clicking on
the corresponding button in the tool bar.

Map  Help
Mawigation L S ===
Properties
Edition b
Selection b
Mawegation in a wiew ¥ | & Paint
Sragphics ¥ | [] Rectangle
-+ ) Circle
= / Line
EH commands stack Alt-K 2\ pakdine
& Print [< Pokgaon
Prepare page U lmage
"if L=
= Legend
“ Srale
Rl rorth
B Box

If you wish to insert a graphic element, left click on the map in the place you wish the
graphic element to be inserted in.

June 2007

Page 354 of 409



Sl gl,
gvSIG — User guide ) 4

10.4.8.1 Editing graphic elements in a map
When you have inserted a graphic element, you can edit its vertexes.

You can access this tool by going to the "Map" menu, then to "Edit" and then to “Edit
vertexes” or from the following tool bar button.

®

If you wish to edit a vertex in a graphic element, select the element from the map and go to
the tool.

10.5 Undoing / Redoing

These tools allow you to undo actions you have taken on the map or redo the actions you
have previously undone.

You can access these tools by clicking on the “Undo” (left-facing arrow) or “Redo” (right-
facing arrow) buttons

or by going to the menu bar and selecting the “Map” option.

You can also undo several actions by using the command stack. This tool allows you to
view the actions you have carried out on the map and decide which point you wish to
continue working from. The advantage of this tool is that you can undo or redo several
actions at the same time. However, you cannot undo a specific action, i.e. if you take six
actions, you cannot undo just the fourth one. The sixth and the fifth action will also be
undone.

You can also access this tool by clicking on the command stack button in the tool bar

B
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or by going to the “Map” menu bar and then to “Command stack”.

10.6 Deleting a selection

You can delete any of the elements selected in the “Map” by clicking on the “Delete
selection” button in the tool bar.

X|

10.7 Map-inserted element properties
When the elements have been inserted in a map, you can access its properties.

Select the element. Right click to show its contextual menu and select "Properties".

|| | | ||
N
nWw
Properties
B i Select all

Place back
Bring to framnt

sizefposition

F.efresh

10.7.1 Aligning

You can access this tool by going to the “Map” menu, then to “Graphics” and to “Align”.

This tool can be used to modify the alignment, distribution and size of the map elements
selected.
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4 Align

Alignment:

&) a]a) [®fofu] neson

DISUASUIES -
m EEE | H
Matchsize  Spate:
EILEEE

In the layout: If this button is enabled, the tools in the "Align" menu will use the
map limits as a reference. If it is disabled, the selection will be used as the
reference.

Alignment: The tools in this section allow you to align the selected graphics (place
a series of objects on the same axis) according to your needs (left, horizontally
centred, right, top, vertically centred and bottom).

Distribution: This allows you to space out objects at equal distances over a
specific area.

Match size: This allows you to modify the size of a selected object, using another
object as a reference. The adjustments are made based on the largest object in the
selection.

The object sizes can be made to coincide in width, height or both.
Space: This allows the selected elements to be “spatially distributed”.

If, for example, you decide to spatially distribute two selected elements in the map
(using the active "In the layout" button), the objects will be moved to the same
distance from the map’s left and right-hand margins when you click on the first
option.

If we click on the second button, the images will be moved to the same distance
from the top and bottom margins.

10.7.2 Grouping / Ungrouping

You can access this tool from the tool bar by clicking on the buttons
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or by going to the “Map” menu, then to “Graphics” and to “Group” or “Ungroup”.

10.7.3 Simplifying the legend

When a legend has been inserted and selected in a map, this option can be accessed by
going to the “Map” menu, then to “Graphics” and to “Simplify legend” or from the contextual
menu (right click on the selected element) by selecting “Simplify legend”.

| | |
Port Saplaya.dxf
O 1
Properties
[ =
- Select all
L= Place back
[ =

Bring to front
Ow=

[ =
m Simplify legend

siZefosition

Fefresh

When the legend has been simplified, it loses its link to the view. This means that any
modifications made in the gvSIG view will not affect the legend.

If you wish to group the legend again, select the "Group graphics" option.

10.7.4 Viewing order

You can access this tool by going to the “Map” menu then to “Graphics” and then to “Bring
to front” or “Send to back” respectively or from the tool bar by clicking on the following
buttons:
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T

You can use this option to change the viewing order of the selected elements in the map
by bringing them to the front or sending them to the back.

10.7.5 Graphic line
This tool draws a frame around a selected element or elements.

You can access this tool from the tool bar by clicking on the following button

or by going to the “Map” menu and then to “Graphics” and "Graphic line".
The available options are shown in the following dialogue box:

Gir eezinille [la saeilee)s %

(2) Place around the graphics selected.

() Place around all the graphics.

() Place with reference ta margins.

[ ] Group graphic line with graphics
Position of the line

Equal displacement for all sides.
M agp units
pper Left Conti
Lower Right entimetars
Configure | | Accept | | Cancel

The different options include a check box which allows you to group the graphic line and
the object you have inserted in the map so that they make one single element and not two
separate ones.
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If you click on the “Configure” button, another dialogue box appears which can be used to
define the properties of the graphic line or frame to be inserted. Select the properties and
click on the “Ok” button if you wish to use the new configuration or "Cancel" if you wish to
maintain the default values.

o erzigiile urogaridas £
L Fill: —
L Fill:
[¥] Line S
[ ]stroke:

[ sincronize colar of stroke and fill;

Line width: ?TH‘O 1 Degrees:
Transparency -
(&l [

Arcept Cancel ‘

10.7.6 Size and position

You can access this tool by going to the tool bar and clicking on the following button
i

or by going to the “Map” menu then to “Graphics” and to “Size/Position”.

This tool opens a dialogue box which allows you to specify the size and position of the
selected element.
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Units: Centimeters
Page size

29,7 Height j 21 Width

From left:
From top:
wictth:
Height:
| Arcept | | Cancel |

You can edit the different text fields and modify and specify the object’s size and position.

10.8 Tools for navigating in a map

You can use these tools to move around and zoom in and out of the maps page.
H GRSV ST R

You can access the tool from the tool bar or by going to the “Map” menu and then to
“Navigation”.

- Zoom in: This allows you to zoom into the page.

I Y Zoom out: This allows you to zoom out of the page.

_ Panning (Frame): This allows you to move the map page.

5 Full extent: This carries out a full zoom of the page.

- Scale 1:1 zoom: This carries out a “real” size zoom of the configured page.
4
- % Zoom in: This zooms into the centre of the page.

_ X Zoom out: This zooms away from the centre of the page.
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10.9 Exploring the view of the map

S
There are several tools you can use to navigate around the view
Zoom in: Enlarges a particular area of the view.
oy
Zoom out: Reduces a particular area of the view.
oy
Full extent: Full zoom of the total area included in all the layers of the view.
=

Panning: This allows you to change the view zoom by dragging the viewing field all over
the view with the mouse. Click and hold down the left button of the mouse then move the
mouse in the direction you require.

T

10.10 Templates

10.10.1 Saving templates

gvSIG allows the configuration of a map to be saved as a template. This can then be used
at a later date with different data sources.

The element distribution and properties from a map can be saved.
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If you click on the “File” menu then on “Save as template

File  Show  Window  Wiew

D Mewy project
= Open project
Q Save project

Q Save as...

Alt-N
Alt-A
Alt-i

@ Export to pdf
E Export to ps
&l open template

B cave as template

SCripting

| Exit

Alt-X
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a dialogue box appears so you can save your .gvt file which can be recovered at a later
date and will allow you to reconstruct the map configuration.

o SEVES [2]]

Fave In: |EI Documentos v| |§| |§| |§| |£|E

3 qElG-praject
@ comvergenciaMeridianos, gwt

File Marme: |cnmrergenciaMeridianns_gm |

Files of Type: | template -/

| Sawe || Cancel |

10.10.2 Open template

If you wish to retrieve a saved template to use it in a new project, go to the "File" menu and
then to "Open template".
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File  Show  Window  Wiew

D Mews project Alt-N
F= Open project Alt-f
Q Save project Alt-1
Q Save as...

@ Export to pdf
E Export to ps

=1 Jpen template

Q Save as template

Scripting

| Exit Alt-¥

10.11  Printing

=

This option opens the printing dialogue box from which you can select the printing options
(selecting printer, quality, etc.).
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b Prins X
General \\ Page Setup \éppearance \

Print Service

Mame: |camino 2

Status: Mot accepting jobs

Tywpe:
Infa: [ ] Print Ta File
Print Range Copies
(3) All Mumber of copies: E
() Pages

| Print | | cancel |

N.B.: The specifications which are not enabled depend on the type of printer installed.

10.12 Tools for exporting to postScript and pdf

You can use these tools to export a layout to a postScript and/or pdf file by going to the
"File" menu and then selecting "Export to ps" or "Export to pdf* respectively

June 2007 Page 366 of 409



gvSIG — User guide J
S|

File  show  Window  Wiew

D Mew project Alt-N
| B> open project Alt-d

Q Sawe project Alt-G

Q Sawe as...

@ Export 1o pdf

3 Export to ps

&l open template
Q Sawve as template

SCripting ]

| Exit At

or by clicking on the following buttons in the tool bar:

]

-
-

1
!

[

This opens a dialogue box in which you are asked to specify a file to save the resulting
postscript file (with the .ps extension) or pdf file (with the .pdf extension). When you have
selected where you wish to save the document, click on “Save”.
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11 geoDB Extension (database manager)

This extension allows users easy, standardised access to geographic databases from
different providers. At present, gvSIG supports the following database management
systems:

- PostGIS

- MySQL

- HSQLDB

- Oracle Spatial (SDO Geometry)

gvSIG stores the different connections made during the various sessions. Thus, users do
not need to input the parameters of every server they connect to. Likewise, if a project file
is opened which has a database connection, the user will only be required to enter the
password.

The extension has two user interfaces, one to manage the data sources and another to
add the layers to the view.

11.1 The spatial database connection manager

Select the menu See — Spatial database connection manager (figure 1) to open the
dialogue box which allows you to add, remove, connect and disconnect the connections to
the different types of databases containing geographic information. If you have already
used this manager in an earlier gvSIG session, the previous connections will appear
(figure 2). If not, the dialogue box will be empty.
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Tipos

Gestor de conexiones a BD espacdiales

Gestor de proyectos

Alt-=
Alt-a

Alt-P

Tahla

r
X

Gestor de conexiones a BD espaciales

X

[ Conexiones a BD espaciales
[=}-( Oracle Spatial Database Driver

------ D pepito {Oracle Spatial Database Driver)

Figure 1. Access to the geoDB connection

manager

| Afiadic | | Quikar l |

Modificar |

[ Conectar | | Desconectar | |

Aceptar |

Click on Add to introduce the parameters of a new connection (figure 3).

Figure 2. The connection manager

NB: From gvSIG version 1.1 onwards, it should be noted that the name of the database
must be written correctly and that it is case sensitive. If you wish to open a project saved in
a version prior to gvSIG 1.1 which includes layers belonging to a database whose
connections have not taken this factor into consideration, the data must be recovered by

reconnecting to the original data base.

You can either connect there and then or remain offline. Open connections appear with a
link and with “[C]” before their name (figure 4). If you wish to open a connection, select it
and click on Connect. You will be asked to enter the password (figure 5) and the

connection will then be made.
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Gestor de conexiones a BD espaciales

[= Conexiones a BD espaciales
=123 Oracle Spatial Database Driver
D [Z] pepito (Cracle Spatial Database Driver)

Parametros de la conexion

Parametros de la conexidn

Mombre de la conexidn: |

Driver: |PostGIS JDEC Driver Vl

URL del servidor: | | [}g
Puerta: [5432 |

Nombre de BD: | |

Usuario: | |

Contrasefia; | |

Conectar:

| Aceptar | | Cancelar | | Afiadir | | Quitar | | Modificar |

| Conectar | | Desconectar | | Acepkar |

Figure 3. Adding a new connection Figure 4. The connection has been made

Enter Password rz|

Esta intentando conectar a la base de datos
cuyos parametros son [Dracle Spatial
Database Driver, spain, 1521, asdh, spatial].
Contrasefia?

[ R

Figure 5. Password request

11.2 Adding a geoDB layer to the view

In the Project Manager, create a new view and open it using the New and Open buttons.
Use the Add layer icon to add a layer to the view. Go to the GeoDB tab in the dialogue box
to add a new layer of this type (figure 6).

You must choose a connection (if you select one which is disconnected, you will then be
asked to enter the password), select one or more tables and the attributes you wish to
download from each layer and, optionally, set an alphanumeric restriction and an area of
interest. You can give each layer a different name to that of the table. Click on Ok to view
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the table’s geometries in the view.

This window also allows you to specify a new connection if the database is not registered
in the data source catalogue.

Any alphanumeric restriction must be introduced by means of a valid SQL expression
which is attached as a WHERE clause to each call to the database.

Given that the table may take several seconds to load, a small icon appears next to the
name of the table indicating that this process is underway. When the table has been
loaded, the small blue icon disappears and the gvSIG view is automatically refreshed to
allow the geometries to be viewed.

Anadir capa E|
Archivo | Georreferenciar© GEOBD | WS ', WS |, WICS | ArcIMS |

Elija conexién

|[] pepito (oracle Spatisl Datshass Driver) -] | &
Elija tabla table_fields
ID [MUMBER] -
COUNTY [WARCHARZ] _ e Velww Wi T v
O [¥] FIPSSTEO [WARCHARZ] TaRXE N oLA i rNadelvox B O 6@ TONXIBAHOSE (AREOE oD
[]us_Parks STATE [YARCHARZ] b
7] US_RESTALRANTS [ ] STATE_ABRY [WARCHARZ] g
[]uS_RIVERS L D
S STATES LANDSGMI [NUMEER]
[vacta TOTPOP [NUMBER] —
[ ] WORLD_COMTIMENTS = ———
WORLD_COUNTRIES -~ Todos | tinguna

Especificacion de la capa

Mombre de la capa |US_COUNTIES |

Campo con [0 ‘ROWID V‘ Carmpa con geometria | GEOM -

[] Restricrion 5L

[ Zonadeinterés | Capturar vista |

yrEK ymin Kmax ®min

| I | | I |
| Acep E ‘ Cancelar |

Figure 7. Views with geometries from a

Figure 6. Adding a geoDB layer geographic database
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Figure 8. Mini icon showing layers are
loading

11.3 Exporting a gvSIG layer to a spatial database

This function allows new tables to be created in the spatial database from any vectorial
source in gvSIG. These tables can be created as follows:

3.

4.

Create a vectorial layer of any type, for instance by opening an sHP file using the
Add layer button (figure 9).

Select the layer by clicking on its name in the left-hand side of the screen (figure
10).

In the Layer — Export to menu, select the type of database you wish to export the
layer to. The example shows an Oracle database (figure 11).

You will then be asked to introduce the name of the table which will be created in
the database (Oracle) and whether or not you wish to include the newly-created
layer in the current view.

If all goes well, the new vectorial geoDB layer will appear in the view and you will be able
to work with it in the usual way.
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Figure 9. Adding a vectorial layer
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Figure 10. Selecting the layer to export
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Figure 11. Exporting to Oracle Spatial

PostGIS
GML

O Oracle Spatial

11.4 Oracle Spatial

Exportando funcionalidades

Exportando 26 geometrias

|

Figure 12. Export progress bar

These notes supplement the documentation for the geoDB extension with regard to the

driver for Oracle Spatial.

This driver allows access to any table from an installation of both Oracle Spatial and
Oracle Locator (in both cases from version 9i onwards) which has a column that stores

SDO-type geometries.
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11.4.1 Metadata

The driver only lists tables which have their geographic metadata in the
USER_SDO_GEOM_METADATA view.

Given that each table’s metadata is available, the interface makes use of that data and
automatically presents the column (or columns) of geometries. Likewise, ROWID, which is
a unique descriptor for each row used internally by Oracle, is used and this ensures that
identification is correct.

11.4.2 Data types
Two and three-dimensional data of the following types are supported:

8. Point and multipoint

9. Line and multiline

10. Polygon and multipolygon
11. Collection

At present, layers in LRS format (Linear Referencing System) are not supported.

11.4.3 Coordinate systems in Oracle

Oracle has its own system for cataloguing coordinate and reference systems. Miguel Angel
Manso, on behalf of the Polytechnic University of Madrid, has provided a list of equivalent
values for the Oracle system and the EPSG system and this is included in the driver as a
DBF file.

Conversions from one coordinate system to another are carried out by gvSIG since its
performance has proved to be superior.

11.4.4 Notes on reading geometries

The driver constantly performs geometric requests (in other words constantly calculates
which geometries intersect with the current gvSIG view) and it is therefore essential that
the database has a spatial index linked to the column in question. If this index does not
exist, an error window appears (figure 1) and the table or view cannot be added to the
gvSIG view.

In addition, the driver needs to set a unique identifier for the records of the table or view,
and this is not possible for certain types of views. If such a problem occurs, it will be
detected by the driver and an error message will also appear (figure 2). As a result, the
view cannot be loaded to gvSIG from the database.
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Error, con los campos geométricos

Hubo un problema al obtener campos con geometrias validos:
Mo se han encontrado indices espaciales para los campos geomeétricos de la tabla: LLEIDA.NTC_AUTOSYVC

| Sceptar | %

Figure 1. Warning regarding the lack of a spatial index

Error con ID

Hubo un error al obtener ID de la tabla PORTOS_ESPTIGOM_GIS. AUTORIZACION _GEOM_SELECCION:
ORA-01445: no se puede seleccionar ROWID desde una vista de la unidn sin una tabla protegida por claves

| Aceptar | %

Figure 2. Warning regarding the fact that a ROWID could not be obtained

11.4.5 Transferring a layer from gvSIG to Oracle

If you wish to export a layer to an Oracle database, you will also be asked if you wish to
include the view’s current coordinate system in the table at the end of the process
described in the manual. This may be useful in cases where we do not wish to include
such information in the table for reasons of compatibility with other applications or
information systems.

To work with two Oracle geometries (the most common case is an intersection), the two
geometries must have the same coordinate system. Each geometry has an SRID field
which can have the value NULL.

For instance, if we have a table with geometries in EPSG:4326 (Oracle code 8307) and
another with geometries in EPSG:4230 (Oracle code 8223), it will not be possible to carry
out SQL instructions to perform calculations directly between the geometries of one table
and another. However, if these tables’ geometries do not have a coordinate system (i.e.
SRID is NULL), then operations can be performed between the geometries of these tables,
bearing in mind the errors involved in carrying out intersections between different
coordinate systems.

When reading a table whose geometries have a coordinate system set at NULL, it is
understood that the user will make sure that the geometries are appropriate for the current
view, since no reprojection is possible (this may change with the new gvSIG extension for
the advanced use of coordinate systems).

In short, not storing the coordinate system allows for a more flexible use of geometries.
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12 JCRS Extension (Coordinate Reference System
management)

12.1 Introduction

The JCRS extension aims to enable gvSIG to accurately manage Coordinate Reference
Systems and coordinate operations. In addition, information has been incorporated
regarding standard CRS repositories and operations, such as EPSG and IAU2000, which
are the only ones available in this initial version.

These additions provide a solution to the problem of the ED50 — ETRS89 transition.
Furthermore, the two official IGN solutions have also been included:

- Through the EPSG, the various official IGN solutions concerning seven-parameter
transformations have been introduced.

- Through Proj4, the official IGN transformation has been incorporated with a NTv2 grid
file.

Selecting a view’s default CRS

In gvSIG, the CRS associated with a view by default can be determined when the view is
created. To do so, open the gvSIG preferences dialogue box from the
“Window/Preferences” menu or click on the corresponding button in the tool bar:

~

Select the “View” menu from the pull-down tree menu on the left-hand side of the window.
The following window appears:
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Mapa Vista
LoWista
Proveccion por defecto: EP5G 23030
[] Afiadir nuevas capas en modo invisiole
[ Mantener escala al redimensionar
Factor zoom mas; 2.0
Factar zoom rmenos: 05
Color de fondo de la wvista por defecto E
Color de la seleccidn por defecto E
Uniclades de mapa ’Metros v]
Unidaces de medida Metros ~|
[ restare_defaults l [,d\ceptar] [ Cancelar]

Figure 1. View preferences

In the “Default project” section, clicking on the “Change” button will open the dialogue box
to search for and select CRSs:
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Nuevo CRS =

Seleccione CRS de la vista

Tipn: Fecientes -

Fecientes
EPSIC

Ultimos CES= utilizados: IALZ 000

Coordinate Reference Systems

Fuente Codigo | Mombre
EPSG 23821 ETESE9/UTMzones 1M
EPSG 32246 WOSE4/5CARIMWES16-18
ALZ000 30110 Moon_Equidistant_Cyindrical
[AZ2000 61100 Epimetheus2 000
EPSG 23820 ETESES/UTMzoneZ 0N
EPSG 4220 EDE0

Cancelar | ‘ ArCeptar

Figure 2. Selecting the CRS. Recent CRSs

This box allows you to choose between three possible CRS repositories:

7. Recent: The CRSs which have been used previously are displayed (Figure 2). The
list of recent CRSs is available during current and future gvSIG sessions but it is not
associated with any particular project.

8. EPSG: This allows CRSs to be searched for and selected from the EPSG database
(European Petroleum Survey Group).
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Nuevo CRS =

Seleccione CRS de la vista

Tipn: EP5G -

Criterio e blsgue... () Por cddigo (2) Par nomkbre () Par area

| Buscar | |ETRS| | | Info CRS

Coordinate Reference Systems

Cédigo| Mombre Tipo Area |
2176 ETRESE% j Poland ... projected Paoland - Waof 16.5 ... Poland - west of &
2177 ETRESE% j Poland ... projected Poland - 16.5 to 13, Poland - betwed::
2178 ETRS8% j Poland ... projected Poland - 19.5% to 22, Poland - betwe
21749  ETRES8% j Poland ... projected Poland - Eof 22.5 d... Poland - east o

21|8 ETESE% j Poland ... projected  Poland Foland - Dnslhn B
4] i 3

| Cancelar | ‘ ArCeptar |

Figure 3: EPSG Repository

In order to perform a search, write the name of the CRS you wish to find in the
corresponding text box. The following search criteria can be used:

12. EPSG Code (e.g. 4230)
13. CRS name (e.g. ETRS89)
14. Area of application (e.g. Spain)
To change the search criteria, select the corresponding check box.

The “CRS Info” button provides detailed information about the CRS selected in the table at
that time.
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: ETRSBB!PoIandCSZDDDzoneS__;_L

”

Projcs: ETRSG9/PolandCS2000zaneS  Geoges: ETRSE4
Datum: EuropeanTerrestrialReferenc... spheriod: GRS1980, B378137.0, 298257222101
Primiem: Greenwich , 0.0 Unidades: DecimalDegree , 0.017453292519943295
Proyeccidn: Transverse_Mercator Unidades_p: Meter, 1.0
Mombre Walor
latitude_of __origin 0.0
central_meridian 14.55555555555558¢
scale_factor 09959523
false_easting 55000000
false_northing Q.0

Aceptar

13.1AU2000: This allows the user to search for and select CRSs from the 1AU2000

database. Clicking on the corresponding check box allows searches to be made “By
code” or “By name”.

Seleccione CRS de la vista
Tipo:  |IAL2000 ~|
Criterio de bidsgueda () Par codiga (3) Par nombre

Buscar | [mars |

1AU2000
Chdign | Marmbre |Prwe...| Daturm
49900 Mars 2000 Mo D_Mars_2000
49901 Mars 2000 Mo D _Mars_2000
459910 Mars_Equidistant_Cyindrical si D_Mars_Z2000
459911 Mars_Equidistant_Cydindrical si D_Marz_Z000
44512 Mars_Equidistant_Cyindrical si D_Mars_2000
449513 Mars_Equidistant_Cyindrical si O _Mars_2000
Cancelar || ALeprar

Fiqure 4. IAU2000 Repository.
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12.2 Setting a view’s CRS

In order to set the CRS associated with a view, select the view in the gvSIG Project
Manager and click on “Properties”.

@ Gestor de proyectos

rTipos de documentos

YWista Tahla Mapa

rVista

Sin titulo - O

Muewn
Abrir
Renombrar
Barrar

Propiedades

~Propiedades de la sesidn

Mombre de la sesign:  Sin titulo
Cuardada en:
Fecha de creacian; 12 -feb-2007

Fropiedades

Figure 5. gvSIG Project Manager
In the “View properties” box, click on the “Current projection” button.

L EEEEEEEEEREEEEEESSSSSs.
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@ Propiedades de la vista

MHarmbre:
Fecha de creacidn:
Propietaria:

Unidades de mapa:

Unidades de medida:

(Sin titulo - © |

[12/02/07 10:13 |

[Metros v]

[Metrus v]

S|

Proveccidn actual EPSG 22030 :]

Comentarios:

Color de fondo:

L ]

l Areptar H Cancelar l

Figure 6. View properties

The CRS search box will open.

L. Nuevo CRS

rSeleccione CRS de la vista

Uhtimos CRSs utilizados

EPSTC
LAL2000

Fuente | Cadiga | Mambre
EPSGC 25831 ETRS89/UTMzonez 1M
EPSGC 3246 WCSEASCARIMWES16-18

Coordinate Reference Systems

JALZ000 20110 Moon_Eguidistant_Clindrical
lAUZ000 61100 Epimetheus2000
EP5C 25830 ETRZ89/UTMzonez 0N

EPSC 4230 EDZ0

I Cancelar ] [ Areptar

Figure 7. Selecting the CRS
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12.3 Selecting the CRS associated with a layer

A layer’'s CRS can be selected when the layer is added to the view. In the “Add layer” text
box, click on “Current projection”.
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o Anadir capa =

Archivo |
~Capas
Hojas_area. shp
| Eliminar |
| Ariba |
| Apajao |
Froveccion actual  EPSG23030 E
ACeptar ” Cancelar

Figure 8. Adding a layer

A box will open which is similar to the one used to select the view’s CRS, the difference
being that there is a pull-down menu to select the transformation to be applied when
reproducing the layer on the view (if this is required).
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iy Selecciona sistema de referencia -

rSeleccione CRS de la capa

Ultirnos CRSs utilizados:

rCoordinate Reference Systems

IALZ000 30110
1ALIZ2000 61100

Fuente Cadigo | Mombre
EFSC 25831 ETR=E3/UTMzanes 1k
EFSC 2246 WoEEd ST ARIMWST16- 18

Moon_Equidistant _Cdindrical
Epimetheus 2000

EPSC 25830 ETRSEBSJUTMzonez orM
EPSC 42320 EDS0
Seleccione Transforrmacidn: Sin Transformacian -

Transformaciones Recientes

Transformacian EPSG ior H

Finalizar

Transformacion Manual
F.ejillas

Figure 9. Selecting the layer's CRS
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12.4 Transformations

Changing a layer’s reference system requires a conversion or transformation operation, or
a conversion and transformation operation:

A coordinate conversion operation is applied when the layers CRS datum
coincides with the view's CRS datum. In other words, both CRSs correspond to the
same geodesic reference system but use different coordinate systems.

In this case, the “No transformation” option would be selected.

A coordinate transformation operation is applied when the layer's CRS datum
does not coincide with the view’s CRS datum. In this case, two types of coordinate
operations can be carried out:

o The operation may only involve a transformation operation. This is the case
when the layer's CRS coordinate system coincides with the view’'s CRS
coordinate system, that is to say that the position is expressed in the same
coordinate system in both CRSs but using different datum.

o The operation may require a joint transformation and conversion operation
because neither the datum nor the coordinate system of the layer's CRS and the
view’s CRS coincide.

If such a transformation operation is required, select the type of transformation in the
layer's CRS’ selection box and click on “Next’. This opens the corresponding
transformation panel. There are three types of transformations: “EPSG transformation”,
“Manual transformation” and “Transformation by grid file”.

12.4.1 EPSG Transformation

These are the official seven-parameter transformation operations defined in the EPSG
repository and are used when the view’s and the layer’s CRS belong to this repository.

The panel for this type of transformation shows the transformations which can be applied.
The source CRS is taken to be the one chosen for the layer and the target CRS is the one
set in the view.
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s Selecclona sistema de referendia =)

Transformacion EPSG

Transformaciones

Cad...|Mombre de la Transfnrm...lTipD de la | CRS...| CRS...| Descripeion del Ar

1588 EDS0 to ETESES (1) transforma... 4258 4230 Monway - offshore nol = |
1626 EDS0 to ETRSES (4) transfarma... 4258 4220 Denmark - onshore al::
1628 EDS0 to ETESES (5) transforma... 4258 4230 Gibraltar - onshore
1620 EDS0 to ETRSES (8) transfarma... 4258 4230 Spain - Balearic Isla

1632 EDS0 1o ETRRES (7 transforma... 4258 4230 Spain - mainland ex

1624 EDS0to ETESES (B) transforma... 4258 42320 3pain - narthwest in

1650 EDS0 to ETRSES (10) transforma... 4258 4230 France - onshore an

EDS 0 to ETRESES (4 transforma... 4258 42320 Turkey - anshaore Tnc:
] 3

Cancelar | | Anterior | | Finalizar

Figure 10. EPSG Transformation

It must be taken into account that transformation operations of this kind are always carried
out on base CRSs, that is to say non-projected CRSs. Consequently, if the CRS of the
view or the layer is projected, the corresponding CRS base will appear in the CRS source
and CRS target fields.

12.4.2 Manual Transformation

In this case, the transformation operation is defined by introducing seven parameters; the

translation of “x”, “y”, “z”, the rotation of “x”, “y”, “z” and the scale.
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{7 Selecciona sistema de referencia__

Transformacidn Manual

Translacionenx: [0 | [-1000.0, 1000.0]
Translacioneny, [0 | [-1000.0, 1000.0]
Translacionenz: [0 | [-1000.0, 1000.0]
Rotacion en i e [-60.0, 60.0]
Rotacion en y. o ] [-600,60.0)
Rotacion en z: e [-60.0, 60.0]
Escala e [-200,20.0]

ancelar || Anterior

12.4.3 Transformation by grid file
This involves carrying out a transformation operation based on an NTv2 grid file.

Select the file you wish to use from the ones available by clicking on the “Nadgrids file”
pull-down menu. If you wish to use any other NTv2 file, it must first be imported. To import
a “nadgrids” file, click on the “Import .gsb” button. This then opens the list of files which
can be used for the transformation.

Grid files are calculated for a specific CRS and this data must be provided by checking one
of the two options under the “Grid file calculated on:” label.

NB: A grid file has a specific area of application which can be seen in the information
about this file in the transformation panel. No transformations are performed outside this
area. As a result, the reprojection is considerably less accurate as it simply carries out the
corresponding conversion operation between coordinate systems.
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Selecciona sistema de referencia

+Rejillas

Importar .gsh: ladl

Fichero nadgrids: |spedzet.gsb

Fichero rejilla calculadn en:

(3) CRS de la capa (EPSG: 2583 1) () CRS de la wista (EPS5:2 30300

(& Crids en: sped2et.gsh
E-E0 PEM+BAL
-0 BALE

IMPORTANTE: La transformacian se aplicara dentro de oz limites de las rejillas.

Cancelar | | Arterior | | Finalizar

Finure 12. Transformation bv arid file

. Recent transformations

This function allows a previously-used transformation to be selected. The list of

recent transformations is available in current and subsequent gvSIG sessions and is
not linked to a specific project.
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1 Selecciona sistema de referencia___-'

Transformaciones Recientes

| Informacin de la transformaci. . |

Transformaciones

transforma. .. MNombre | CRS5 fuente | CRS destin0| Detalles
EPSC:1622  EDSO to ETESES (7) EPSG 25820 EPSGI232020 Spain - mainland excep
UsR:0 manual EPSGI25830 EPSGI22030 [10,100,500,50,0,10,4
MNADGRIO  ——-- EPSCI25820 EPSLI22020 sped2et.gsh (EPSCI2E

EPSC:1588 EDSO to ETESES (1) EPSG 25830 EPSG:230320 Morway - offshore nort

4]

Cancelar || Anterior || Finalizar

Fiqure 13. Recent transformations

13 Scripting extension

gvSiG has an extension which allows you to create your own scripts in different
programming languages, such as Jython, javascript, beanShell or groovy.

Jython is an implementation of the high-level, object-oriented language Python written in
Java, and integrated with the Java platform. It allows you to run Python on any Java
platform.

BeanShell is an object-oriented Java source code interpreter with script utilities. It
executes standard Java expressions and statements as well as scripting commands and
syntax.

Groovy is a powerful language for the Java virtual machine which compiles Java byte
code and implements several high-level utilities for Java developers.

A scripting extension tutorial is available in www.gvsig.org.
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13.1 Jython console

gvSIG includes a command console for Jython language which can be accessed by going
to the "File" menu bar, then to "Scripting" and “Jython console".

-Shnw Lawer Wincdow  Yiew Help

[ ] Mew project At B
S Open project  Alt-A
E Save project Alt-G

E Save as...

& Open template

4] Exit Flit [Consala_de_jythaon_tooltip |
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Anexos

1 Icons and cursors in gvSIG

1.1 Icons which appear in the ToC (Table of contents)

The following table shows the icons which appear in the ToC to the left of the name and
which vary depending on the type of layer.

Original Name Icon Description
. A generic icon for a layer which does not have its own
icon-layer F | icon

icon-layer-group An icon for a group of layers in the ToC.

icon-layer-vect.shp An icon used by default for a vector layer.

icon-layer-wms An icon used for WMS layers in the OGC service.

icon-layer-wfs An icon used for WFS layers in the OGC service.

EECIE

icon-layer-raster An icon used for raster layers.

1.2 Cursors

These cursors are used by the application depending on the tool which is enabled at that
time.

Original Name Icon Description
. . L] A cursor used when the information request tool is
cursor-query-information +
selected.
cursor-zoom-in +Q A cursor which appears when zooming in.
cursor-zoom-out ey A cursor which appears when zooming out.
cursor-hyperlink +:'E A cursor used for the hyperlink tool.
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cursor-insert-polygon

A cursor used by the insert polygon tool in an editing
session.

cursor-insert-rectangle

A cursor used by the insert rectangle tool in an editing
session.

cursor-pan

A cursor which appears when panning is allowed.

cursor-query-area

A cursor used by the area measuring tool.

cursor-query-distance

IR A

A cursor used by the distance measuring tool.

cursor-select-by-rectangle

K

A cursor which appears when selecting by rectangle.

cursor-select-point

A cursor used to make a point selection.

1.3 Actions

Icons which appear in the tool bar or in the application menus.

Original Name Name in gvSIG Icon |Description
application-console Information console This displays the application’s error console.
application-exit Exit ]| This closes the application.
application-preferences |Preferences 7> ggl?) guili%ljys the  application's  preferences
edit-copy Copy Ep This copies documents
edit-cut Cut ok This cuts documents.
edit-delete Delete ] This deletes documents.
edit-paste Paste FE) This pastes documents.
edit-redo Redo @ This redoes an action.
edit-undo Undo @ This undoes another action
document-print Print =) ggli gsgok\)/\(/; | access to the print configuration
project-new Create a new Project 0 This creates a new blank project.

. I . This shows the “Open” dialogue box which allows
project-open Open an existing project = an existing project to be located.
project-save-as Save as =) This saves the changes made to a project.
project-save Save project E This saves the changes made to a project.
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This shows the dialogue box to add layers to a

+
layer-add Add layer = view.
layer-show-attribute-table |See table EE l'l;r;:rshows the table of attributes of the selected
edition-command-stack |Command stack FEH Th.'s.’ shows. the command stack window of an
editing session.

. . . This activates the complex selection tools on a
edition-complex-selection | Complex selection 3 view
edition-geometry-copy  |Copy = This makes a copy of the selected element.
Sg:’if;-geometry-edlt- Edit vertex £ This allows a geometry vertex to be edited.
edition-geometry-insert- |, . This allows a line to be inserted in a line layer
. Line ~ . .
line editing session.
edition-geometry-move |Move b This moves the selected geometries.
edition-geometry-rotate  |Rotate O This allows the selected geometries to be rotated.

. This scales (reduces or increases) the selected
edition-geometry-scale [Scale B :

geometries.
edition-geometry-select |Select k This selects a geometry
edition-geometry- . .
symmetry Symmetry Alts This divides a geometry symmetrically.
:?étlon-msert-geometry- Arc This activates the tool to insert an arc in the layer.
sic:gllgn-msert-geometry- Circle This activates the tool to insert a circle in the layer.
ed_ltlon-lnsert-geometry- Ellipse & This activates the tool to insert an ellipse in the
ellipse layer.
edition-insert-geometry- . . This activates the tool to insert points in a
o Multipoint R ..

multipoint multipoint geometry.
Sg:g?n-msert-geometry- Point . This activates the point insertion tool.
edition-insert-geometry- Polygon . This activates the polygon insertion tool.
polygon
edition-insert-geometry- Polyline rd This activates the tool to insert a polyline.
polyline
edition-insert-geometry- Rectangle [Tl |This activates the rectangle insertion tool.
rectangle
edition-modify-geometry- Y This allows a polygon to be extracted from a
internalpolygon closed geometry.
Maps
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layout-add-border Graphic line 1 This adds a border to the map.
layout-bring-to-front Bring to front L This puts the selected element in front of other
elements.
layout-clear-selection Clear selection X This eliminates the selected element.
layout-command-stack  |Command stack :ZE] This displays the map’s command stack window.
. . This allows vertexes of graphic elements inserted
layout-edit-vertex Edit vertex % in the map to be edited.
layout-export-pdf Export pdf FDF This exports the map to pdf format.
layout-export-ps Export ps s, This exports the map to postscript format.
. pe This groups together the selected elements of the
layout-group Group graphics il map
layout-insert-box Insert box = This inserts a box in the map.
layout-insert-circle Circle @] This inserts a circle in the map.
layout-insert-image Insert image :E" This inserts an image in the map.
layout-insert-legend Insert legend = This adds the view legend to the map.
layout-insert-line Insert line s This tool allows a line to be added to the map.
layout-insert-north Insert north M Adds the element “North” to the map.
layout-insert-point Insert point i* This tool allows a point to be inserted in the map.
layout-insert-polygon Insert polygon < 'In']k;; tool allows a polygon to be inserted in the
. . . This tool allows a polyline to be inserted in the
layout-insert-polyline Insert polyline < map
. - This tool allows the view scalebar to be inserted in
layout-insert-scalebar Insert scale -
. the map.
layout-insert-text Insert text ZE  |This inserts a text in the map.
layout-insert-view Insert view AV This inserts a view in the map.
layout-page-setup Page setup ) 'tl)'g)l(s opens the map’s page preference dialogue
layout-pan Frame the view & \'I/]r;lvs\,l activates the panning tool to move around the
layout-save-template Save as template = This saves the map design as a template.
layout-select Select by rectangle 3 This selects an element in the map.
layout-send-to-back Send to back g This sends the selected element to the back.
layout-set-size-position |Size/position & This changes the size and position of an element
in the map.
i Move image to be This allows you to move the image to be
layout-show-tag georeferenced 'E’f georeferenced in the view.
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layout-template-open

Open template

This loads a previously saved map template.

layout-ungroup

Ungroup graphics

This ungroups a set of graphics inserted in the
map.

layout-zoom-centre-in Zoom in to centre ] This zooms into the centre of the map.
layout-zoom-centre-out |Zoom out from centre 2% This zooms out from the centre of the map.
layout-zoom-fit Zoom fit WA Thls adjusts the map zoom to the size of the
window.
layout-zoom-in Zoom in This zooms into the selected area of the map.
layout-zoom-out Zoom out ] This zooms out from the selected area of the map.
layout-zoom-real Zoom 1.1 111 This enlarges the map to the size of the screen.
layout-zoom-selected Zoom to selection &, This zooms to the selected elements.
Tables
table-filter Filter K This opens the filter dialogue box in a table.
table-join Join By This opens the dialogue box to join tables.
table-link Link L This opens the dialogue box to link tables.
table-order-asc Ascending order = This puts the .records in a selected field of the
table in ascending order.
table-order-desc Descending order = This puts the rgcords in a selected field of the
: table in descending order.
table-selection-up Move the selection up 1 ;tgia moves the selected records to the top of the
table-statistics Statistics > This opens the statistics dialogue box in the table.
Views
view-add-event-layer Add event layer = This opens t.he dialogue box for adding an event
layer to the view.
. This opens a dialogue box in which you can input
. . Centre the view on a . . : . .
view-centre-to-point oint the required coordinates you wish the view to
P centre on.
view-clear-selection Clear selection This deselects the elements selected in the view.
view-locator Locate by attribute & This opens the dialogue box to select by attributes.
view-pan Panning &M This activates the panning tool.
view-query-area Measure area & This activates the area measuring tool.
view-query-distance Measure distances = This activates the distance measuring tool.
view-query-link Hyperlink X This activates the hyperlink query tool.
view-save-to-raster Save to raster O This allows you to select the area of the view you

wish to save to the raster layer.
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view-select-by-polygon

Select by polygon

This activates the tool for selecting geometries of a
layer which are located in a polygon.

view-select-by-rectangle

Select by rectangle

This activates the tool for selecting geometries of a
layer which are located in a rectangle.

view-select-geometry

Select by point

This activates the tool for selecting geometries of a
layer.

view-query-information

Information

S| | = ¥

This activates the tool for providing information
about a point.

view-zoom-back

Previous zoom

This shows the view with the previous zoom.

view-zoom-centre-in

Zoom in to centre

This zooms into the centre of the view.

view-zoom-centre-out

Zoom out from centre

This zooms out from the centre of the view.

view-zoom-in

Zoom in

This zooms into the area of the selected view.

view-zoom-manager

Zoom manager

This opens the zoom manager dialogue box.

view-zoom-map-contents

Zoom fit

This zooms to a suitable size to display all the
information of the loaded layers.

view-zoom-out

Zoom out

This zooms out from the area of the selected view.

view-zoom-to-selection

Zoom to selection

This zooms in to the selected elements of a layer.

Gazetteer-search

Gazetteer

This opens the gazetteer search tool (search by
place names)

catalogue-clear-point

Delete

This deletes the reference point added by the
catalogue or gazetteer search.

Catalogue-search

Catalogue search

This opens the catalogue search tool.

scripting-console

Jython console

B O | @ &8 W B 255K

This opens the scripting languages console.

2 Details of known errors in gvSIG 1.1

2.1 Windows which roll up and affect the installation launcher
and the application windows (only applies to Linux and KDE

desktops)

An error has been detected which affects the way in which the application windows and
the gvSIG installer are displayed. There are occasions on which the windows roll up and
only the title bar can be seen. To solve this problem, follow the steps below:

- Open the application and place the cursor over the gvSIG icon in the top left-hand
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corner. Right click on the mouse.

If the window has already rolled itself up, open the window again before continuing.
To do this, right click on the mouse on the window’s title bar and disable the “Shade”
option so that the window is displayed again.

® Avanzado 3 -l
Al escritorio 3 IMS\
-C
—| < Mover
Afiadir
Elirninar |
Arriba |
- Ahajo |
%4, Configurar comportamiento de la ventana... [
6 Cerrar Alt+F4

9. Select the “Configure window behaviour” option from the contextual menu.

Tk QuSsIG:!
Avanzado 3
Al escritorio >

+ ]
Minimizar

|7 Maximizar
Recoger

2 Configurar comportamiento de la ventana...

Q Cerrar Alt+F4
F-fista ‘

In the following window, select the “Specific window preferences” option and click
on “New”.
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x Configurar - Médulo de control de KDE ===

Configurar parametros especificos de una ventana

I

o Configuracion para com-iver-andami-Launcher
Decoracion de ventanas

(]

>
(2]
fal
El
3
o
w

WVentana {Ventana extra Geometria Preferencias |Pgenteus I

Descripcién:

[

Clase de ventana (tipo de aplicacion):

(L]

l ] [ ] Concordar la clase completa de ventanas

[ sin importancia [+]

Funcién de la ventana:

[ l

lSm importancia |v]

L]

Preferencias especificas de la ventana

{Detectar propiedades de la ventana

|

I

Translacido

[V Aceptar ”x Cancelar

(@ Aves ] Lrsamonss / |

In the next window, click on the “Detect” button and click on any part of the gvSIG
view.

15.A new window will then open. Select the option “Use window type (all the
application” and click on “Ok”.

X Mbdulo de control de KDE ==
Informacion sobre la ventana seleccionada
Clase: com-iver-andami-Launcher (sun-awt-X11-XFramePeer com-iver-andami-Launcher)
Funcion:
Tipo: Desconocido - se considerara como Ventana normal
Titulo: gvSIG:Sin titulo
Funcién-extra:
Magquina:

(®) Usar clase de ventana (toda |a aplicacion)
O
() Usar clase total de ventanas (especifica de ventana)

|| Concordar también con el titulo de la ventana

[V Aceptar ][x Cancelar

14. Return to the “Edit specific window options” window, go to the “Geometry” tab,
select the “Shade” option and click on the “Force” option in the pull-down menu.

L EEEEEEEEEREEEEEESSSSSs.
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X Editar las opdones espedificas de la ventana - Médulo de controlde KDE (| |7 7|

Ventana Ventana extra Geometria Preferencias Puenteos
Posicién Mo afecta
Tamario Mo afecta
Maximizada horizontalmente |Mo afecta
Maximizada verticalmente Mo afecta
Pantalla completa Mo afecta
Escritorio No afecta = || liEscritorio 1 -
Minimizada Mo afecta

Recogida Forzar

Colocacidn Mo afecta = | |Predeterminado -

W Aceptar # cancelar

2.2 Error in the management of Date values in gvSIG

At present there is no uniform date format in gvSIG, which leads to problems involving date
value management.

Problems have been detected when performing calculations with Date values using the
Field Calculator.

2.3 Error when attempting to join two tables with accented
field names.

At present, it is not possible to correctly join two tables whose field names contain accents.

2.4 Error when configuring a web browser in preferences
(only applies to Linux)

In the web browser option of the gvSIG preferences menu, the section “Execute own
command” does not work correctly in this version.

2.5 The fields of a dbf table joined to a dxf table cannot be
labelled.

At present, it is not possible to see the labels on the field of a dbf table which has been
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joined to a dxf table by means of the table-joining process.

2.6 Rotating an element inserted in a map using the graphics
rotation arrow in the properties window (Error in Windows XP)

At present, graphics cannot be rotated clockwise as there is no arrow with which to do so.
If you wish to rotate graphics in this direction, input the corresponding degrees (together
with a minus sign) in the associated text box.

2.7 Symmetry tool do not work on an annotation layer.

At present, it is not possible to use the symmetry tools on an annotation layer.

2.8 Once loaded, the image format of a WMS layer cannot be
changed.

A problem has been detected with some WMS servers in which, on attempting to access
the layer properties again and change the image formats, these are not displayed correcily.

2.9 Problems recognising the printer (only applies to Linux
and Java 1.5)

If gvSIG displays a warning message indicating that there is no default printer even if there
is a printer installed, go to the system preferences menu and set the printer as default.

2.10 Error in the results of the grouping functions in the
“Dissolve” geoprocessing tool.

It has been found that the results obtained after applying the grouping functions in the
“Dissolve” geoprocess are not correct.

211 Known errors in the “Export to raster” tool.

When attempting to clip jpg2000 and ecw layers, the RGB bands are interchanged in the
resulting layer.
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3 GNU GENERAL PUBLIC LICENSE

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.,

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software—-—to make sure the software is free for all its users. This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Lesser General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not
price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their
rights.

We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software
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patents. We wish to avoid the danger that redistributors of a free
program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and
modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains
a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The "Program", below,
refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it,
either verbatim or with modifications and/or translated into another
language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the

Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License
along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

c) If the modified program normally reads commands interactively
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when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide
a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on
the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Program,

and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based

on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the

entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.

In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections
1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three
years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative 1is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with such
an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source
code means all the source code for all modules it contains, plus any
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associated interface definition files, plus the scripts used to
control compilation and installation of the executable. However, as a
special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.

5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all. For example, if a patent
license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
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any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions
of the General Public License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any
later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free
Software Foundation. If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software
Foundation.

10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the author
to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this. Our decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest
to attach them to the start of each source file to most effectively
convey the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

<one line to give the program's name and a brief idea of what it does.>
Copyright (C) <year> <name of author>

This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License along
with this program; if not, write to the Free Software Foundation, Inc.,
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type "~ show w'.
This is free software, and you are welcome to redistribute it
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under certain conditions; type ~show c' for details.

The hypothetical commands "~ show w' and "~ show c¢' should show the appropriate
parts of the General Public License. Of course, the commands you use may
be called something other than “~show w' and "show c¢'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer" for the program, if
necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
"Gnomovision' (which makes passes at compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Lesser General

Public License instead of this License.
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